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Who, Where, and When 
Room & Location 

ISB 360 
Monday & Wednesday 1:25-4:25 

Professor 
Pat Wadsworth 
Professor, Biology 
456 Morrill IV 
patw@bio.umass.edu 

Laboratory Coordinator 
Katherine Dorfman 
HHMI Laboratory Coordinator 
ISB 241C  
kdorfman@bio.umass.edu 

Teaching assistant 
Heather Jordan 
Graduate Student in MCB 
460 Morrill IV 
hmjordan@umass.edu 

Biology Department Library Liaison 
Maxine Schmidt 
Integrated Sciences and Engineering Library 
mschmidt@library.umass.edu 

Course website 
http://bcrc.bio.umass.edu/bioimaging/ 

Textbook 
In lieu of a textbook, readings will be available on line.  

Other materials:   
1 GB USB flash drive 
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Laboratory Schedule 2014 
Day Date Lab Page 
W 9/ 03 Lab 1.1:  Introduction to the Equipment 11 

M 9/ 08 Lab 1.2:  Imaging Mitosis with fixed cells: Image Spatial 
Quantification 23 

W 9/ 10 Lab 1.3: Image Formation in the Microscope 27 

M 9/ 15 Lab 2.1:  Numerical Aperture  35  
DUE:  Assignment 1: Making a figure  

W 9/ 17 Lab 2.2:  Resolution    43 
Quiz 1  

M 9/ 22 Lab 3.1:  Fluorescence microscopy  53 

W 9/ 24 
Lab 3.2:  Identification of Cellular Organelles  65 
Quiz 2:  Fluorescence  
DUE:  Report 1: Unit 2 - Resolution  

M 9/ 29 Lab 3.3:  Labeling Cellular Structures 67 
DUE:  Report 2: Lab 3.1 Photobleaching  

W 10/ 01 Lab 3.4:  Imaging Living Cells Expressing GFP-Tagged Proteins 73 

M 10/ 06 Lab Practical 
DUE:  Assignment 2:  Unknown Proteins  

W 10/ 08 Lab 4.1:  Motility in Control Cells  79 
M 10/ 13 No class (Columbus Day)  

TuM 10/ 14 Lab 4.2:  Mechanism of Motility  83 
W 10/ 15 Lab 4.2:  Mechanism of Motility, cont’d.  

M 10/ 20 Presentation #1:  Cell Motility 
DUE:  Assignment 3: motility  

W 10/ 22 Lab 5.1:  Receptor-mediated Endocytosis  87 
M 10/ 27 Lab 5.2:  Bulk-phase endocytosis 95 

W 10/ 29 Lab 5.3:  Transport of Endosomes Along Microtubules 
Quiz 3:   Endocytosis 

99 
 

M 11/ 03 Lab 6.1:  Cellular Responses to External Stimuli 105 
DUE:  Report 2: Endocytosis  

W 11/ 05 Lab 6.2:  Release of Internal Calcium Stores  113 
M 11/ 10 No class (Veteran’s Day)  

WM 11/ 12 Lab 7.1:  Designing an Experiment  
DUE:  Report 3: Calcium imaging 

119 
 

M 11/ 17 Projects 105 
W 11/ 19   
M 11/ 24   
W 11/ 27   
   UMass Thanksgiving Break  

M 11/ 26 Projects 

 W 11/ 27 
M 12/ 01 
W 12/ 03 
Final exam 

period 
Presentation #2:  Independent Project 
DUE:  Report 4:  Final Project 

121 
 

M:  Monday schedule 
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Introduction to the Course 
Bioimaging focuses on the use of microscopy in the life sciences, ranging from the principles 
of optics to the use of specialized microscopic techniques to investigate the structure and 
behavior of various types of cells.  Using research-quality fluorescence microscopes 
purchased on the HHMI grant, you will learn to use both phase and fluorescence microscopy, 
and to take digital stills and movies with both.  You will observe the movements of living 
cells in response to various substrates or drugs, and learn to fix and stain cells to see greater 
internal detail, using quantification techniques to measure the size or concentration of various 
cellular components.  Then you will have the opportunity to apply these techniques to the 
independent investigation of a particular problem regarding cell division, locomotion, or 
growth.  We intend to present a class poster at the Undergraduate Science Symposium in 
May. 
This course is intended for beginners, and it is expected that students do not necessarily have 
basic familiarity with microscopy, sterile technique, micropipettes, etc. 
The results or techniques from one experiment will be used in the next.  
There will be times that you will be extremely busy and others not busy at all. (The ‘not 
busy’ times are a good opportunity to get your notebook, image pages, and data files up to 
date.) 
Your success will depend on your ability to come prepared, listen carefully, pay attention to 
protocol details, and cooperate with others.  
You will at times be handling dangerous compounds and laboratory equipment; think safety 
first at all times (see page 8).  
The bulk of each day has been scheduled to perform experimental procedures, but time has 
been scheduled throughout for lecture and discussion.   

Preparation 
It is your responsibility to check the web site each week to get your assignment.  It is 
furthermore your responsibility to read both the lab manual and the assigned background 
reading.   There will be quizzes from time to time during the semester, intended to check 
your preparation.   

Participation 
This is a small class, and it will be easy for the instructors to observe your class participation.  
Participation in this context means working efficiently and in cooperation with your lab 
partner.  It makes sense to divide up laboratory duties between partners, and we do not expect 
that both members of a team will perform every duty entirely evenly.  However, each student 
should try as much as possible to participate in all aspects of experiments.  Efficiency means 
that you are prepared when you arrive in class—you’ve read the lab manual, and are ready to 
start right in.  If it’s clear that you and your partner are dividing up duties fairly evenly, and 
discussing your experiments and progress together, you’re cooperating well.  If you either 
hog all the action, or hang back all the time, that is not good cooperation, and your 
participation grade will suffer accordingly. 
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Course Objectives 
First objective – Unit 1 
Familiarization with the hardware and software of a modern research microscope 
 Concepts: Properties of visible and ultraviolet light 
 Properties of an optical microscope: 
 Resolution 
 Brightness 
  Focus 
 Numerical aperture 
 Contrast 
 Bright field, phase contrast, and fluorescent microscopy 
 Skills:   Using the Nikon microscope 
 Taking images through the microscope  
 Posting files to the server; posting images on our web site  
Second objective – Units 2 and 3 
Using fluorescence to see cellular details 
 Concepts: Fluorescence 
 Staining 
 Immunofluorescence 
 Cell structure 
 Skills: Observing fixed and live cells 
 Fixing and staining cells 
Third objective – Units 4 through 6 
Using microscopy to study cellular function.  
 Concepts: Cell cycle 
 Endocytosis 
 Cell motility 
 Skills: Measuring integrated fluorescence of a region of interest 
 Making movies of cell activity 
Fourth objective – Unit 7 
Designing an experiment  
Fifth objective  
Mastering laboratory techniques 
 Skills: Posting images to the website 
 Micropipetting 
 Data analysis with Excel 
 Dilution techniques 
 Sterile technique 
 Cell culture techniques 
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Laboratory Basics 
Your station 
You will be provided with a variety of materials and equipment for use during the semester, 
some for exclusive use by you and your lab partner, and some to be shared with another pair 
at the same bench.  You will be responsible for keeping track of these things. 
Your station should have the following items: 

• timer 
• hand counter 
• lens paper 
• bottle of ethanol 

You will have to share the following: 

• microfuge 
• vortex mixer 
• micropipettors 
• tips 
• slide warmer 
• incubator 
• biological safety cabinet 

Organization and Care of Reagents 
For some experiments, we will provide you with just enough reagents to carry out the 
experiments described in the laboratory manual, often in very small volumes.  It is extremely 
important that you manually mix (by shaking or vortexing) reagents before using them, 
because droplets of liquid reagents often adhere to the lids or sidewalls of microcentrifuge 
tubes due to condensation and handling.  After mixing, always spin the tube briefly in the 
microfuge to settle the contents at the bottom.  Having all of the reagent at the bottom of the 
tube will increase pipetting accuracy and ensure you do not run out of reagents.  (This is 
especially important when you use frozen samples, which first must be thawed completely, 
and then thoroughly mixed.)   
Label your tube with a permanent marker so you know that it’s yours and what’s in it. 

Don’t make a liar out of the label.  Don’t contaminate your stock reagents.  This means not 
to reuse pipette tips, and not to pour any leftover reagent back into the stock bottle.   Always 
use a fresh sterile pipette tip—not one that was used previously, and never one that you have 
accidentally touched.  Even if you can’t see liquid in a used tip, microdroplets are in there, 
and would cross contaminate your solutions if the tip were used more than once.   If you have 
any doubt about the contents of a tube, assume it to be contaminated. 

Mark the label of anything you have opened – its sterility or integrity has been compromised, 
and it should not be put back on the shelf as if it were unused. 
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Laboratory Safety 
We do very little in this course that could result in a fire or an explosion.  We will, however, 
be using a few reagents (in very small amounts and low concentrations – be reassured) that 
have the potential to cause harm.  We will try to alert you to whatever dangers we see in the 
lab.   
Your best bet, however, for protecting yourself is not to get anything in your mouth, eyes, or 
breaks in your skin.  Do not eat or drink or apply lip balm or fix your contacts in the lab.  
Wash your hands:  after you handle reagents, before you touch your face, before you leave 
the room, before you have a snack.  Wear gloves:  while you handle anything that might hurt 
you, or that you might contaminate.   Take your gloves off:  whenever you move from wet 
bench activities to computer keyboard, or whenever you have touched something you don’t 
want to spread around the room.  Remember that if you touch your face with a gloved hand 
that has just touched a toxic reagent, you might as well not have worn the gloves!  (The same 
applies if you touch barehanded any surface previously touched with a contaminated glove.) 

Fixing live cells entails the use of solvents that kill cells (to state the obvious).  Therefore, we 
do all our fixation, and store all of our fixatives (fresh and used) in the fume hood.  

Discarding Waste 
There are many different types of waste in this lab:   

• recyclable paper 

• recyclable containers 

• broken glass (unrecyclable, dangerous to handle) 

• sharp trash (small sharp objects like razor blades) 

• biohazard waste (biological specimens that might be infective or invasive)  

• hazardous liquid waste (toxic, corrosive, or flammable waste)   

• regular trash (solid waste that is not any of the above) 

• benign liquid waste (liquid waste that is not hazardous or infective) 
Please ask whenever you have the slightest doubt as to how to dispose of something! 
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UNIT 1:  THE QUANTITATIVE OPTICAL 
MICROSCOPE 
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Lab 1.1:  Introduction to the Equipment 
Goal for the module 
Familiarization with the hardware and software of a modern research microscope. 

Introduction 
Much research in the life sciences requires measurement of the localization and dynamics of 
biomolecules in cells.  The characteristic size of most cells is too small for direct 
visualization, but is compatible with the resolution of the optical microscope.  Innovations in 
microscopy and the introduction of new techniques have produced an explosion in the use of 
the optical microscope in modern life science research.  By the end of this course you will be 
familiar with optical microscopy techniques and their application to cell biological systems. 

The properties of the optical microscope are governed by the radiation that it manipulates.  
Recall that light is electromagnetic radiation that has a characteristic wavelength and 
frequency for each different color.  The glass lenses in a microscope transmit visible light as 
well as light that is of somewhat shorter and longer wavelengths.  This wavelength range has 
been selected because the microscope, through its history, has been used dominantly by 
humans viewing microscope images directly with their own retinas.  In the past couple of 
decades, however, the wavelengths of light accessible to the optical microscopist have 
increased.  This is due to the introduction of electronic detection methods and the broader 
wavelength sensitivity of these devices.   

In this course we will use Nikon research-grade microscopes that can form brightfield, phase-
contrast and fluorescence images.  (These will be explained in much more detail in later lab 
modules.)  A research-grade charge coupled device (CCD) camera from QImaging 
Corporation is connected to the microscope through a side port and can be used to collect 
images suitable for quantitation.  (The workings of a CCD camera and the methods of 
quantitating digital images will be covered in later lab modules.)  The particular camera on 
your microscope is a QICAM 12-bit mono fast 1394 cooled model.  You can find out more 
about the camera by visiting the QImaging web site at http://www.qimaging.com. 

Materials 
Glass slide with a cover slip of fixed LLC-Pk1 pig kidney epithelial cells that have been 
stained with DAPI, a fluorescent marker for DNA. 
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Procedures 
Task 1. Signing into the computer and the course web page. 
Throughout the semester, you will be making, editing, analyzing, and storing, digital images, 
as well as uploading them to the course webpage.  In this task, you will learn your way 
around the computer and our webpage. 
1. Log into the computer with your BCRC ID and password.  If you don’t have a BCRC 

account, 
a. Have someone else sign into the computer for you. 

b. Open Firefox. 
c. Click on “course accounts” on the BCRC homepage. 

d. Follow the directions to set a BCRC password after authenticating with your OIT 
NetID and password. 

2. Find the course website.  You can get to all biology course websites from the Biology 
Department pages from the “Undergraduate” tab. 

a. Log in with your BCRC username and password. 
b. Tell an instructor you have done so, and you will be given uploading privileges.  

Task 2. Turning on the microscope (without destroying it) 
1. Remove the microscope cover. 

2. If you plan to use the fluorescence epi-illuminator, turn on the epi-illuminator power 
supply (large box).  Push the start button for a second or two until the lamp in the lamp 
housing on the back of the microscope lights (the red light on the power supply turns 
on)∗.  (This start procedure involves a high-voltage spark in the lamp.  The sparking 
produces a voltage transient that can disrupt sensitive electronics.  The computer should 
be turned off, and your hands away from the microscope when you start the epi-
fluorescence lamp.) 

3. Turn on the transmitted light illuminator and the microscope. 
4. If you plan to use the fluorescence shutter, turn on the shutter controller (black box). 

5. If you plan to take digital images, turn on the camera, and then the computer. 
6. When you are finished with the microscope, turn off all of the lamp power supplies and 

electronics.  The order in which you do that does not matter. 

Task 3. Observing cells 
One of the most important aspects of optical microscopy is to locate a specimen of interest, 
to place it in the field of view, and to get its image in focus.  Follow the steps below to 
observe fixed cells using phase contrast microscopy.  Refer to Figure 1 (taken from the 
Nikon instruction manual available on the course web site). 

                                                
∗  The arc lamp in the epi-illuminator lamp housing gets very hot during operation.  The lamp must cool 

between lamp lightings.  Therefore, you must wait at least 15 minutes after the lamp is turned off before 
turning the lamp back on.  Likewise, the lamp should be allowed to fully warm up before turning off, so 
leave it on at least 15 minutes after it is turned on. 
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Figure 1.  Photograph of the left side of the microscope base. (Image from Inverted 
Microscope Eclipse TE2000E Instructions, reprinted with permission from Nikon.) 

1. If you have not already turned on your microscope, do so now.  Follow the turn-on 
procedure on page 12.  Be sure to turn off the computer before you turn on the epi-
illumination arc lamp.  The arc lamp emits an electromagnetic pulse that can damage 
electronic components.  Locate the epi-illumination field block near the fluorescence 
excitation and emission selector wheel on the right side underneath the nosepiece (see 
figure above).  Be sure that it is closed (pushed to the front). 

2. Rotate the nosepiece (see Figure 1) so that the 10× lens is facing up, toward the stage 
opening.  Use the side of the nosepiece for the rotation of the lenses so as to avoid 
fingerprints or other damage to the (expensive) microscope objective lenses. 

3. Place your glass slide with cell cover slip side down on the stage.  (The slide always 
should be put so that the cover slip, or the surface with the object to be examined, is on 
the side of the slip closer to the objective lens.  This is an inverted microscope, so the 
glass slide is “inverted”, too.) 

4. Turn on the transmitted light condenser illuminator (Nikon calls this the Dia-illuminator), 
adjust it for brightness, and find some cells.   

5. This is often harder than it sounds.  You might try to observe through the eyepieces while 
you move the stage from side to side using the stage x-y positioning knobs (on the 
extended bar coming down from the stage).  The lateral movements allow you to find 
contrasting parts of the image, which you can then use to focus on the specimen.  Focus 
as you move the stage.  It is also helpful to partially close the condenser iris.  

6. Can’t find cells?  Check the orientation of your slide, settings on the microscope and 
brightness of the illumination light.  Still can’t find cells?  Ask for help. 

7. Change to the Plan Fluor DLL 40× objective and find cells.  Can you find the same cells 
that you observed in part 3? 
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Task 4. Fluorescence 
The use of fluorescent probes for cellular structures is a powerful tool that allows high-
contrast images of cellular components to be visualized.  In this task you will observe the 
same cells from the previous step, but now in fluorescence mode.  These cells have been 
treated with DAPI (4',6-diamidino-2-phenylindole; http://en.wikipedia.org/wiki/DAPI), a 
fluorescent probe that binds strongly to double-stranded DNA and, in doing so, shows the 
location of dsDNA in cells.   

1. Leave the 40× lens and cells in place from Task 3.  Locate the rotating disk below the 
objective lens nosepiece, in the location “Black cover” shown in Figure 1.  The black 
cover has been removed and replaced with fluorescence filters and mirrors.  The controls 
are on the right hand side as you face the microscope.  Rotate the filter wheel until you 
find the “UV” click stop.  This sets the fluorescence filters in the microscope for the 
ultraviolet excitation and blue emission needed to visualize DAPI.   

You have 4 filter cubes in your filter wheel, each set up for particular fluorophores: 
Label on  
filter wheel 

excitation  λ  emission λ  used for Label on  
filter 

UV UV (360nm) Blue (460 nm) DAPI UV 2E-C 
B B (480 nm) Green (535 nm) GFP, fluorescein B-2E/C 
G G (560 nm) Red (630 nm) Texas red, rhodamine Y-2E/C 

LP B (470 nm) 
long pass green-red  
(> 500 nm) chlorophyll and GFP simultaneously B-2A 

 
2. Your microscope will have either a Sutter Instruments or a Vincent Associates shutter 

controller.  Determine which one you have. 
a) Sutter controller: The epi-illuminator shutter is manually opened by switching the 

toggle switch on the controller box to “Open” and is manually closed by switching 
the toggle to “Close”.  With the toggle in the middle “Auto” position, the computer 
controls the shutter.  The shutter should be set for manual operation and be closed. 

b) Vincent controller: The epi-illuminator shutter is manually opened by switching the 
right toggle to “Local”.  Then switching the left N.O./N.C. (normally open/normally 
closed) toggle on the Vincent Associates controller box to “N.O.” opens the shutter 
and switching to “N.C.” closes it.  With the right toggle in the “Remote” position, the 
computer controls the shutter.  The key switch should be in the “Std” position.  

3. Open the epi-illumination field block.  This is the rotating slider just below the epi-
illumination fluorescence filter selector wheel under the nosepiece.  The closed position 
is forward, marked as “C”.  The open position is back, marked as “O”.  This will allow 
fluorescence excitation light to pass freely into the microscope and therefore be gated by 
the computer-controlled shutter.  Open the shutter as directed above.  Observe your cells.  
The DNA in the cells should fluoresce bright blue against a dim background.  Close the 
shutter when you are finished with the observations.  Leaving the epi-illumination turned 
on will photobleach your specimen. It will also bleach optical filters. Always be sure to 
close the shutter whenever you are not imaging by eye or camera.  
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4. Locate the epi-illuminator neutral density (ND) filters at the back of the microscope.  
They are on the right hand side, just before the light path from the arc lamp housing to 
the far right makes a turn into the microscope.  Turn the shutter on again and play with 
these to see how they control the fluorescence excitation light level.  The ND 4 filter 
reduces illumination intensity by a factor of ¼.  The ND 8 reduces intensity by a factor of 
1/8.  Together they reduce the intensity by a factor of 1/32.  If in an experiment the 
fluorescence is too bright, you should use the neutral density filters in the excitation 
beam.   

5. Play with simultaneous phase and fluorescence imaging (i.e., having both the transmitted 
light illuminator and the fluorescence illuminator turned on at the same time).  Can you 
find cells in different stages of the cell cycle? 

Task 5. Digital imaging 
It is fine to observe directly with your eyes.  However, it is difficult to quantitate the image 
you see.  For example, can you tell what the average dimension of nuclear DNA is?  Is there 
more DNA in one nucleus versus another?  By taking and preserving digital images, you can 
use image analysis software to answer these questions.  In this task you will capture images 
of the cells in phase contrast and fluorescence modes. 
1. Leave the 40× lens and cells in place from Task 4.  Turn on your computer if it is not 

already on.   
2. Turn on the camera if you haven’t done that already.  Locate cells with your eyes.  Now 

look at the cells with the camera.  To do this,  
a. Find and open the Micro-Manager program in the Applications folder (it uses a 

microscope icon)*.  Select the correct configuration file (Vincent or Sutter config file, 
depending on your shutter) in the Micro-Manager window to tell the software about 
your hardware.  Note that the camera must be turned on for the software to properly 
initialize. 

b. Rotate the optical path switch dial on the bottom right front of the microscope.  This 
places a mirror in the optical path that moves the image from the eyepieces to the 
camera.  The image in the eyepieces will disappear. 

c. Activate the camera using Micro-Manager by clicking the “Live” button.  If the 
image is too dark or too bright, adjust the light intensity in the microscope.  You are 
after a sharp image with good contrast. 

3. Play with your specimen and the camera.  Notice what part of the field of view is seen by 
the camera (this is due to a magnifying lens that sits in front of the camera.)  Notice any 
focal shift that occurs when you go between the eyepiece and the camera.  (When the 
camera is at the same exact focus as the eyepiece, it is said to be parfocal.  Your camera 
is probably not quite parfocal with the eyepieces.)  Get a feel for the response time of the 
camera, the way that the image changes with respect to changes in image brightness, and 
the camera’s resolution compared to your eyes’ resolution.  (Eyes are nearly always 
better for resolution when light is bright enough.) 

                                                
* Alternatively, open ImageJ, then open MicroManager from the Plug-ins menu. 
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4. Take individual phase and fluorescence images of an interesting group of cells.  Try to 
get at least a few cells in the field of view.  To do this, 

a. Turn off the live image collection. 
b. Assure that the shutter controller is set for computer control and that the shutter is 

closed (see Task 4.2).  Block off the transmitted light by turning the lamp off with the 
button on the left bottom of the microscope. 

c. Take a single fluorescence image by clicking the “Snap” button.  If the exposure is 
too dim or bright, adjust it by changing the “Exposure [ms]” value.  Save the image to 
disk by using the “Save” button at the bottom of the image window.  You should 
make a folder with a sensible name and use a sensible name for the image file.  While 
you are working, it may be easiest to keep this folder on the desktop.  Later you can 
move it to permanent storage.  (If you come back in two weeks and want to find your 
fluorescence image from today, what would make it easy to locate?) 

d. Take a single phase image by blocking off the fluorescence illumination light or 
turning the shutter controller to manual control and closed, which defeats the 
computer control of the shutter.  Don’t forget to turn on the transmitted light.  Save 
this image, too.  You may need to adjust the exposure time and/or image illumination 
brightness. 

Task 6. Controlling the image display 
The Micro-Manager software that runs the camera is actually a software plugin for the 
freeware image-processing program called ImageJ.  You will use these programs throughout 
the semester. 

In this task you will use some of the features of ImageJ to get used to the program and to 
explore the properties of the camera attached to the microscope. 

1. Get cells in the field of view using fluorescence illumination for DAPI.  Snap a picture as 
you did in Task 5. 

2. The Micro-Manager display shows several pieces of information.  Next to the row of 
buttons at the top left is a list of “Camera settings”.  If you haven’t played with them 
already, do so.  Change the “Exposure [ms]” and “Binning” values and snap pictures to 
see what happens. 

3. Snap another image with binning set at 1.  The display at the bottom of the Micro-
Manager window is a histogram of the brightness values (or “gray levels”) contained in 
the image that you just took.  The histogram shows the number of pixels in the image (the 
vertical part of the plot) versus the brightness in the pixel (on the horizontal part of the 
plot).  More light falling on a pixel in the camera will give a larger signal that is 
translated into a brighter pixel on the displayed image.  The plot shows the values 
contained in all the pixels of the image from full black (on the far left) to full white (on 
the far right).  Peaks in the graph correspond to gray level values that are the most 
commonly found in the image.  From your graph you should be able to see that there are 
a lot of dark pixels compared to the number of pixels that are bright (the DAPI-stained 
nuclei). 

4. That “Log hist.” box under the two display range control buttons changes the vertical axis 
on the plot to a logarithmic scale from a linear scale.  This allows you to expand the small 
values on the vertical scale relative to the large values.  Try it. 
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5. With the image window and the Micro-Manager window both in view, click the “Full” 
and “Auto” buttons alternately.  Clicking the “Full” button makes the image appear 
black.  Nothing has happened to the image data.  Rather, what you are doing is changing 
the displayed brightness of the image by changing the image gray level values that 
correspond to displayed brightness levels on the screen. 
The image that is displayed on the computer screen is a representation of a data file of 
numbers.  The usual way in which the numbers are converted to a screen image is to 
make the brightness of a particular image pixel proportional to the value in the data file 
for that pixel. 
The image produced by the camera has a limited gray level range, from zero to 4095.  
The “Full” button causes the gray level value of zero in the digital image to be displayed 
as black and a gray level value of 65,535 to be displayed as white, with intervening 
values displayed in proportion to the numerical value in each pixel.   When you click the 
“Auto” button, the Micro-Manager software sets the minimum value in the image as 
black and the maximum as white.  (Notice that these values are shown under the “Log 
hist.” button on the left.) 

6. Notice that the two slider controls underneath the plot change when you click the “Full” 
and “Auto” buttons.  You can manually adjust these two slider controls.  The top one sets 
the gray level value that is shown as black on the screen while the bottom one does the 
same thing for the gray value that is shown as white.   

Play with the controls to see how the image changes when you change these values.  All 
pixels that are equal to or less than the top slider value will be shown as black in the 
display and pixels equal to or greater than the bottom slider value will be shown as white.  
By changing these values you can emphasize the parts of the image that you want to.   

Notice that the Min and Max values change as you change the sliders.  Those Min and 
Max values give the exact values below which pixels are colored black and above which 
they are colored white. 

7. The pull-down menu just below the “Min” and “Max” values changes the scaling on the 
plot at the right.  The default value is “camera” which means that the maximum value on 
the plot is set to the maximum possible value of the image data file that the camera and 
its software will produce.   
Your camera can make so-called 12-bit images, which means that each pixel in the 
camera can discern up to 4096 (that’s 2 to the 12th power) gray level values.  The 
computer doesn’t handle 12-bit files well, so the data is stored in a so-called 16-bit file 
(numbers can range up to 65,535).   
Because your camera images are created as 16-bit data files, the minimum for the “Full” 
button is zero and the maximum is 65,535.  Use the pull-down menu to change the scale 
to some value.  “16bit” will be the same as “camera”, while other settings will be 
different.  Play with them to see how they affect the plot and the displayed image.  You 
should find that the image always behaves the same when you flip between “Full” and 
“Auto” while the plot looks a lot different.  The reason is that the pull-down menu 
changes only the scale on the gray level plot, but doesn’t affect the range of the lower 
sliders, which are tied to the data file.  You should find that the plot gives the full range 
of the camera when the pull-down menu is set to “12bit”. 
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It is possible to save a lower resolution image by using the “Pixel type” pull-down menu 
under “Camera settings” at the top middle of the window.  As you have already seen, the 
default is to store the full 12-bit range of camera data in a 16-bit file.  Change the 
“Pixel type” to “8bit”.  This means that the next picture that the camera takes will have a 
gray scale resolution of zero to 255 (2 to the 8th power is 256).  There are fewer possible 
gray levels, so the image contains less information than an image taken with 12 bit gray 
scale resolution.  The computer can handle 8-bit data files, so the image will be stored as 
an 8-bit file.  The image file will take up less storage space because only 8 bits need to be 
stored for each pixel.  This can be an issue in some applications, but we are using 
computers that have plenty of disk space, so we won’t be using this feature in subsequent 
modules.   
Take an image with the “Pixel type” set at “8bit”.  Then play with the histogram controls 
at the lower left of the window to compare how this lower resolution image is handled by 
the software. 

8. There’s one more important control to play with in the Micro-Manager window.  The 
“Auto-stretch” box below the pull-down menu at the lower left of the window allows you 
to control the display of images as they are taken by the camera.  The function is best 
seen by example: 

a. Get an image on the camera and look at it “Live” with the camera.  If the “Auto-
stretch” box is checked, the Micro-Manager software automatically sets the Min and 
Max values for each image that is collected so that Min is the lowest gray level in the 
image and Max is the highest.  This will effectively “stretch” the image gray scale so 
that the display is from full black to full white.  Notice that on the live image, when 
“Auto-stretch” is ticked on that Min and Max change constantly.  This is because 
each image is slightly different than the previous image. 

b. Tick the “Auto-stretch” box off.  Now adjust the slider bars.  Notice that the live 
image display responds to your control.  Notice also that the Min and Max remain 
fixed where you set them. 

This control can be quite useful when you want to set the image so that the brightest area 
in the image is just below the maximum gray level that the camera can register.  It also 
can be useful when you want to follow changes in image brightness qualitatively as an 
experiment progresses.  You will do this later on in the semester to follow fluorescence 
bleaching as a function of time. 

Task 7. Saving image files to Wahoo 
Image files tend to be very large.  The ISB server, Wahoo, has space set aside for storage of 
Bioimaging files.  This is a very useful place for you to keep your files.  You can access 
these files from anywhere that has an internet connection. 
There should be a link on the desktop that takes you to the Wahoo Bioimaging space.  Find 
the folder already set up there for your microscope.  Make a new folder with an informative 
and unique identifying name e.g., “Unit 1 – Tom & Jerry” (if your names are Tom and Jerry, 
of course).  Save your image files there, creating identifying subfolders as needed, and 
keeping a record of what goes where. 
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Task 8. Retrieving files from Wahoo 
From room 360 
Obviously, you can readily locate these files from any computer in room 360.   

On a networked Macintosh on campus 
Open a finder window, and pull down the Go menu.  Choose “connect to server” and type 
“smb://wahoo.nsm.umass.edu/bioimaging”.  Sign in with your BCRC username and 
password. 

From anywhere else  
Download and install FileZilla following the instructions on the OIT web-hosting support 
page (http://www.oit.umass.edu/support/web-hosting). 

• Open FileZilla. 

• Open Site Manager from the File menu, and enter the following: 
Select Entry: New Site 

Hostname: wahoo.nsm.umass.edu 
Port: 22 

Protocol: SFTP – SSH File Transfer Protocol 
Logon Type: Ask for password 

User:  your BCRC username 

• Click Connect. 

• Enter your BCRC password, and click OK 

• Note: The first time you log in, a one-time screen warning you about an unknown host 
key may appear.  Check the box next to Always trust this host, add this key to the 
cache and click OK. 

• The remote site is something like this: /u1/home/bio/username (personalized with your 
username, of course). 

• Clear the Remote site box, and type this: /export/bioimaging  

• Enlarge the absurdly small window under the remote site bar and scroll to find your 
microscope folder.  Move files between local and remote folders by drag-and-drop, or by 
right click and upload (local to remote) or download (remote to local) 

• Voilá!   
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Task 9. Uploading an image to the course webpage 
You will be putting images on the course webpage throughout the semester.  Course 
information will be posted there as well.  Check the webpage for changes in uploading 
procedure. 
1. When you have an account and the proper permissions for the web site, navigate to the 

“Image Galleries” link under “Course Resources”.  You will see that there is a place to 
put images for the course.  Image files should be JPG, PNG or GIF.   

2. Convert one of your ImageJ images (stored as TIFF image files) to JPG.  To do this, have 
an image displayed as you want it.  Go to the ImageJ>File>Save as>Jpeg… pull-down 
menu, make the filename sensible to you and put the file where you can find it. 

3. Now that you have a JPG image file, import it into the image gallery for the course.  To 
do this, expand the “Create content” link on the course website menus and click on the 
“Image” link.  Give your image an appropriate title, select the appropriate gallery for the 
course, browse to your JPG file, and write a very short image caption in the “Body:” box.  
You can preview your submission before you submit it.  You must click the “Submit” 
button to upload the image. 

4. You can now see your image along with any others posted by navigating through the 
Image Galleries link on the menu.  When you have a pretty image to share any time 
during the semester, please post it here. 

Task 10. Printing an image 
After you have set up your image the way you want it, with a scale bar and appropriate 
labeling, you are ready to send it to the printer. 
Warning:  there are many steps to this process.  Much frustration, heartbreak, and wasted 
paper can be avoided by mastering these steps now. 

• Select “print” from the file menu.  This does not send your job to the printer! 

• Notice the name of the printer, as this will tell you where to look for your printout.  
(The printers in ISB biology space are named after Pacific islands.)   

Printer name room 
Nifiloli 264 

Nupani 360 
Nukapu 364 

Ngawa 368 

• You may be able to get a menu that lets you change image quality by looking at your 
options under “copies and pages”.   

• Use the preview function to make sure you will be printing the right thing.  Check 
which pages will be included. 

• Click print. This does not send your job to the printer!  This will produce an 
authentication dialog box.  Sign in with your BCRC username and password.  This 
does not send your job to the printer! 
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• Go to the print release page (https://wahoo.nsm.umass.edu/printrelease/), which is 
linked to the BCRC web page, and in the pull-down list under “undergraduate” on the 
Biology Department web page.  Enter your name and password again, if asked.  This 
does not send your job to the printer! 

• You should be directed to the print queue page.  Refresh repeatedly until your job 
shows up.  Check the box for your job and click “release”.  (If you have made a 
mistake, this is a good time to cancel a job.)  This does not send your job to the 
printer! 

• After you release your job, you get a confirm release page.  Click “really print”, and 
this will finally send your job to the printer! 

Task 11. Microscope hygiene 
You should treat your microscope like the delicate instrument that it is.  Your microscope 
and camera cost over $35,000.  The objective lenses cost between $780 and $2300 each.   
Lens surfaces are coated with antireflective materials that can be scratched.  Never use any 
abrasive materials to wipe them.  Only lens tissues are soft enough to be used.  Dust should 
be blown off of optical surfaces, not wiped off. 

Use care when moving filters into the optical path, when switching from viewing by eye to 
viewing by camera and when switching fluorescent filters. 

If a part of the microscope doesn’t seem to work properly, don’t try to force it to move.  Ask 
an instructor if you have a question.  Learn the parts of the microscope and how they function 
so that you’ll know if there is a problem with something. 
The microscope should be covered when you are finished for the day.  Never put the cover 
on when power is applied to any part of the microscope, or if the lamp housing is hot.  The 
lamps and electronics produce lots of heat that can cause damage if not properly ventilated.  
Always double check that all power is turned off before you cover the microscope.  This is 
very important. 

Clean-up 
Save good slides for future use (and note which slide you used).  Discard (in the glass trash) 
any slides that had bad specimens, got cracked, or are totally photobleached. 
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Lab 1.2:  Imaging Mitosis with fixed cells: Image 
Spatial Quantification 

Goal for the module 
Identify the stages of mitosis in fixed cells and to determine the dimensions of cellular 
structures. 
Mitosis is the process by which one cell divides into two daughter cells.  We will take 
advantage of the ease of imaging mammalian cultured cells to observe the process of mitosis.  
We will observe the chromosomes and the mitotic spindle microtubules.  You will learn to 
identify the stages of mitosis in fixed and live cells; later in the semester we will make 
movies of living dividing cells.  

The ability to grow and duplicate is a fundamental property of life.  Mammalian cells require 
about 1 day, 24 hours, to traverse the entire cell cycle.  From visual examination of cells, the 
cell cycle can be divided into mitosis (M) when cells physically segregate the chromosomes 
and divide into two daughter cells and the remainder, interphase (I).  Additional experiments 
showed that cells replicate their DNA during a discrete period in interphase called S phase, 
for DNA Synthesis.  The period prior to S is called G1 (gap 1) and the period after S, but 
before M, is called G2 (gap 2).  See Figure 2. 

 
Figure 2.  Schematic diagram of the cell cycle. 

Some cells exit the cell cycle and cease to proliferate.  This phase is sometimes referred to as 
G0.  Cells usually enter G0 prior to entering S phase.  Most neurons and RBCs have exited the 
cell cycle and no longer undergo cell division.  Other cells arrest in G0, but can be induced to 
divide, for example by injuries to tissues or during an immune response.  Lymphocytes are a 
good example of a cell type that can be induced to divide.   

In this lab we will explore the cell cycle using mammalian cells. You will also learn to 
perform a test of significance, the T-test, which will allow you to determine if the results you 
obtain can be explained by random chance, or if there is a statistically significance difference 
between the groups.  This basic statistical test will come in handy when you take on an 
independent project later in the course.   
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Task 1. Identify the stages of mitosis 
You may have already noticed dividing cells on your slides that are stained with DAPI.  In 
mitotic cells, the nuclear envelope has disassembled and the DNA has condensed into 
discrete chromosomes.  The slide you will use today has been stained with DAPI.  The 
microtubules that make up the mitotic spindle can be visualized because the cells express 
tubulin (subunit protein of microtubules) that has a fluorescent tag (GFP).  Fixed slides are 
useful to observe the different stages of mitosis and to estimate the % of cells in a population 
that are in mitosis.   
Using your DAPI and microtubule stained slide, find cells that are in each of the stages of 
mitosis and obtain paired phase and fluorescent images (UV illumination and blue 
illumination, to image DNA and microtubules).  Save these images on your computer.   

Use Figure 3 to help you identify the stages of mitosis:  
prophase: nuclear envelope is intact, chromosomes condensed  

prometaphase, nuclear envelope has broken down, but chromosomes are not aligned at 
the metaphase plate  

metaphase, all chromosomes aligned between the two spindle poles  

anaphase, sister chromatids have separated and are moving to the spindle poles  
telophase, chromosomes beginning to decondense, cell undergoing cytokinesis.   

 
Figure 3.    Schematic of the cell cycle, showing the stages of mitosis.  (Figure 17-2 in Alberts, 
et al, 2002, Biology of the Cell, 4th edition, Garland Science, reproduced with permission.) 

Can you find all of the stages of mitosis?  Do you find that it is more difficult to find 
examples of some stages than others?  

Task 2. Image spatial quantification 
You now have several digital images of cells.  What sorts of information can be gotten from 
these images?  One obvious thing you might need to know is the size of a cell or a 
subcellular structure.  This can be done once you calibrate the imaging system.  To do this, 
you will use a calibrated stage micrometer, a slide that has a very fine ruler etched into it 
(Figure 4). 
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Figure 4.  Stage micrometer from Ward’s Science (part # 949910) 

1. Return the 10× objective as the active lens.  Remove the cell slide and replace it with the 
calibrated stage micrometer slide.  Notice which side the stage micrometer is on.  That 
side faces the objective lens. 

2. Using phase contrast, locate the stage micrometer by eye, center it, and get it into focus.  
If you are having trouble locating the micrometer, look at it from above the microscope 
stage.  You should be able to make it out with your eyes.  Move it to near the center of 
the objective lens and then try to find it in the microscope again. 

3. Get the camera image of the stage micrometer, optimize it and be sure it is in good focus. 

4. Take a single image of the stage micrometer and save it. 
5. Switch to the ImageJ window.  Click on the line symbol and draw a straight line from one 

stage micrometer hash mark to another.  It will be most accurate if you draw the line from 
hash marks as far apart as possible.  (Why?) 

6. From the “Analyze” pull down menu select “Set scale…”.  The window that pops up will 
show you the distance in pixels of your line.  You need to type in the actual distance 
between the two hash marks that you used.  If you can’t figure this out, ask for help.  Be 
sure to use the correct units of measurement in the “Set Scale” box.  (1 cm = 104 µm.)  
Leave the aspect ratio set at 1.  Your camera has square pixels, so the aspect ratio 
(height:width) is 1. 

7. Put a scale bar on one of the two cell images from Task 3.  Use “Analyze > Tools > Scale 
Bar”.  Save this in a separate file, appropriately named, using the “Save as” button.  Make 
another Word or Open Office file with this image and an appropriate caption.  When a 
scale bar appears in an image you should always give the dimensions of the scale bar, in 
the caption instead of adding that number to the image.  The scale bar is usually 
positioned in one corner of the image where it will not obscure any important image 
detail. 

8. Determine the size that a camera pixel represents when the 10× lens is used.  You can do 
this by dividing the known distance between hash marks in part 6 by the distance in pixel 
units from part 6.  This value is the number of µm per pixel (or cm per pixel if you 
prefer).  This tells you how much of the specimen area falls on each pixel in the camera.  
This value will remain the same for any future use of this objective lens and camera in 
this microscope.  The value will be different for different lenses (and for different 
cameras, if you happened to use a different one). 
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Task 3. Determine the mitotic index.   
Using the slide stained for DAPI and tubulin, determine the mitotic index (MI), which is 
defined as the percentage of cells in a population that are in mitosis.  You will also identify 
the stage of mitosis for all the mitotic cells that you observe.  Use Figure 3 on page 24 to help 
you identify the stages of mitosis.  

Take images of at least 15 fields of view at 40× or 10×; for about 200 cells total.  Image each 
field in DAPI and fluorescein (microtubule) fluorescence and in phase contrast (if necessary 
to count individual cells).   

To take representative fields of view, position the coverslip/slide on the microscope so that 
you begin observation at one side (or corner) of the coverslip and then move the slide in a 
pattern (across, down, across, etc.), so that you don’t quantify the same region of the 
coverslip twice.  Save each image.   

Count the total number of cells in each image and the number that are in mitosis, and enter 
the data into a spreadsheet in Excel (provided for you - see below).  Then, for each mitotic 
cell, determine if the cell is in prophase, prometaphase, metaphase, anaphase, or telophase.   
You can do this after the lab period if you are running short on time. 

Calculate the mitotic index for the cells on your slide. 

Task 4. Testing the Significance 
Do cells spend the same amount of time in each stage?  Without observing individual cells 
going through the entire process and timing each stage, we can figure out the relative time 
spent in each phase by counting how many cells are in each stage at a given time. 
1. Using your own data, see whether cells spend equal amounts of time in each stage of 

mitosis.  See the section on χ2 tests, beginning on page 149.  Help illustrating any 
differences can be found in the section on comparing means, beginning on page 136.  

2. Using the class data, determine if the values for mitotic index are different between any 
of the groups. 
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Lab 1.3: Image Formation in the Microscope 
Goal for the module 
Learning the basics of image formation in the microscope. 

Pre-lab homework 
Visit Nikon’s MicroscopyU (http://www.microscopyu.com/sitemap.html).  Look over the 
contents to get a feel for what’s there and read the sections on refractive index, the optical 
train, Köhler illumination and phase contrast. 

Introduction 
The principles that allow the visualization of cells and cell structures in the optical 
microscope are based on so-called geometric optics.  This is the field that describes the 
redirection of light by lenses.  The ability of a lens to divert light arises from one 
fundamental aspect of the electromagnetic radiation that we call light: the speed of the light 
wave decreases when the light enters a medium from a vacuum.  You probably remember the 
relationship between light’s wavelength (λ), frequency (υ) and speed (c): 

 

This equation is valid when the light passes through a vacuum.  When it passes through a 
specimen, the speed of the light drops and the wavelength decreases, both by the same 
amount.  The degree to which the speed drops and the wavelength decreases is called the 
index of refraction (n).  Therefore, when the light is in a medium, its wavelength is 

 

and its speed is 

 . 

This relationship is important because it shows why curved lenses with high refractive index 
bend light coming from air with a low refractive index.  In essence, the light takes longer to 
travel through a thick piece of lens as compared to a thin piece, and so the wave is retarded in 
the thick section of lens.  See Figure 5 and the tutorial at MicroscopyU 
(http://www.microscopyu.com/articles/formulas/formulasri.html). 
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Figure 5.  Light rays entering a medium of higher index of refraction at an angle have their 
wave fronts bent toward the normal of the medium due to the slowing of the rays by the high 
index medium.  If the medium is wedge-shaped, the waves are bent. 

The alteration of wave speed and wavelength in media of differing indices of refraction also 
affects the movement of light through a microscope specimen.  Although the differences in 
index of refraction between the surrounding aqueous medium and a cell are small, they can 
be exploited to produce image contrast. 

Materials 
Glass slide with a cover slip of fixed LLC-Pk1 pig kidney epithelial cells, stained with DAPI. 
A ruled stage micrometer. 

Procedures 
Task 1. Aligning the optical system for Köhler illumination 
Although a poorly aligned microscope can produce an image of a specimen, the best possible 
image can only be obtained when the microscope is properly aligned.  In this task, you will 
align the transmitted light portion of the microscope optical path.  The proper alignment of 
the light source and imaging lenses is said to follow Köhler illumination. 
1. If you have not already turned on your microscope, do so now.  Follow the turn-on 

procedure on page 12.  You will not be using fluorescence in this lab, so do not turn on 
the epi-illuminator.  The arc lamp used in the epi-illuminator has a limited lifetime, and 
so should be left turned off unless you need to use it. 

2. Rotate the nosepiece so that the 10× lens is facing the stage opening.  Use the side of the 
nosepiece so as to avoid fingerprints or other damage to the (expensive) microscope 
objective lenses.  Rotate the eyepiece turret to the “O” position (see Figure 6).  Rotate the 
condenser turret to the “A” position (the one facing forward).  Both of these settings 
leave the optical path fully open. 
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Figure 6.  Adjustment points on the Nikon TE2000.  (Image from Inverted Microscope Eclipse 

TE2000E Instructions, reprinted with permission from Nikon.) 

3. Focus the sample.  For all subsequent steps, the sample must remain in focus.  Place the 
stage micrometer on the stage, turn on the transmitted light condenser illuminator, adjust 
it for brightness, and focus the stage micrometer.  Notice which side the stage micrometer 
is on.  That side faces the objective lens.  If you are having difficulty finding the 
micrometer, try to center it over the objective first by looking at the micrometer from 
above. 

4. Adjust the microscope for proper Köhler illumination.  (See Figure 6 for a key to the 
adjustable elements on the microscope.) 
a. With the stage micrometer still in focus, reduce the size of the field diaphragm by 

moving the lever.  When the lever is in the up position (as shown in Figure 6) the 
diaphragm is fully open.  Moving it down will reduce its size.  You should be able to 
see an outline of the field diaphragm as your reduce its size.   

b. Rack the condenser focus knobs until the field diaphragm is in focus.  DO NOT 
CHANGE THE FOCUS OF THE SPECIMEN (THE STAGE MICROMETER).  You 
will note that the edges of the field diaphragm appear to have a color gradient, 
making the edge a bit difficult to discern.  This is due to what is called chromatic 
aberration in the lenses.  Chromatic aberration causes light of different wavelengths 
(colors) to focus at slightly different focal planes.  You can limit this problem by 
restricting the range of wavelengths of light that are being observed.  One of the 
sliders on the right hand side of the microscope top between the field diaphragm and 
the light source is a so-called bandpass filter that passes a limited range of 
wavelengths in the green range of the spectrum.  It is marked “G”.  Push it into the 
beam path and see how the field diaphragm image is improved. 

c. Adjust the centering of the field diaphragm until it is nearly centered.  Do this by 
using the two knobs on either side of the front of the condenser turret Figure 6. 
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d. It can be somewhat difficult to determine the center of the field of view when the 
field diaphragm is fully stopped down.  A trick to get perfect centering is this: Open 
the field diaphragm until it is nearly, but not quite out of the field of view.  The edges 
of the field diaphragm will be close to the edges of the field of view.  Tweak the 
centering until the field diaphragm is exactly concentric with the edge of the field of 
view.  Repeat b and c until you have a sharp field diaphragm that is centered. 

e. Open the field diaphragm a bit until the whole field of view is illuminated.  Open it 
just to the point that it disappears.  Opening farther than that will cause light to scatter 
inside the body of the microscope, thus degrading the image. 

f. The microscope is now set up for Köhler illumination.  What you have accomplished 
by this process is to direct light rays originating from the light source onto the focal 
point of the condenser (so that the light coming from the condenser is composed of 
parallel rays) and you have centered the condenser (so that the parallel illumination 
rays are also parallel to the optical axis of the microscope).  These adjustments must 
be made any time that you change objective lenses.  You should do this every time 
you use the microscope. 

Task 2. Bright field imaging 
In this task you will use unstained cells to explore the ability of the microscope to generate 
contrast using transmitted light. 
1. Leave the microscope set up as in Task 1.  Place a slide with cells on a cover slip on the 

microscope.  Adjust the stage and focus to get cells in view.  This will be difficult.  The 
reason is that most animal cells have little in the way of pigments or coloring to produce 
image contrast that is necessary to provide the brain a way to interpret the image. 

2. Contrast can be gained at the expense of resolution (a topic to be covered in a later lab).  
To do this, reduce the size of the condenser aperture diaphragm.  (This is not the field 
diaphragm that you just centered.  This is a diaphragm for which the opening is 
controlled by a rotary dial as shown in Figure 6).  The condenser aperture diaphragm 
control is on the front of the condenser module, just below the two knurled nuts that you 
used to center the field diaphragm.  You may need to increase the illumination level 
because reducing the condenser aperture will decrease the amount of light entering the 
specimen.  What is happening physically is that the diameter of the column of parallel 
rays is changing as the condenser diaphragm is changing.  This causes the cone of light 
emanating from the specimen to decrease, and this, in turn, reduces the resolution in the 
image, increases the depth of focus, and increases the contrast partly because the amount 
of background light in the image decreases. Observe your cells as you open and close the 
iris. How does the image change? 

3. Open the condenser aperture diaphragm as far as possible and still see cells.  You want to 
operate this way so as to keep the image resolution as high as possible, unless you need to 
increase contrast. 

Task 3. Phase contrast 
As you saw in Task 2, strong contrast is not an inherent property of the specimen that is 
being observed.  Good contrast is produced by exploiting the interaction of the illuminating 
light with the specimen, and using the changes produced by the specimen in clever ways.  
One such way is called phase contrast.  This method was invented by Fritz Zernike, for 
which he received a Nobel Prize. 
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Phase contrast takes advantage of the fact that all microscopic samples diffract light and 
images are built up from the recombination of the un-diffracted (so-called zero order) and 
diffracted beams.  Think of the zero-order beam as the background.  Even absorbing (i.e., 
black) samples diffract light.  You can see this by blocking the zero order beam and noting a 
dark object becomes bright (we can demonstrate this in lab).  Absorbing samples look dark in 
part because the diffracted light is 180˚ out of phase with the zero order light and hence 
destructive interference ensues.  Transparent samples diffract light too, but introduce a phase 
shift that does not cause appreciable interference.  Phase contrast is a trick to introduce a 
relative phase shift between the diffracted and zero-order beams that lets them interfere 
destructively and gives rise to an intensity difference we can see.    

This is accomplished in the phase-contrast microscope by two circular, optical elements 
(Figure 7).  In the front focal plane of the condenser, there is an annulus that restricts the 
illumination to a ring.  In the rear focal plane of the objective, there is a phase ring (labeled 
phase plate in Figure 7) onto which the ring of illuminating light is focused.  The 
illuminating light is the zero-order beam, un-deviated by diffraction; when it traverses the 
phase ring, its phase is advanced or delayed (depending on the instrument design) relative to 
light passing through the rest of the rear focal plane.  It is also customary to reduce the 
intensity of the zero order beam by reducing the transmission of the ring. The annulus is built 
as an opaque sheet with an annular opening through which light passes; the phase ring is a 
flat plate, which is etched away or built up in a ring shape, at the appropriate diameter.  Phase 
contrast requires the illuminating annulus and the objective phase ring to be superimposed 
precisely.   

phase  
Figure 7. Main features of the phase contrast microscope. The Illumination is restricted to a 
ring by the annulus. The object (sample) diffracts light, giving rise to diffracted (dashed lines) 
and unaffected (“zero order”) light. These beams recombine in the image (not shown). The 
phase of the zero order beam relative to the diffracted beam is altered by a quarter wavelength 
at the phase plate, which allows destructive interference to occur, making the object appear 
dark.  (Figure 24 from  Spencer M., 1982. Fundamentals of Light Microsopy, Cambridge 
University Press, London, reproduced with permission.)  

In this task you will set up the microscope for phase contrast imaging. 
Leave the 10× objective lens and cells in place from Task 2.  Confirm that cells are in focus 
and that the microscope is set up for Köhler illumination. 

1. Observe the tube of the 10× objective.  It has “Ph 1” printed on its side, which indicates 
that the objective has in its back focal plane a phase ring that obscures a circular annulus 
of the back focal plane.  This phase ring is matched to a clear annulus that can be placed 
at the focal plane of the condenser.  Rotate the condenser turret selector until it says “Ph 
1” (at the front).  Observe the improved contrast in the image. 
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2. The phase ring in the objective lens is fixed in place.  The condenser annulus can be 
moved.  You should check to see if the condenser annulus is properly aligned with the 
objective phase ring. To do this, move the eyepiece turret selector to “B”.  This stands for 
Bertrand. There is a small silver knob to the right and underneath of where it says B. 
Make sure the annulus is sharp by rotating that knob. A Bertrand lens allows the eyepiece 
to image the condenser focal plane rather than the specimen focal plane.  Because the 
condenser focal plane is the location of the condenser phase annulus (and is conjugate 
with the location of the objective lens phase plate), the Bertrand lens allows you to see 
the location of these two elements.  If the condenser annulus is not concentric with the 
phase ring, use the red-handled tools on the side of the microscope to adjust it. There are 
two, recessed hex-head adjustment screws on either side of the marking on the condenser 
turret for this adjustment. 

3. Return the eyepiece turret to the “O” position and observe the cells again. 

Task 4. Exercise in adjusting the microscope 
In this task you will take a misadjusted microscope and return it to proper alignment.  When 
you are ready to do this, ask one of the instructors to misadjust the microscope.  You then 
will readjust the microscope and document your steps by taking pictures during the process. 
1. For this exercise, use the 10× lens.  You should follow the procedures above to first set 

up the microscope for Köhler illumination and then for phase contrast.  You should take 
the following pictures to document the process: 
• An image of the cells when first focused in the misaligned microscope. 
• An image of the edge of the unfocused field diaphragm as you begin the adjustment 

for Köhler illumination. 
• An image of the edge of the focused field diaphragm that has been centered. 
• An image of the cells in brightfield when the system has been properly adjusted for 

Köhler illumination. 
• An image of the cells when the phase annulus and phase ring are in place, but 

misaligned. 
• An image of the cells when the phase annulus and phase ring are properly aligned. 
Upload a selection of interesting images with comments to your corner of the class web 
page. 

Further studies 
You now have the basic tools to set up the microscope for Köhler illumination and phase 
contrast.  You might want to examine other samples, comparing phase contrast with 
brightfield.  Try a stage micrometer.  Which imaging technique works best for a sample that 
has strong absorption contrast (like the stage micrometer)?  Are the camera pixels really 
square? To what accuracy? What happens if you calibrate at 45˚? 

Clean-up 
Save good slides for future use.  Discard (in the glass trash) any slides that had bad 
specimens, got cracked, or are totally photobleached.  Return the micrometer to its box. 
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Lab 2.1:  Numerical Aperture 
Goal for this lab:  
Establishing the definition of numerical aperture and its role in the microscope. 

Pre-lab homework 
Visit Nikon’s MicroscopyU (http://www.microscopyu.com/sitemap.html) and read the 
sections on numerical aperture and depth of focus. 

Do the calculations on page 37. 

Introduction 
The quality of a microscope imaging system is characterized by a number of factors.  The 
one that most influences the ability of the system to resolve details in the specimen is called 
the numerical aperture or NA.  The NA is defined as 

 

where n is the index of refraction of the medium between the lens and the specimen and α is 
the half-angle of the cone of light that maximally fills the lens.  See Figure 8 for a diagram of 
this angle. 

 
Figure 8.  Light originating from the specimen plane can, in principle, spread in a 360°  
circle.  Only a portion of that light can be captured by the objective lens.  The angle 
between the optical axis (dashed line) and the maximum cone of light entering the lens is α .  
Any aperture in the objective lens limiting the diameter of light in the lens will limit the 
maximum numerical aperture of the lens. 

From Figure 8 and the equation for NA, it should be clear that two factors control the 
numerical aperture:  

1. the index of refraction of the medium between the specimen and the lens and  

2. the diameter of the lens.   
The larger is the NA, the more of the light cone is collected.   

!sinnNA =
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The size of the light cone (which is proportional to the NA) determines two important things 
about the image of the specimen:  

1. the amount of light collected and  
2. the size of the smallest resolvable spacing within the specimen.   

The first of these should be evident from Figure 8.  Suppose a luminous particle is emitting 
light evenly in all directions.  The amount of light collected by the objective lens increases 
with increasing light cone size because more light falls on the front lens.  The second point is 
not as obvious, and requires some knowledge of light scattering and interference.  We will 
consider this aspect of NA in the next lab period. 
When a specimen is illuminated by a condenser and imaged by an objective, the NA of the 
condenser and the objective both contribute to the amount of light available to make an 
image and to the resolution of the image.  See Figure 9.  When the objective and condenser 
both contribute to the NA of the microscope, the effective NA is 

 . 

 

Figure 9.  The NA of an optical system depends on the 
NA of the components that are involved in making the 
image of the specimen.  For transmitted light, both the 
condenser and objective contribute to NA.  In this 
example (a typical one), the condenser has lower NA 
than the objective (because αo > α c). 
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Pre-lab homework 
Before you come to class, do the following exercise.   
One of the 100× objective lenses on your microscope has a variable NA that ranges from 0.5 
to 1.25.   
It uses oil between the specimen cover slip and the front lens of the objective.  That oil has an 
index of refraction of 1.51.   

For green light of wavelength 530 nm (or 5.3 × 10-7 m): 

• What is the full angle of the cone of light that the objective can accept when its NA is 
0.5?  (See Figure 9 for a diagram of the cone of light.)   

• What is the full angle when its NA is 1.25? 

Materials 
Glass slide with a cover slip of fixed LLC-Pk1 pig kidney epithelial cells that have been 
stained with DAPI, a fluorescent marker for DNA, fluorescein-anti-tubulin and rhodamine-
phalloidin, that labels F-actin. 

A ruled stage micrometer. 

Procedures 
Task 1. Oil immersion objectives:  the role of magnification on 
image intensity 
Objective lenses are made of glass or similar material.  That is, the index of refraction of the 
objective lenses is greater than that of the air.  Cells sit on glass (or plastic) substrates, both 
of which have higher indices of refraction than air.  Thus, the light that forms an image of the 
cells makes transitions across several different regions with different indices of refraction. 

For objective lenses that collect a wide cone of light (lenses of high numerical aperture), the 
index of refraction of the material between the lens and the specimen must be high.  Often, 
this material is oil.  The oil also has another purpose.  Transitions between media of different 
indices of refraction cause refraction of light, which can be wavelength-dependent.  These 
transitions in the interfaces between the cells and the objective lens can lead to considerable 
image aberrations that are difficult to correct.  To avoid the transitions from the cover slip to 
the objective lens, oil with a refractive index equal to that of glass is used for many high NA 
lenses.  Lenses for which oil is used between the lens and the specimen are called “oil 
immersion” lenses.  The immersion part is meant to indicate that the lens surface is immersed 
in oil, not the whole lens.  IT IS VERY IMPORTANT TO KEEP OIL OUT OF THE 
LENS.  OIL SHOULD ONLY TOUCH THE FRONT SURFACE OF THE LENS.  Ask for 
help if you need to clean a very dirty lens. 

In this task we will compare the image generated by a 10× air, 40× air and 100× oil lens. 
1. If you have not already turned on your microscope, do so now.  Follow the turn-on 

procedure handout. Insure that the fluorescence epi-illuminator field block is in the light 
path so that no bleaching of fluorophores occurs. 



38 Lab 2.1:  Numerical Aperture 

2. Put the 10× lens to the microscope optical path. Find an interesting group of cells, adjust 
the microscope for proper phase contrast, take an image, and save it.  You will compare 
this image to that for other objectives.  One point is to observe the change in the 
brightness of the image.  This can be accomplished quantitatively by forcing the image 
display to be on a fixed bright-to-dark scale.  If you don’t remember how to do this, 
review Task 6.8 from Lab 1.1, on page 18.  Now play with camera exposure time and 
light intensity to get a nice image.  Note the exposure time you have used.  Don’t change 
it or the illumination level for the next two pictures.  Don’t forget to save the image for 
the 10× lens. 

3. Put a 40× lens in the optical path, take and save an image.  For purposes of this Task, do 
not change the brightness of the transmitted light.  You should check microscope 
alignment and image focus before you take the picture. Remember that the condenser 
turret has more than one phase ring. Be sure you use the correct one for the objective 
lens. 

4. Now put the 100× Plan Fluor Dll lens in the optical path.  (Make sure you chose the right 
lens: the Achromat FF 100× lens is not a phase contrast lens.)  The 100× lenses require 
immersion oil.  To apply it, you can use one of several techniques: 
a. Remove the slide, put a drop of oil on the objective lens, being careful to avoid 

touching the lens surface with the applicator, and replace the slide.  This method 
requires careful replacement of the slide to keep the same cells in the field of view. 

b. Rack the objective turret down so that the top of the objective can be oiled as above.  
This method is awkward. 

c. Rotate the objectives so that the 100× lens is off to the side.  Oil the objective as 
above and return the 100× to its correct position.  This method is relatively easy, but 
it is also easy to get oil on the wrong places. 

5. If any oil gets on places other than the glass front surface of the objective lens, remove it 
immediately.  Kimwipes are OK for any non-lens surface.  ALL LENS SURFACES 
SHOULD BE WIPED ONLY WITH LENS TISSUE.  Lens tissue is specially 
formulated with nonscratch fibers.  Kimwipes, Kleenex and many cloths are very 
abrasive to the coatings on microscope lenses.  These sorts of wipes should never be used 
on lens surfaces. REPEAT:  ONLY USE LENS TISSUE TO CLEAN LENSES. 

6. Adjust the microscope for Köhler illumination, proper phase contrast and focus.  Do not 
change the brightness or the image exposure time. If you cannot find cells, try 
fluorescence with UV excitation for DAPI. Remember to return to phase contrast once 
you have found and focused on cells.  Take and save the image. 

7. When you are finished with this or any oiled lens, clean the oil off of the lens by: 

a. Exposing the lens surface by removing the glass slide or rotating the lens to a 
convenient position. 

b. Blotting the oil from the lens with a lens tissue.  Do not put your fingers on the part of 
the tissue that touches the lens and do not touch the lens surface with your fingers.  
This can leave finger oils and grit on the lens.   

c. Cleaning the surface further with lens cleaning solution (90% ethanol in our case) if 
you are done with the lens.  You can leave the oil residue on the lens for now until 
you are completely finished with all oil immersion lenses.   
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Task 2. The role of NA on image intensity: brightfield 
This exercise will explore the role that the NA of the objective lens plays in control of image 
intensity when the microscope is set up for brightfield.  In this case, the effective NA of the 
system depends on both the objective NA and the condenser NA. 
1. Use the cover slip of cells from Task 1 on page 37.  There is no need to clean the oil off 

the cover slip because you will be using another oil lens.  Put in the Achromat FF 100× 
lens and find cells. This may not be easy because this lens does not have a phase ring, so 
it must be used in brightfield.  (If you are having trouble, clean off the cover slip by 
gently wiping with a Kimwipe or lens tissue – the coverslip won’t scratch like lens 
coatings will, thus any sort of wipe will do – and finish with a wiper dampened with 
ethanol.  Try to get most of the oil residue off.   Find cells using the 10× lens, check the 
alignment of the microscope, and then move up to the Achromat FF 100× lens.)  The 
Achromat FF 100× is an oil immersion lens that has an iris diaphragm inside it.   

2. Find a location that has some reasonable amount of contrast so that you can properly 
focus on the image.   

3. This objective lens has an iris aperture inside it that can be opened or closed to change 
the NA of the lens (see Figure 8 to see why this will change the NA).  The NA can be 
changed from a maximum of 1.25 to a minimum of 0.5.  Locate the iris ring on the 
objective.  While observing the specimen, rotate the ring to see the effect of changing the 
NA.  Leave the iris fully open for the next part.  (How will you be able to tell the iris is 
fully open?)  The Bertrand lens can be useful for this.  

4. Double check the focus of the area of cells you have chosen.  Take a picture of the cells.  
Set up Micro-Manager to display the full range of black to white signal from the camera.  
(See Task 6 on page 16 if you forget how to do this.)  Once you have gotten a good 
image, save it.  This image is for an NA of 1.25. 

5. Carefully rotate the objective lens iris ring till it is about halfway between fully open and 
as small as possible.  Try to avoid bumping the cells.  If you do move the cells, repeat 
step 4 and try step 5 again.  You should be able to rotate the ring without changing the 
position of the cells.  Touch up the focus.  Now, without altering the lamp brightness, the 
exposure time or the scaling of the image display, take another picture.  Save this one.  
This NA setting is about 0.875, which is halfway between 1.25 and 0.5. 

6. Carefully rotate the objective lens iris ring till the iris is as small as possible.  Touch up 
the focus.  Now, without altering the lamp brightness, the exposure time or the scaling of 
the image display, take another picture.  Save this one.  This NA setting for this image is 
0.5.  We will quantify these images later. 
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Task 3. The role of NA on image intensity: fluorescence 
This task will explore the role that the NA of the objective lens plays in control of image 
intensity when the microscope is set up for fluorescence.  In this case, the effective NA of the 
system depends on the objective lens NA only.  Do you know why? 
1. Leave the microscope set up as in Task 2.  Return the objective lens iris ring to its fully 

open position.  Rotate in the UV fluorescence filter set, find some cells that have nicely 
stained nuclei (the stain is DAPI), and adjust the brightness of the UV illumination 
appropriately with the neutral density filters on the back of the microscope near the epi-
illuminator lamp housing. 

2. Adjust the brightness of the fluorescence illumination and the exposure time as you did in 
step 4 in the previous task.  Remember that the shutter controller must be under computer 
control.  (If it is not, the fluorescence light will be on constantly, and that can result in 
photobleaching.  Photobleaching will result in a continual loss in fluorescence intensity, 
and that loss, in turn, will skew the results when you quantify image intensity for the 
series of pictures that you generate in this task.) 

3. As in Task 1 on page 37, take three images at the three different settings of the objective 
lens iris size for NA 0.5, 0.875, and 1.25.  Save all of them for later analysis.  Don’t 
forget to close epi-illumination shutters between images.  Strive to keep the exposure 
time of the cells as low as possible to avoid photobleaching. 

Task 4. Image intensity quantification 
Information in your images contains three dimensions: two axes in space (the x, y location) 
and intensity (the brightness of the image).  If you take multiple images in a time-lapse 
sequence, that would be a fourth dimension (time).  You’ll do that in future labs.  If you have 
a microscope with computer focus control or a steady hand, a fifth dimension, the focus 
direction z, is available.  Changing the focus in z allows you to focus on different parts of the 
sample (which we will do in a future lab).   
In this task you will quantify the differences in image intensity from the images you took in 
the previous two tasks.  This is computer-only work, so you can now shut off the microscope 
illuminators and camera.  You can even do this work at home by downloading a copy of 
ImageJ from its home at the NIH (http://rsb.info.nih.gov/ij/).  ImageJ is freeware that runs on 
many common computer platforms.  (In this lab you will consider image intensity.  In the 
next lab you will use these same images to look at image resolution.) 
1. Open one of the image files of the DAPI-stained cells you took in Task 3, on page 40.   

2. Using the “Freehand selections” or “Polygon selections” tool in the ImageJ window, and 
put a polygons or a closed freehand shape on the image.  For example, surround a 
nucleus, or surround a region free of any fluorescence.  Once you have a region of 
interest (ROI), select the “Analyze> Measure” pull-down menu item.  This will bring up 
a window with some data on the ROI. Do this several times to get the hang of how to 
place regions and what parameters show up in the measurements window. 

3. The data are parameters of interest for the ROI.  We will use the parameters below.   

a.  Area: this is the mathematical area in square units, based on your calibration.   
b. Mean: this is the arithmetic average value of the intensity in the ROI.  



Unit 2:  Making Images 41 

c. Min and Max: These are the minimal and maximal intensities in the ROI.   
 
If these parameters are not present, then you can set which ones show up in 
ImageJ.  The absolute size of these numbers depends on a number of factors 
including the response of the camera, how the camera signal is converted to numbers 
in the computer, what filters were in the microscope, what objective lens was used, 
and so on.  Thus, so long as you use the same settings, filters, lamps, etc., you can 
quantitatively compare the signal in two different images or in different regions of a 
single image. 

4. Draw an ROI around a nucleus.  Be sure to get as much of the nucleus in the region as 
possible but none of the dark area outside the nucleus.  Measure this.  Then draw an ROI 
in a region of the sample that has no obvious fluorescence, about the same size as a 
nucleus.  This should be dark; we call it a background region.  Measure that region.  If 
the camera and software are set up correctly, the mean intensity will be greater than zero 
in the background ROI. This is due to at least 3 factors:  
a. There is noise in the imaging system that translates to intensity noise in the camera.  

b. Regions of the specimen, the medium it is bathed in, or the glass of the microscope 
can “autofluoresce”, i.e. produce photons even in the absence of a fluorescent stain.  

c. You are not working in the dark, and thus extraneous photons can leak in to the 
camera through the objective lens. 

5. Therefore, the mean intensity in your first ROI is the sum of the DAPI signal plus 
background signal.  To obtain the signal from the DAPI alone, you need to subtract the 
background signal from the signal from nucleus.  This will give you a background-
corrected mean intensity.  For all of the work below when you are asked to measure 
intensities, always correct for background.  

6. Average intensity tells you about the average brightness within a region of the image.  
What is sometimes useful is not the average brightness, but rather the integrated 
brightness.  The latter represents the total number of fluorophore molecules, while the 
former represents the lateral concentration of fluorophores in the region of the image.   
 
If you have a hard time seeing this, draw out a 4 × 4 grid.  Place any number of dots in 
each grid.  The dots represent fluorophores.  Figure out the average number of dots per 
grid box.  Now multiply by the number of boxes.  The value (of course) is the total 
number of dots in the grid.  As you can see, increasing the size of the grid will increase 
the total number of dots while the average value would remain about the same if you 
added dots to each new grid box about like you did at first.  So now multiply the average 
background-subtracted intensity times the area of the first ROI.  This number (in some 
funny system of units) is proportional to the number of DAPI molecules in the ROI.  And 
that is proportional to the DNA content in the ROI. 

7. Collect values of average and integrated intensity for 5 or more nuclei and compute their 
average and standard deviation.   

8. Repeat this procedure for the other two fluorescence images.  Compare the values you get 
for the three different NA settings. Each lab partner should do the measurements 
independently.  In your lab report, you may give the results for your partners and discuss 
differences if present.  
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9. The values that are produced by ImageJ will have many digits.  Most of these are 
nonsense, because repeated measurement of the same image area will not produce the 
same result to so many digits.  You need to come up with a reasonable number of digits 
for numerical values that you report in this course. A simple, approximate way to 
determine how many digits to report is based on the standard deviation.  For example, 
you might compute the average intensity of a set of ROIs to be 4913.662788 and the 
standard deviation to be 456.199034.  Here the SD is about 460, which is a measure of 
the accuracy of the measurements.  So in our example a reasonable way to report the data 
would be 4910 ± 460.  This is a fair representation of the accuracy of the system.  

Further studies 
How does image brightness vary with NA for brightfield imaging?  
You took backgrounds by using an ROI in a dark region of the sample.  What if your image 
was full of cells with no empty regions?  How else could you get background information?  
Will the NA of the objective be different for a red fluorescent specimen (with λ = 700 nm) 
than for a blue fluorescent specimen (with λ = 450 nm), and if so in what way? 

Clean-up 
Save good slides for future use.  Discard (in the glass trash) any slides that had bad 
specimens, got cracked, or are totally photobleached. 
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Lab 2.2:  Resolution 
Goal for this lab:  
Establishing the definition of numerical aperture and its role in the microscope. 

Pre-lab homework 
Visit Nikon’s MicroscopyU (http://www.microscopyu.com/sitemap.html) and read the 
sections on resolution and the subsection called “Matching Optical Resolution to Detector 
Geometry” in the section about optical system and detector requirements. 

Introduction 
In the first part of this unit you looked at the role of numerical aperture on the light 
transmission properties of an optical system.  Recall that the NA is defined as 

 

where n is the index of refraction of the medium between the lens and the specimen and α is 
the half-angle of the cone of light that maximally fills the lens.  The maximum angle of light 
that can enter the lens is determined by the NA, with larger NAs corresponding to larger 
angles.   

Suppose a small object is illuminated by uniform, parallel rays of light.  That object scatters 
light in all directions, the amount of which depends on the wavelength of the light and the 
structure of the object.  It turns out that the smaller features of the object scatter light more 
widely that the larger features.  The information of the small features is thus contained in 
light at large values of α in Figure 8 on page 35.  Clearly, then, an optical system with a large 
NA can collect light from smaller features of the specimen and thus can reproduce the 
smaller features in an image better than a system with a small NA.   

A very small light source (a self-luminous dot, a fluorescent microsphere or a small scatterer) 
emits light in all directions.  The loss of light coming from the light source at large angles 
limits the information about the source that is collected by an imaging device.  Thus, when 
the device forms the image of the source, not all the information is present.  The result is an 
image that looks different than the source.  The point source turns into a diffraction pattern, 
bright in the center and dimming as distance from the center gets larger.  The pattern formed 
is called an Airy disk (see Figure 10). 

 

Figure 10.  The Airy disk (named for its discoverer, George Airy).  
This pattern of a point light source much smaller than the 
wavelength of the light forming the image is due to interference 
effects.   
 
Image taken from 
www.cambridgeincolour.com/tutorials/diffraction-photography.htm. 
Used with permission. 

 

The size of the Airy disk and spacing of the diffraction rings depend on the wavelength of 
light that forms the image and on the NA of the imaging system.  If two small light sources 
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are near each other, they will each form an Airy disk.  They can be distinguished if their two 
Airy disks do not overlap.  As the particles are brought closer together, their Airy disks begin 
to overlap.  It is customary to say that the resolution limit of the imaging system is the point 
at which the first minimum in the Airy disk of one particle overlays the maximum of the 
other particle.  Mathematically, this condition is 

 

where rmin is the minimum resolvable separation of two small objects, λ is the wavelength of 
the light forming the image and NA is the numerical aperture of the imaging system.  This is 
called the Rayleigh criterion. 
For digital microscopy (or photomicroscopy in the case of photographic film usage or video 
microscopy in the case of video camera usage), the camera that collects image light from the 
specimen has a physical array of light collection points.  The size of each of the array 
elements (or pixels), in relation to the size of the image, dictates the resolution of the camera.  
For our CCD camera, this is the array of photoelectron wells that hold the electrons generated 
by photons striking the camera face.  The QICAM has an array of 1392 × 1040 wells that are 
4.65 µm on a side.  The imaging CCD is manufactured by Sony (model ICX 285) and is used 
in several commercial instrumentation-grade cameras.   

When the camera pixel size in specimen dimensions is much larger than the Rayleigh 
criterion size, the camera is unable to resolve details that the microscope can produce (Figure 
11).  In contrast, when the camera pixel size is much smaller than the Rayleigh size, the 
camera resolution is easily sufficient.  The minimal camera pixel size possible to still resolve 
an object is given by the Nyquest theorem, and is usually taken as about 4 pixels per object.   

 
Figure 11. Relation between the Airy disk (white circles) and camera pixels (gray grid). 
When the Airy disk is less than the size of a pixel (under), specimen details that can be 
resolved by the microscope are lost due to the limited resolution of the imaging device.  
When the Airy disk is much larger than the size of a pixel (over), the resolution of the 
imaging device has no problem.  The minimal size able to be resolved (near) is when 
pixel size is about one fourth the area of the center part of the Airy disk. 

In the previous paragraph, the phrase in specimen dimensions was highlighted.  Recall from 
earlier lab modules that the image of a specimen projected by a 10 × lens covered much more 
of the cover slip than that projected by a 40× lens.  When collected by the camera, the 
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specimen area per pixel is about 16 times smaller for the 40× lens than for the 10× lens (each 
pixel side covers 4 times less distance for the 40× lens, and area is the product of the x- and 
y-dimensions, thus 4 × 4 = 16 times less area).  The important thing to note is that the 
dimensions of a pixel on the camera represent different specimen dimensions depending on 
the magnification of the microscope in front of the camera.   

In information theory, the content of data is considered as a signal containing complementary 
information.  In the case of a wave, we often think about the frequency or the wavelength.  
These two pieces of information complement each other, as the wavelength decreases in 
proportion to increasing frequency.  In considering an image, the same thing is true.  The 
spatial dimensions of an object are like the wavelength of a wave and something called the 
spatial frequency is like the frequency of a wave.  The smaller a structure in an image is, the 
higher its spatial frequency.  Thus, for a microscope to image a small object requires that it 
pass high spatial frequencies.  This is what a high NA lens can do.  Likewise, to capture a 
high spatial frequency image, the camera must have small pixels.  The information theorem 
that describes this relationship, called the Nyquist criterion, says that the frequency of 
sampling must be twice the largest frequency of interest. Because an image is two-
dimensional, this works out to approximately 4 pixels per Airy disk.  This size, then, sets the 
dimensions of the elements of an imaging device needed to attain a given resolution.  In this 
lab we will think about the relative dimensions of a camera pixel and how that relates to 
image resolution. 
Before you come to class, do the following exercise.  Suppose you are working with the long 
working distance 40× lens on your microscope (the Plan Fluor ELWD 40×).  It has an NA of 
0.60.  For blue light of wavelength 450 nm, what is the Rayleigh criterion resolution of the 
microscope, assuming the NA of the objective is the only NA that is relevant?  If you wanted 
to use a camera that fulfilled the Nyquist criterion, what would the area of a pixel of the 
camera need to be? 

Materials 
Glass slide with a cover slip of fixed LLC-Pk1 pig kidney epithelial cells that have been 
stained with DAPI, a fluorescent marker for DNA, and fluorescein-anti-tubulin. 
A ruled stage micrometer. 

Procedures 
Task 5. The role of NA on image resolution 
The NA of the imaging system limits the resolution that the imaging system can produce.  In 
this task you will attempt to show that reducing NA reduces resolution. 

1. Turn on and set up the microscope with the 100× objective lens in position, focused on 
cells.  Don’t forget the immersion oil.  Return the objective iris ring to fully open so that 
the NA is 1.25.  Using the green fluorescence excitation setting on the fluorescence filter 
cube selector (position G), scan around until you find some fine structures in a cell or 
cells. What you want to find is a region with the finest structures that you can see, 
particularly if the structures run together at some point.  Spots or fine linear elements 
work well. You can find suitable areas with either green excitation (for actin) or blue 
excitation (for microtubules). Don’t forget to turn off the fluorescence when you have 
found the area you want to use.  The fluorescence of the sample will decrease in 
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proportion to the length of and brightness of the illumination light.  This is called 
photobleaching. 

2. Quickly check the focus and exposure with the camera.  You want to have the fine 
structures that you are examining to be reasonably exposed.  You may need to 
overexpose some of the brighter areas in the field of view to do that.   

3. As in part 3 of Task 2 on page 39, take a series of images at NA 0.5, 0.875, and 1.25 and 
save them. For this task, adjust the exposure time as needed to maintain the overall 
brightness similar for each image. Here, be careful to keep the focus fixed, so if you 
bump the cells while changing the objective iris, either find a new area and start over or 
carefully tweak the focus to keep the fine structure in focus.  This may not be easy at the 
lower NA values because the resolution of the microscope is degraded. 

4. You will look at difference in resolvability of the two close dots in your lab report.  Do 
you see evidence of the bright and dark Airy disk rings like those in Figure 10? 

Task 6. Camera resolution 
In this task you will compare the resolution of the camera with the available resolution of the 
microscope.  Recall that the microscope has a limiting resolution defined by the Rayleigh 
criterion and that the camera has a set number of pixels.  Here you will measure the 
dimensions of a pixel, which is different for each of the objective lenses.  These dimensions 
will not change so long as you use the same camera and objective lens set, so this one 
measurement will allow you to calibrate all future image dimensions as well as allow you to 
determine how well the camera resolution matches the microscope resolution for each 
objective. 

1. Replace the cell slide with the ruled stage micrometer.  Before you put the stage 
micrometer on the stage, rotate the 10× lens into the optical train.  This will keep the 
stage micrometer free of oil for now.  Be sure to put the green interference filter into the 
condenser illumination path.  This will limit the spectrum of wavelengths of light to those 
in the green range, which with this filter has a center wavelength of 545 nm, and a 
wavelength bandpass of 60 nm. 

2. Take an image of the stage micrometer.  Brightfield probably will give you the sharpest 
image. If you use brightfield, remember to remove the phase ring from the light path. 
Repeat this process for all of the microscope objectives.  Be sure to save files with file 
names that make sense.  Of course, you will need to use immersion oil for the two 100× 
lenses. 

3. Switch to the ImageJ window.  Click on the line symbol and draw a straight line from one 
stage micrometer hash mark to another.  It will be most accurate if you draw the line from 
hash marks as far apart as possible.   

4. From the “Analyze” pull down menu select “Set scale…”.  The window that pops up will 
show you the distance in pixels of your line.  You need to type in the actual distance 
between the two hash marks that you used.  There are 10 major divisions on the 1 mm 
ruler, i.e. the major divisions are 100 µm wide.  There are 10 fine divisions for one major 
division on one end of the micrometer, so these fine divisions are 10 µm wide.  If you 
can’t figure this out, ask for help.  Be sure to use the correct units of measurement in the 
“Set Scale” box.  (1 cm = 104 µm.)  Leave the aspect ratio set at 1.  Your camera has 
square pixels, so the aspect ratio (height:width) is 1. 
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5. Determine the dimensions of a camera pixel for each objective lens.  Save this 
information as you will need it in the future to put scale bars on your images.   

6. Put a scale bar on one of the two cell images from Task 3 on page 40.  Use “Analyze > 
Tools > Scale Bar”.  Save this in a separate file, appropriately named, using the “Save as” 
button.  Make another Word or Open Office file with this image and an appropriate 
caption.  When a scale bar appears in an image you should always give the dimensions of 
the scale bar in the legend, and never on the image itself.     

7. This step may be done later, when you have finished taking images. Compute the 
Rayleigh criterion value for each of the objective lenses.  You should read off the NA for 
each lens from the lens tube.  The NA of the transmitted light illuminator is 0.52.  You 
may assume that the wavelength is 545 nm.  Make a table with lens, magnification, NA, 
Rayleigh value for 545 nm and the dimension of a camera pixel.  You will include this 
table in the lab report on microscope resolution. 

Task 7. Camera resolution, part 2 
In the above task, you compared the resolution of the camera with the resolution of the 
microscope. Often, camera pixel size is not limiting and imaging occurs well above the 
Nyquist criterion. This usually causes no difficulty but sometimes there is a cost to collect 
those extra pixels, usually because of signal strength. This cost can be reduced by making 
larger pixels, that is “super-pixels”. This process is called binning (i.e. placing multiple 
pixels’ worth of signal into a bin).  See Figure 12 for a schematic illustration of camera 
binning.  In this Task you will take images at different camera binning sizes. 

 
Figure 12. When every individually addressable pixel in the camera is collected, the binning is 
said to be 1 ×  1.  In this example there are 16 rows of 16 pixels, for a total of 256 pixels in the 
collected image.  Suppose the amplitude of the signal (the brightness) in each pixel is A.  When 
the signal from four adjacent (two up and two across) camera pixels is combined, the binning is 
said to be 2 ×  2.  There are now 64 combined (or “binned”) pixels and the total amplitude in 
each superpixel is 4A.  4 ×  4 binning adds up the signal of 16 camera pixels to make 16 
superpixels each containing 16A signal units. 

 

1. Put the cover slip of cells back on the microscope.  Use the 100× Plan Fluor Dll lens.  
Adjust the microscope illuminator and phase annulus as needed and find a nice field of 
view. 
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2. Observe a phase image of a nice cell field with the camera.  Also observe a fluorescence 
image of the fluorescein-labeled microtubules with the camera (the fluorescence 
illuminator is set for blue excitation).   

3. Now change the camera resolution by using the “Binning” setting under Camera settings 
in the Micro-Manager image collection window.  Try all of the different camera binning 
settings.  Notice the size of the image changes with this value (the total number of pixels 
drops as the binning collects more pixels together, and the software displays the image 
based on number of pixels in the x- and y-directions).  You can make the display larger 
by using the Zoom controls in the Micro-Manager image collection window.  Notice also, 
as you change the binning of the image, the brightness of the image changes.  You can 
determine this as you look at a live image by looking at the histogram display at the 
bottom of the image collection window.   

4. Take two sets of images for both phase contrast and fluorescein tubulin fluorescence.  
Both sets should contain 8 images using the four different camera binning settings.  One 
set should use a fixed illumination brightness and camera exposure time (the exposure 
times for phase and fluorescence may be different, but should be used consistently for 
each type of image).  For this set, you should start with the brightest image (the one with 
8 × 8 binning) to set the illuminator and exposure time so that the brightest pixels in the 
image are a bit less than the maximum value that the camera can produce (212-1 = 4095).  
For the second set, optimize the image brightness for each different binning.  That is, get 
the brightest areas in each image to be slightly less than 4096.   

5. This may be done later.  You will put these images into your report on resolution.  All 
images should be laid out at the same display size and should include a dimensional scale 
bar.  You will find that using the Analyze>Tools>Scale bar tool produces a low 
resolution sale bar if you apply it directly to the low resolution images.  To make the tool 
bar look better, duplicate the binned images so that the duplicate images contain the same 
number of pixels as a 1 × 1 binned image does.  (For your camera, that is 1392 × 1040).  
A 2 × 2 binned image has 696 × 520 pixels.  To expand it up to 1392 × 1040, open the 
image and chose the Image>Scale tool.  Be sure to click off the “Interpolate” box (so that 
the duplicated pixels will have the same values as the original pixels).  With the “Create 
New Window” box ticked, a duplicate image window will be computed.  You need to put 
the correct values in the Width and Height boxes (the full camera resolution values).  
Now to put a scale bar on this image, you need to put in the correct calibration values that 
you collected in Task 6.  The new image has as many pixels as the 1 × 1 binned image 
you used to do the calibration, so the calibration value to use is exactly what you found in 
Task 6.  Put the same size scale bar on all eight of the images that you took in the second 
half of part 4 (the ones with good exposure settings).   
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6. This may be done later.  You will put these images and the collected data into your lab 
report on resolution.  Collect the average and total fluorescence signal for the same area 
in each of the four fluorescence images that had the same exposure and illumination.  
Pick a fluorescent structure that you can identify in each of the images.  You should use 
the same procedure for getting fluorescence intensity as you did in Lab 2.1, Task 4 on 
page 40 (i.e., subtract background image intensity from the total signal from the 
fluorescent area).  Once you have measured the area of interest, you should save the area 
that you have measured.  There are several ways to do this, but one is to make a “mask”.  
Under the Edit>Selection pull-down select “Create Mask”.  You will see that a new 
image is made, showing exactly what pixels are included in the image regions that you 
have selected.  

7. Do the same measurements as in part 6, but now for the average and total transmitted 
light signal in the four phase images.  Pick the same region in all the phase images (this 
may be different than the region you selected for the fluorescence images 

Task 8. Resolution in the z-dimension 
You explored resolution in Task 6, on page 46.  The resolution in that task was in the plane 
of the specimen, conventionally called the x-y plane.  The specimen has three spatial 
dimensions, of course, and resolution in the third direction is also important.  Conventionally 
this is called the z-direction.  The z-direction is along the optical axis of the microscope, i.e. 
perpendicular to the plane of the specimen and along the direction of the lens train. 

We often think of a part of an image as being in or out of focus, where the in-focus image is 
sharp and the out-of-focus image is fuzzy.  This sharp/fuzzy effect is due to the spread of 
light away from its source, which is the result of Airy disk spreading of light in the x-y plane 
through the imaging system.  In actuality, the Airy spread occurs along the z-axis as well.  In 
this Task you will measure this z-dimensional image spread. 
1. This task can be done with either microtubules or actin. 

2. You will be taking a series of images at different focal planes in the specimen.  This is 
called a through-focal series.  You need to keep the exposure of each of the images in the 
through-focal series the same as all the rest for subsequent image analysis.  You don’t 
want to overexpose very bright elements of any image, so find the brightest area in your 
image stack and set the fluorescence illumination and shutter exposure time to keep the 
brightest pixels below the maximum camera signal value (4095).   Probably keeping the 
camera signal below 3500 is a safe bet in case you missed some other very bright feature 
in one of your slices. 

3. The through-focal imaging can be done in a semi-quantitative way by using the fine focus 
knob markings.  One full rotation of the fine focus control on your microscope 
corresponds to 100 µm of movement in the z-direction.  Thus, each mark on the fine 
focus knob equals 1 µm.  Locate the bottom of the cells by focusing on it.  While one 
partner observes the cells, the other partner should change the focus using the fine focus 
control.  Count the number of fine focus marks that are needed to scan all the way to the 
top of the cells.  This is the thickness of the cells in µm.  (Not all cells will be the same 
thickness.  You should scan to the top of the thickest one in your field of view.)   
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4. Now take a through-focal series of images at 1 µm z-steps from the bottom to the top of 
the cells.  You can do this by taking an image at each increment of the fine focus knob.  
Start the first image at the bottom of the cells and then move the fine focus in 1 µm 
intervals between images.  Be sure to use the shutter under computer control for pulsed 
fluorescence illumination to minimize photobleaching when you take these images.  You 
should save each image using a consistent system so you know what is at the bottom and 
what is at the top.  Using a sequential numbering system (like image01, image02, etc.) is 
useful. 

5. This may be done later.  Make a single projection image of your through-focal stack.  
Read in the through-focal images into a single image stack (File>Import>Image 
sequence…).  Set the pixel-to-distance conversion in the images with the Analyze>Set 
scale… menu item.  Use the values you measured in Task 6, on page 46 for the objective 
you have used for the through-focal series.  For example, if you measured that 60 µm on 
the micrometer corresponded to 1275 pixels, then the number you would put into the 
Distance in Pixels: box is 1275.0 and the Known Distance: value is 60.0.  The Units of 
Length: box should be changed to um (for micrometers).  Now compress the image stack 
into a single projection image (Image>Stacks>Z project…) using one of the “Projection 
types”.  “Average Intensity” stores average intensity of all images in the stack at each 
pixel location.  “Maximum Intensity” projection creates an output image each of whose 
pixels contains the maximum value over all images in the stack at the particular pixel 
location.  “Minimum Intensity” projection creates an output image each of whose pixels 
contains the minimum value over all images in the stack at the particular pixel location.  
“Sum Slices” creates an image that is the sum of the slices in the stack.  “Standard 
Deviation” creates an image containing the standard deviation of the slices.  “Median” 
stores the median intensity of all images in the stack at each pixel location.  Your best bet 
is probably the Maximum Intensity projection, though you should try other projections to 
see what they produce.   

6. You may do this later.  Make a 3-D projection of your data stack.  Do this with the 
Image>Stacks>Reslice [/]… menu item.  The input spacing is 1 µm.  Set the output 
spacing to be 0.5-1.0 µm (otherwise the 3-D projection will use too much memory).  
Remember that your first slice was at the bottom of the cells, and set the start point 
accordingly.  You should end up with a z-x image stack that lets you look at the interior 
of the cells and their surfaces in cross section.   

7. The z-x image will show the spread of the points of fluorescence.  You should see X-
shaped flares of fluorescence.  The central point occurs at the plane of best focus.  This 
X-shaped flare is often called the microscope’s “point spread function”.  The point spread 
function depends on the objective used, wavelength of light and numerical aperture just 
like the Airy disk does. 
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Further studies 
You now should have a full calibration of your camera with all of the different objective 
lenses.  The objective lens is used both as a condenser and a collector for fluorescence, so its 
numerical aperture controls the resolution of the microscope’s image.  But what wavelength 
should be used to compute resolution?  There are, after all, two important sets of 
wavelengths, those for excitation and those for emission.  Think about this and see what you 
think. 

Clean-up 
Save good slides for future use.  Discard (in the glass trash) any slides that had bad 
specimens, got cracked, or are totally photobleached. 
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UNIT 3:  CELLS IN THE MICROSCOPE 
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Lab 3.1:  Fluorescence microscopy 
Goal for this lab:  
Examining the properties of fluorescent specimens and their imaging in the microscope.   

Pre-lab homework:  
Visit Nikon’s MicroscopyU (http://www.microscopyu.com/sitemap.html) and read the 
sections on fluorescence and specific Nikon fluorescence filter sets.  

Introduction:  
You have used fluorescently labeled specimens in previous lab modules.  In this module you 
will explore more about the phenomenon of fluorescence and the techniques used to make 
fluorescence images in the microscope. 

Fluorescence is a quantum mechanical phenomenon in which a molecule absorbs a photon of 
light, stores the energy briefly, and then releases the energy in the form of another photon.  
Not every molecule can do this efficiently, and thus there are a limited set of fluorescent 
molecules – fluorophores – that are available for microscopists.  Fluorescent molecules can 
be attached covalently to molecules of interest, to antibodies that recognize molecules of 
interest or noncovalently to molecules of interest.  Fluorescent molecules can also be 
designed to interact with specific structures in the cell or to report on conditions within the 
cell.  We will look at some of these molecules in more detail in later lab modules. 

For a molecule to be fluorescent, it must be able to capture a photon, to store energy and then 
to emit a photon.  Such interaction with electromagnetic waves is best accomplished by 
molecules that have delocalized electrons, thus most fluorophores contain ring structures 
with pi electrons.  A photon arriving at the fluorophore can cause electron rearrangement 
leaving the fluorophore’s electrons in a higher energy (excited) state as the photon’s energy 
is absorbed by the fluorophore.  Quite often, the fluorophore has its molecular vibrations and 
bond rotation energized by this absorption event.  These vibrations and rotations rapidly 
dissipate as heat into the surrounding medium, thus lowering the total energy of the 
fluorophore.  After a while (typical times are 0.5 to 20 nsec; i.e. 0.5-20 × 10-9 sec) the 
fluorophore’s electrons will rearrange to their original low energy (ground) state.  The 
fluorophore often has vibrations and rotations energized during this process, and these 
quickly dissipate.  The excess energy between the excited and ground electronic states is 
released in the form of a photon, the fluorescence emission photon.  See Figure 13 for an 
energy level diagram of a fluorescence absorption and emission cycle. 
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Figure 13. Absorption and emission of photons by a fluorophore.  The absorption event, from 
the ground electronic energy state (Egr) to the excited electronic energy state (Eex), involves 
interaction of a photon with more energy than the energy gap between Egr and Eex.  The excess 
energy appears as molecular vibrations and rotations in the fluorophore.  These quickly 
dissipate into the surrounding medium.  Later, the fluorophore transitions from its excited 
electronic energy state to a vibrational and rotational state above the electronic ground state, 
leading to an emitted photon of energy less than the energy gap between Egr and Eex. 

Thus, the energy of the absorbed photon is greater than that of the emitted photon for the full 
fluorescence cycle.  The excess energy is dissipated to the surrounding medium from the 
molecular vibrations and rotations excited during the absorption and emission events.  The 
apparent net effect is that a photon of high energy (or short wavelength) has had its energy 
shifted to a lower energy (or longer wavelength).  This is known as the Stokes shift, named 
for George Stokes who first described fluorescence. 
Individual fluorescence absorption and emission events can occur many times over for a 
single fluorophore.  When many fluorophores are present, a very large number of photons are 
absorbed and emitted.  Each of these events can lead to a slightly different amount of 
(photon) energy absorbed or emitted by the fluorophore.  Macroscopically, this appears as a 
continuous spectrum of photon energy absorbed and emitted (see Figure 14).  The absorption 
spectrum is of higher energy (or shorter wavelength) than the emission spectrum, though 
there can be a small overlap in the two spectra.  Therefore, fluorescence excitation is of 
shorter wavelength than fluorescence emission. 
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Figure 14.  When large numbers of individual photon-fluorophore pairs interact, the specific 
vibrational and rotational excitations upon absorption or emission can differ for each 
fluorescence event.  This leads to a variety of possible energies for photon absorption and 
emission.  There are so many absorption and emission events that the individual events blend 
together into apparently continuous absorption and emission wavelength (or energy) spectra.  
The small overlap in the spectra happens because some particular absorptions are of rather 
low energy photons (leading to even lower energy emitted photons) and some particular 
emissions are of rather high energy photons. 

The microscope is set up to exploit these wavelength shifts by the use of a set of wavelength 
filters and special wavelength-selective mirrors.  Although there are a number of ways in 
which one could arrange to excite the specimen with short wavelength light and to collect 
long wavelength fluorescence emission, all modern research microscopes use a so-called 
epifluorescence system.  In this system, light from a bright bulb (usually an arc discharge 
lamp) is passed through a wavelength selection filter (the excitation filter) to remove all but 
the desired excitation wavelengths that overlap the excitation spectrum of the fluorophore 
being used (see Figure 15).  This light is reflected off of a dichroic mirror that reflects the 
short wavelength excitation light.  The excitation light is then directed along the optic axis 
through the objective lens where it falls on the specimen.  Fluorophores in the specimen 
absorb some of the excitation light, and reemit the energy as longer wavelength fluorescence 
emission light.  This light is collected by the objective lens and passes through the dichroic 
mirror (the dichroic part coming from the ability of the mirror to reflect some wavelengths 
but pass other wavelengths).  The emission light then passes through a barrier filter that 
blocks any scattered excitation light but transmits the longer wavelength fluorescence light.  
This light then continues in the usual way to form an image on the imaging device. 
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Figure 15.  Multispectral light from the light source is filtered to select short wavelength 
excitation light.  This light is (mostly) reflected to the specimen by the dichroic mirror where it 
excites fluorophores.  The longer wavelength fluorescence light, shown here by dotted lines, 
(mostly) passes through the dichroic mirror to the imaging device.  A small portion of the 
excitation light is scattered by the specimen and passes through the dichroic mirror (which is 
not perfect).  This “leaky” excitation light is absorbed by the barrier filter that passes the 
longer wavelength emission light. 

Different fluorophores have different fluorescence properties.  You have seen that DAPI 
absorbs UV light and emits blue light.  If you tried other fluorescence settings with your 
earlier specimens, you found that fluorescein absorbs blue light and emits green light and that 
rhodamine absorbs green light and emits red light.  Molecular Probes, Inc. (now a part of 
Invitrogen) has a nice fluorophore spectrum tool that you can access at 
http://probes.invitrogen.com/servlets/spectraviewer?fileid1=1306dna.  The page will start up 
with the excitation and emission spectra of DAPI.  You can also plot the fluorescein 
spectrum and the rhodamine spectrum by selecting “fluorescein (antibody conjugate)” and 
“rhodamine phalloidin” for two of the other compounds.   

 

Fluorescent specimen 

Arc lamp light includes 
many wavelengths 

Excitation filter permits 
excitation wavelengths to pass 

Barrier filter stops most 
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excitation light 

Dichroic mirror reflects 
short wavelengths and 
passes long ones 
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Fluorescence emission light 

Fluorescence emission light 

Some reflected excitation 
light passes through mirror 

Reflected excitation light  
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Another difference in fluorophores is their efficiency in absorbing photons and also in 
converting the absorbed photon energy to an emitted photon.  The first property is quantified 
by a value called the extinction coefficient while the latter is quantified by a value called the 
quantum efficiency.  The extinction coefficient refers to the ability of a collection of 
fluorophore molecules to extinguish (absorb) photons.  Quantum efficiency refers to the 
single-photon (quantum) conversion between excitation energy and emission energy (the 
efficiency).  The higher these values are, the better (brighter) is the fluorophore. 
As discussed above, the fluorophore has a latency time of the order of nanoseconds between 
fluorescence excitation and photon emission.  This time is called the fluorescence lifetime τ 
and is related to the various sorts of processes by which the energy of the electronic excited 
state can dissipate.  Besides photon emission, the energy can pass to other molecules via heat, 
it can participate in forming chemical bonds, it can transfer directly to other molecules, and 
in other ways.  Because these pathways control the rate of conversion of the excited state of 
the fluorophore to another state, they all contribute to the fluorescence lifetime.  Because 
these are all simple single-step reactions, the overall decay of the excited state is governed by 
first-order chemical kinetics, so that the time course of decay of the excited state is 
proportional to an exponential of time divided by the fluorescence lifetime.  Looked at 
another way, this is also the time course of fluorescence emission once the excitation light is 
turned off: 

 

In this equation, the initial fluorescence signal is S0 and the fluorescence signal at any later 
time is S(t).  Although we won’t exploit this very fast decay of fluorescence, there are 
powerful microscopy techniques that use this decay to measure changes in fluorophore 
environment within a cell. 
Another fluorescence decay process that is very relevant to standard microcopy such as what 
we are doing is called photobleaching.  This process involves a covalent bond formation 
between the fluorophore in the excited state and another molecule, often oxygen.  When such 
a bond forms, the fluorophore is modified and cannot decay to the original ground state.  
Thus, the fluorophore no longer emits or absorbs light, and it goes dark.  This chemical-
reaction-mediated loss of active fluorophores is called photobleaching.  The “photo” part 
refers to the requirement that an excited state must be formed for the reaction to occur (this 
from absorption of a photon) and that the color of the fluorescence is lost (the molecule is 
bleached).  Because the photobleaching process requires the fluorophore to be in the excited 
state, the rate of photobleaching is proportional to the brightness of the excitation light.  The 
reaction is a simple first-order process, so the time course of the decay of the number of 
active fluorophores is a simple exponential function of the product of time t and 
photobleaching rate constant kp: 

. 

Where N(t) and N0 are the numbers of active fluorophores at time t and initially, respectively.  
Do not confuse this time course with that for the lifetime of the fluorophore.  Photobleaching 
occurs over a time scale of milliseconds to minutes depending on the brightness of the 
excitation light while the lifetime of the fluorophore as it cycles between the excited and 
ground state is of the order of nanoseconds. 
Before you come to class, visit the Molecular Probes web site to get the values for the peaks 
of the excitation and emission spectra for DAPI, fluorescein-labeled antibody and rhodamine 
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phalloidin.  Also visit MicroscopyU where you can find the values for the spectral properties 
of the excitation filter, the dichroic mirror and the barrier filter for the fluorescence filter 
cubes in your microscope.  The filter sets are UV-2E, B-2E and Y-2E/C.  You can find the 
spectral data at the MicroscopyU site about Nikon filters at : 

http://www.microscopyu.com/articles/fluorescence/filtercubes/filterindex.html. 

Materials 
Glass slide with a cover slip of fixed LLC-Pk1 pig kidney epithelial cells that have been 
stained with DAPI, a fluorescent marker for DNA, fluorescein-anti-tubulin and rhodamine-
phalloidin, that labels F-actin. 

Methods 
Task 1. Fluorescence epi-illumination optics 
Although you have used the fluorescence epi-illuminator already, not much has been done to 
consider its alignment and control.  In this Task you will do some adjustments similar to 
those for transmitted light Köhler illumination. 

1. Turn on and set up the microscope with some cells.  A 10× lens will work well for this 
task.  Adjust the transmitted light Köhler illumination and phase contrast (if needed).   

2. Locate a group of cells using one of the three different fluorophores (DAPI, fluorescein 
or rhodamine) staining the cells.   

3. At the left rear of the microscope you will see two sliders each with a pair of adjustment 
knobs.  The front slider controls the epi-illumination field of illumination.  It is in the 
specimen focal plane.  The rear slider is conjugate to the back focal plane of the objective 
lens.  Move the two sliders and observe their effects. 

4. Center the epi-illumination field diaphragm (the front one) by using the two knobs on a 
partially stopped down aperture.   

5. Center the epi-illumination aperture diaphragm (the back one).  This aperture is conjugate 
with the back focal plane of the objective, so you can visualize it (and the objective’s 
phase ring) by using the Bertrand telescope setting on the eyepiece turret.   

Task 2. Multiple fluorophore imaging 
Many cell biologists like to take images of cells that have multiple fluorescent labels in order 
to see different structures within the cells.  Your samples are like that.  The dsDNA is labeled 
with DAPI, the microtubules with antibodies that have fluorescein attached, and the F-actin 
in the cell with rhodamine phalloidin.  In this task you will collect images of the different 
chromophores from the same field of view. 

1. This Task is best performed with a 40× or 100× lens.  Find a nice group of cells, make 
sure the microscope is aligned correctly and then look at the three different fluorophores 
using the three different fluorescence filter cubes on your microscope (UV, B and G).  It 
is always a good idea to use the lowest level of fluorescence excitation you can manage 
in order to minimize fluorophore photobleaching.  You can reduce light by inserting 
neutral density filters in the excitation light path (behind the microscope on the right hand 
side are two ND sliders) or by adjusting the epi-illuminator aperture as in Task 1.  You 
should keep this in mind for future experiments – it is always a good idea to minimize 
fluorophore photobleaching and to reduce light exposure to the cells.  USE THE 
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ELECTRONIC SHUTTER.  DON’T LEAVE THE FLUORESCENCE EXCITATION 
ON CONTINUOUSLY. 

2. You will find that each of the different fluorescence images is relatively brighter or 
dimmer than the others.  This is for several reasons including the relative quantum 
efficiencies of the fluorophores, their net local concentration, the brightness of the 
illumination and the degree of overlap of the fluorophores’ spectra with the arc lamp 
spectrum and the spectral properties of the filters.  Get a feel for the differences in the 
relative brightness of the different dyes. 

3. Using the camera, determine the appropriate set of ND filters to insert and the shortest 
exposure time you can get away with to get a “decent” fluorescence image for the three 
fluorophores.  You can judge “decent” to be a reasonably noise-free image.  You be the 
judge.  You probably want to have the Micro-Manager display set to fixed rather than 
automatic adjustment of the display scale.  Take note of the settings (ND values, aperture 
settings, exposure time) for each fluorophore, to be used in the next step. 

4. Take and save images of DAPI, fluorescein and rhodamine fluorescence without moving 
the specimen.  Also be sure to take a phase contrast image of the same field of view.  
You will analyze these images later. 

Task 3. Photobleaching, part 1 
As discussed in the introduction to this module, fluorophore photobleaching occurs when the 
fluorophore is exposed to excitation light.  An irreversible covalent chemical reaction of the 
excited state fluorophore renders it unable to fluoresce.  The bleaching is permanent.  Thus, 
your specimens become dimmer as you observe them.  In this module, you will measure the 
rate constant for photobleaching for the three different fluorophores in your specimens. 
1. You will do this experiment as a time-lapse image collection.  That means that you will 

take a series of images at specific times that you will later analyze. 
2. This Task is best done with a 100×, high NA lens.  You can also do it with a 40× lens, 

but the time it takes to photobleach will be a bit longer.  Select the fluorescein tubulin 
excitation (blue).  Remove any neutral density filters from the illumination pathway and 
fully open the epi-illumination aperture.  You want the epi-illumination to be full power.  
Find an area with a nice image.  Adjust the exposure time so that the brightest regions in 
the image are in the range 3000-4000 brightness units.  Check focus with the camera one 
final time and shut off the fluorescence excitation with the microscope field block 
under the objective turret.  You don’t want to bleach the sample yet. 

3. Prepare to take a time-lapse image set.  In the Micro-Manager image collection window, 
select “Acquisition”.  You can select how many images to take and how often to take 
them.  The number of images is at the top and the time between images (Interval) is 
below.  Try 31 images at 10 sec between images.  That will mean that you will have a 
total of 30 intervals at 10 sec each, or a total time of 300 sec = 5 min.  The fluorescein 
will be considerably bleached in this amount of time.  Be sure that “Position XY” is not 
ticked.  DO NOT CLICK AQUIRE YET! 

4. During the full 5 minutes of data acquisition you will leave the cells exposed to the 
excitation light.  Therefore, you don’t want the epi-illumination shutter to block the light 
between images.  Set your shutter to manual open.  This will override the computer 
control of the shutter. 
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5. When you are ready, open the epi-illumination field block that you shut in step 2 and 
click the “Acquire!” button.  Your computer will take the images automatically.   

6. When the images are all collected, save the set of images using the save icon at the 
bottom left of the display window.  This will save a folder of the name you give that 
contains images with names img_0_0.tif, img_1_0.tif, etc. 

7. Repeat this procedure for the other two fluorophores, being sure to adjust camera 
exposure time each time.  You can probably use the same field of view for all 
fluorophores, but you don’t have to do that. 

8. You will analyze this data later. 

Task 4. Photobleaching, part 2 
You now have data that can be analyzed to determine the photobleaching rate for DAPI, 
fluorescein and rhodamine in your microscope for the objective lens that you chose in Task 
3.  In this Task, you will confirm that the photobleaching rate is a function of excitation 
intensity. 
1. Find an unbleached area of cells.  Use any one of the fluorophores you prefer. 

2. Follow the procedure of Task 3 on page 59, but this time insert both of the epi-
illumination neutral density filters into the excitation light path.  This will cut the light 
intensity by a factor of 4 × 8 = 32.  Thus, the photobleaching rate will drop by a factor of 
32.  You will want to increase the camera exposure time from Task 3 by approximately 
this factor to get the fluorescence signal maximum to be in the range of 3000-4000. 

3. Once you have everything adjusted, take the time lapse series and save the data. 
4. You need do this only for one of the fluorophores.   

Task 5. Photobleaching, part 3 
The total time that a fluorophore is exposed to excitation light determines the extent of 
photobleaching.  When taking time lapse images of live cells, a way to limit the total 
fluorescence exposure is to shine excitation light on the cells only when taking a picture.  
This can be done by letting the computer control the shutter during a time lapse image 
collection. 

1. Find an unbleached area of cells.  Use any of the fluorophores you prefer.  Remove the 
neutral density filters so that you are using full epi-illumination power. 

2. As in Task 3, set up the software to take 31 images at 10 sec intervals.  Now, however, 
set the shutter for automatic computer control.  This will expose the cells to fluorescence 
excitation only when images are being collected. 

3. Watch to be sure that the fluorescence excitation comes on only during image collection.  
If all looks right, store this image series.  You will analyze it later. 

4. You are finished with image collection.  You can shut down your microscope any time 
and proceed with analysis now or later on.  Be sure to have copies of the image files 
accessible if you want to work on them out of class. 
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Analysis 
Task 6. Make a composite image 
If you haven’t already done it, visit the Molecular Probes and Nikon sites to look at the 
spectra for the three fluorophores and the properties of the Nikon filter sets. 

1. Make a so-called “merge” file from your three fluorescence images.  To do this, open all 
3 images in ImageJ, then select “Image>Color>RGB merge…”.  If you put the DAPI 
image in the blue channel, the fluorescein image in the green channel and the rhodamine 
image in the red channel, your composite merged image will have pseudocolor 
representations of the three fluorophores that are close to the real colors.  If you took the 
three images without moving the specimen, this image should show you the relative 
distributions of dsDNA, tubulin and F-actin in the cells.  To save the image with a 
reasonable file name, use File>Save As.  Save pictures for data analysis as TIFF; use 
JPEG for your lab report. 

2. Consider the possibility that blue excitation can cause rhodamine to fluoresce.  To what 
extent will this cause what is called “bleed-through” of rhodamine labeled areas into the 
“fluorescein” image?  Can you think of a way to determine if this is something that could 
cause difficulty in fluorescence quantitation when data on multiply stained cells is 
collected? 

Task 7. Analyze your image 
You have several time-lapse data sets.  You want to extract fluorescence intensity values 
from regions of interest for further analysis.  You can do that by hand for each image, but 
that would be very tedious and runs the risk of inconsistent collection from exactly the same 
regions in each image of the series.  ImageJ has a plugin called Multi Measure that will make 
this task easier. 

1. If it is not already on your computer, you need to download an ImageJ plugin that has the 
ability to collect data from a series of images for a number of different regions of interest.  
The plugin is called “Multi Measure” and can be gotten at 
http://www.optinav.com/imagej.html.  Download the Multi_Measure.jar application and 
put it into the plugins folder under Micro-Manager or ImageJ.  Restart Micro-Manager or 
ImageJ.  Now you should find Multi Measure under the ImageJ “Plugins” menu item.  
Multi Measure is preloaded on the Bioimaging workstation computers. 
To use Multi Measure, follow the instructions that are outlined at the McMaster 
University site on ImageJ add-ons: 
http://www.macbiophotonics.ca/imagej/intensity_vs_time_ana.htm#IntvTime_1ROI.   

These instructions are given below with modifications. 
a. Open your time lapse series using ImageJ’s “File>Import>Image Sequence...”.  Select 

the first image in the series and click “Open”.  You want to import all of the images, 
so the starting image is 1 and the increment is 1.  With the Sort Names Numerically 
turned on, the image sequence will sort from the first to the last image as you want. 

b. Open “Multi Measure” plugin (“Plugins>Multi Measure”). 

c. Select your image sequence window (“Window>your file name “).  
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d. Select regions of interest (ROIs) using the ImageJ toolbar and click “Add” to in Multi 
Manager. Clicking on the ROI label will display each region.  You can use this 
feature to keep from selecting the same regions in the image. 

e. Once finished selecting ROIs to be analyzed in the reference image, you can save the 
ROI data by clicking the “Save” button.  Only those ROIs highlighted will be saved 
in a Zip file.  You can import these ROIs later to analyze your data again or to recall 
what ROI area corresponds to what set of data. 

f. Clicking on “Multi” will put all values from all slices and each ROI into the Results 
window.  Note that only the ROIs that are selected will be analyzed. 

g. Go to “Results” window. Select menu item “Edit>Select All…”. Then “Edit>Copy”. 

h. Go to Excel and paste the data. With large data sets this can take some time.  You 
may need to use Paste Special as text.  You should have columns of data including 
the average intensity of each of your ROIs. 

i. To copy ROI co-ordinates in to the Excel spreadsheet, ensure there is an empty row 
above the intensity data.  Go to Multi Measure dialog and click “Copy list” button. 

j. Go to Excel, select the empty cell above the first data column (not the first column 
with image numbers) and then paste the ROI co-ordinates. 

k. The ROIs can be stored and re-opened later using the Multi Measure dialog button 
“Save”.  Save them in the experimental data folder.  The ROIs can be opened later 
either individually (Multi Measure dialog button “Open”) or all at once (Multi 
Measure dialog button “Open All”) which opens all the ROIs in a folder. 

2. Pick some ROIs for each of your time lapse data sets.  For DAPI you might want to select 
two or three nuclei and a corresponding background area like you did in Task 4 of 
Lab 2.1, on page 40.  Following the Multi Measure plugin procedure outlined above, 
collect the data.  Before you do that, you might want to change the data that will be 
collected.  You can do that by selecting Analyze>Set Measurements… and ticking the 
items that are relevant to your data.  Here the only thing that is important is the mean 
gray level.  Once you have the data imported into Excel (or your favorite spreadsheet 
program), go to step 3. 

3. You want to determine the rate constant for fluorescence decay for the various different 
fluorophores and conditions.  To do this, you must first subtract the background 
autofluorescence data from the other ROI data in order to obtain only the fluorescence 
coming from the fluorophore.  Let’s use DAPI as an example.  Suppose you have 
collected data from three nuclei in ROIs 1, 2, and 3 and you collected background data in 
ROI4.  You first want to subtract the ROI4 values from ROI1, ROI2 and ROI3.   
With your data in Excel, you have columns of 31 numbers.  Each column has data for 
each ROI.  They should be labeled Mean1, Mean2, etc. with the ROI name above them.  
Go to the third column past the last data column.  In the cell that corresponds to the first 
row of grey level data type “=B3-$E3” if the ROI1 data is in column B and the ROI4 data 
is column E.  These cell addresses (B3 and E3) may be different if you have pasted the 
data differently than this example or if you have a different number of ROIs.  When you 
type <enter> the program will calculate the value.  You need to copy this formula to all 
the cells for all the ROI values.  This is very easy to do.  Just grab onto the dot at the 
lower right corner of the cell you just filled in and drag it to the end of the column.  When 
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you release the dot, all cells in the column will update.  Now with the column highlighted 
by a long box click on the lower right dot and drag it to fill the columns to the right.  In 
this example, you’ll end up with three columns that contain background-subtracted 
fluorescence values for each fluorescence area ROI.  Label the cells at the top of the 
column so that you know what they are (like FL1 or something like that).  (Note:  If you 
are not an Excel expert, you should know that the copy/drag procedure advances cell 
addresses.  For example, dragging down advances the row numbers {from 3 to 4 to 5 and 
so on to the end} and dragging across advances the column letters {from E to F to G}.  
Thus, the array of numbers you generated maintains the same relative location with 
respect to each other as the original values did.  The $ in the $E3 cell address above is 
important.  When a $ precedes either a column letter or a row number, that means that the 
copy/drag cell filling that we did will not advance the address value.  Thus, in the above 
example the first cell is B3-E3.  The next cell down is B4-E4 (the row numbers will 
advance).  When columns are copied, the first row will be B3-E3, C3-E3 and D3-E3 (the 
columns in the first cell address advance while the last column {E} does not advance). 

4. You now have the fluorescence data for each ROI.  The values should decline as they go 
down because that direction is increasing time.  You will plot the data, but before you do 
that you need to have a column of data that contains the time points.  Your data was 
collected at 10 sec intervals.  Use the free column to the left of the first subtracted column 
that you just produced.  Let’s call that column F.  Type “time” or some suitable header in 
the row with labels.  You can now type 0, 10, 20, etc. in each of the cells in that column.  
There’s an easier way to fill the cells, though.  In the first cell for the first image, type 0 
(in cell F3).  Then type “= F3 + 10” in cell F4 and hit “return” You should have a 10 in 
that cell.  Now drag this cell like you did the others to fill the time column.  You should 
have 0, 10, 20, etc. in column F.    

5. To plot these data, select the columns that contain the time and any fluorescence values 
you want to plot.  It’s important the time column be the one that is farthest to the left or 
else the next step won’t look right.  With the data you want to plot selected, click the 
graph icon on the Excel toolbar.  Select the “XY (Scatter)” chart type and pick the one 
with dots (data points) and a smooth line (a smoothed line fit).  You can fiddle with the 
rest of the settings to get the plot to look the way you want as you go through the chart 
wizard.  When you come to the end, if you select to save as a new sheet, you will have a 
cleaner final product.  You should label the chart sheet.  Your plots should show an 
exponential decline over time. 

6. The time course of fluorescence intensity should follow the formula  

 

where F(t) is the fluorescence at any time t and F0 is the fluorescence at t = 0.  The 
fluorescence brightness is proportional to the illumination brightness and to the number 
of fluorophores contained in each pixel of the image.  You want to extract the value of kp 
from your data.  Excel can do a nonlinear least squares fit to this equation and get that 
value.  Select to the chart you want to analyze.  On the “Chart” menu item select “Add 
Trendline…” and click the Exponential type.  Click the “Options” tab and tick the 
“Display equation on chart” box.  You should get a smooth exponential fit and an 
equation that looks something like y = 3476e-0.0301x.  Here y corresponds to F and x 
corresponds to t.  You can edit the equation to make that change if you wish.  The 
number in front of the e equals F0, the best-fit initial fluorescence value, and the number 

! 

F(t) = F0e
"kp t
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in front of the x equals kp.  In this example, F0 = 3476 fluorescence units and kp = 0.0301 
sec-1.  The units of fluorescence are whatever you’d like to call them.  The units of the 
rate constant are the inverse of the units of time in the first data column that is plotted in 
the graph.  You entered seconds, so the units are 1/sec.  Be sure to save your Excel data 
in a location and with a file name that you can easily find. 

7. Collect the values of kp and F0 for each ROI you selected for all of the time lapse data 
series.  You will report and analyze these in the lab report on this module.  You might 
want to put each separate experiment on a different Excel data sheet in the same data file 
to keep everything in one place.  To do this, open a new sheet by clicking a sheet tab at 
the bottom of the spreadsheet.  You can change the sheet names by double clicking to 
highlight the name and typing in what you like.  You can make more sheets by using the 
Insert>Worksheet pull-down in Excel. 

Note:  In your lab report, plot the data for each fluorophore on the same set of axes so you 
can compare  the curves. 

Further studies 
You can experiment more with the effects of excitation light intensity on other fluorophores.  
You might want to determine if using the fluorescein blue light excitation shows any effect 
on the bleaching of DAPI or rhodamine.   

Clean-up 
Save good slides for future use.  Discard (in the glass trash) any slides that had bad 
specimens, got cracked, or are totally photobleached. 
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Lab 3.2:  Identification of Cellular Organelles 
Goal: 
To learn to identify cellular structures using light microscopy.   

Obtain and image slides that have been fixed and stained for you.   
The slides have been stained so that particular cellular structures will appear fluorescent.  
The cells are also stained with DAPI.  Each slide is labeled with a number and the letters B or 
G.  Slides with a B are labeled with fluorophores that are excited by blue light and fluoresce 
green; slides with a G are labeled with fluorophores that are excited by green light and 
fluoresce red. 

 Place the slide on the microscope.  In your notebook, write down the number/letter on 
the slide. 

 View the cells using the DAPI fluorescence filter set (UV).  Use the focus knob to get 
crisp images of the nuclei at 40×. 

 Snap some images. 
 Switch the filter set to either B or G setting – depending on what is written on the 

slide.   

• What do you observe? Take images of the cellular structures.  Based on what you see, 
identify the labeled structure(s) in each slide.  Be sure to take PAIRS of images of 
nuclei and then the same field of view in the B or G fluorescence channel.  
Remember to indicate for each image the number on the slide that you are using.  
You can go back and look at the images later, and you will need to know which 
images are taken of which slide. 

• Repeat the imaging for all 5 slides.  For each, focus first on the DAPI nuclei, and then 
switch and examine the fluorescence in B or G.  Be sure to look around the slide, as 
the staining might be brighter (or dimmer) in different regions of the slide.  Save 
several images for each slide. 

• Upload your best images from each slide to the course website. 

For each structure answer the following:  
• What is the location of the fluorescent structure? (e.g., is it in the periphery of the 

cell? the middle?) 

• What is the organization of the fluorescent structure? (e.g., is the structure punctate? 
Linear? Diffuse?) 

• Is the structure the same in all cells, or is there variation between cells? 

• Is the organization of the structure the same or different when the cell is in mitosis? 

• Based on your prior knowledge of cell biology, what do you think is stained on the 
slide? 

• Describe a test that you could perform to positively identify the organelle that you 
visualized.   
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Example: you know from last lab that DAPI is a fluorescent dye that is specific for double 
stranded DNA.  Therefore, because double stranded DNA is in the nucleus, you can conclude 
that the structure that is stained by DAPI is the DNA in the nucleus.   
To test your hypothesis that DAPI stains DNA, you could do the following:  

1. Digest the DNA with DNAase (an enzyme that breaks down DNA) and then incubate 
with DAPI.  If DAPI stains DNA, then loss of DNA will result in loss of fluorescence. 

2. Use a different stain for the nucleus to confirm that DAPI is staining DNA.  
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Lab 3.3:  Labeling Cellular Structures 
Goal for the module:   
To visualize cellular components in the microscope using indirect immunofluorescence and 
direct labeling of cell components.  

Introduction:  
The technique of immunofluorescence takes advantage of the remarkable specificity of 
antibodies to localize a particular molecule, the antigen, in cells and in tissues.  In this 
method, the antigen, which can be almost any cellular component, is localized in its native 
location in a fixed specimen.  First, you need to obtain antibodies that recognize the antigen.  
Antibodies are serum glycoproteins that are generated by cells of the immune system in 
response to a foreign substance, the antigen.  Antibodies bind to antigens by their variable 
regions (Figure 16).  

 
Figure 16.  antibody structure (Figure 24-31 from Alberts, et al, 2002, Biology 
of the Cell, 4th edition, Garland Science, reproduced with permission.) 

The most common class of antibodies is called IgG (immunoglobulin G).  In many instances, 
antibodies can be obtained from a commercial source; in other cases the investigator 
produces the antibodies in the lab.  To do this, a preparation of the purified antigen is injected 
into a suitable host animal, often a rabbit.  Over time, the animal launches an immune 
response, and antibodies can be collected from the serum, and purified.  The fixed cells are 
then incubated with the antibodies, rinsed to remove unbound antibodies and the antibodies 
bound to antigen localized.   

In direct antibody staining, the primary antibodies (those that recognize the antigen) are 
labeled with a fluorescent dye.  However, antibodies are expensive, and often in short supply, 
and labeling them with a dye is an inefficient process.  To overcome these limitations, an 
approach called indirect immunofluorescence is typically used.  In this method, the primary 
antibody is unlabeled.  It is localized in a second step, by using secondary antibodies that 
recognize the primary antibodies.   

To generate secondary antibodies, a suitable host animal is immunized with antibodies from 
a different species.  In this lab, the primary antibody that you will use was made in a rat.  To 
make secondary antibodies to use with this primary antibody, the rat IgGs are injected into a 
goat.   The goat will generate antibodies to the rat IgGs, most of which will recognize the Fc 
portion (the Fragment crystallizable region at the base of the “Y”) of the primary antibody 
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(Figure 17).  These secondary antibodies, called goat anti-rat antibodies, are purified and 
labeled with a fluorescent dye.  An advantage of this method is that several secondary 
antibody molecules can bind to the primary antibody, so the signal is amplified.  Another 
advantage of using secondary antibodies is that secondary antibodies labeled with different 
dyes (i.e. different colors) are commercially available, facilitating double (and triple and 
quadruple) labeling experiments.   

 
Figure 17.  Indirect Immunofluorescence  (figure 9-16 from Alberts, et al, 2002, Biology 
of the Cell, 4th edition, Garland Science, reproduced with permission.) 

In addition to antibodies, cellular structures can be stained using fluorescent molecules that 
bind to specific cellular components.  For example, the Golgi membranes can be imaged 
using fluorescent lipids that specifically localize to these membranes.  The mitochondria can 
be labeled using a fluorescent probe that localizes only to structures with a membrane 
potential.  In addition, toxins usually bind  tightly to certain cellular molecules.  By tagging 
the toxin with a fluorescent dye, the location of a particular molecule can be determined.  In 
this lab, we will use fluorescent phalloiden, a toxin from the mushroom Amanita phalloides 
(death angel) which binds to filamentous actin.   
In this lab, you will perform immunofluorescence, and image the stained cells in the 
microscope.   

Materials: 
 Coverslips of fixed LLCPk cells for staining 

 Coverslips of live LLCPk cells for fixation 
 Fine forceps 

 Small beakers 
 Humid chamber  

 Glass slides 
 Mounting medium 

 Ice bucket 
 Staining reagents, pipettors 
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Procedure: 
Making a humid chamber  
Antibodies and cell staining reagents are very expensive, so you will use only a small volume 
of the solution in your incubation.  However, small volumes evaporate quickly.  To prevent 
evaporation, you will perform the incubation in a humid chamber that you construct from 
items commonly available in the laboratory. 

1. Obtain a plastic Petri dish.  Flip the dish so that the larger of the two halves (usually the 
lid) is on the bench top. 

2. Place a piece of filter paper in the lid.  Press it in, so that it fits, and lies flat. 
3. Wet the paper with a small amount of distilled water from the squirt bottle.  The paper 

should be uniformly wet (moist).  If there is excess water, pour it off.   
4. Place a square of Parafilm plastic on the filter paper.  The TA will demonstrate.  Remove 

the wax paper layer, keeping your dirty fingers and gloves from touching the top surface 
of the Parafilm.    

5. Now you can pipette small drops of the staining solution on to the flat surface of the 
Parafilm sheet.  Then place the coverslip with the cells on the drop, CELL SIDE DOWN.  
When the coverslip is placed (carefully) on the drop, the solution will spread out between 
the parafilm and the coverslip surface.   

6. Place the other half of the Petri dish on top, and press slightly, so that it retains moisture.   

Task 1. Indirect Immunofluorescence: Tubulin 
1. Obtain a coverslip of cells that have been fixed for you.  Take an aliquot of anti-tubulin 

primary antibody (raised in a rat). The antibodies have been diluted and are ready for use.  

2. Make a humid chamber (see above), and pipette 50 µL of primary antibody onto the 
parafilm.  Invert the coverslip onto the drop, and incubate for 60 minutes at 37°C. NOTE: 
keep track of the side of the coverslip that has the cells on it! 

3. When the incubation is nearly over, make another humid chamber, and place a 50 µL 
drop of secondary antibody (goat anti-rat FITC) on the parafilm.  The secondary 
antibodies have been diluted are ready for use.  Cover with a lid that is foil covered 
(secondary antibodies are light sensitive).  

4. When the first incubation is done, remove the coverslip from the primary antibody, rinse 
3 × in PBS-Tw-Az by dunking 10 times in each beaker.  Touch one edge of the coverslip 
to a Kimwipe to remove excess PBS, and then invert the coverslip on the drop of 
secondary antibody in the humid chamber.  Incubate at 37°C for 30 minutes. 

5. Rinse again, and mount the coverslip on a drop of Vectashield mounting medium that 
contains DAPI.  To do this, take a clean glass slide and label it with your name, date and 
the experiment; place a small drop of Vectashield (size of a small pea) on the center of 
the slide.  Now, take the coverslip, and remove the excess PBS by holding one edge of 
the coverslip to a Kimwipe.   Invert the coverslip, cell side down, onto the Vectashield.  
Using Kimwipes, press the coverslip firmly into the drop, without any side-to-side 
motion (which would shear the cells).  Wear gloves for this step.  The cells are now 
labeled for microtubules and DNA. 
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Control Experiments 
It is important to verify that the antibodies that you are using are specific for the antigen you 
wish to study.  In most cases, scientists spend considerable effort making sure that the 
staining pattern that they obtain with a particular antibody is ‘real’.  To do this, cells are fixed 
using different fixation conditions, and incubated with various agents to block non-specific 
staining with the antibodies.  Do one or more of these experiments if there are sufficient cells 
and time during the lab period. 

1. No primary antibody.  This control experiment is used to demonstrate that the staining 
results from a specific interaction of the primary antibody with the antigen. To do this, 
omit the primary antibody from the first incubation (incubate with a buffer solution) and 
then incubate with the secondary antibody.  One group can perform this control for the 
tubulin antibodies. Note: because the antibodies that you will use have been well 
characterized, you need not perform these controls (2 & 3).  

2. Preadsorption.  An additional control to demonstrate that the primary antibody is specific 
for the antigen is to preincubate the primary antibody with purified antigen. This mixture 
is then centrifuged to remove antibody-antigen complexes and the resulting supernatant, 
called preadsorbed serum, is used in place of the primary antibody, followed by 
incubation with a secondary antibody.  What might you expect to observe?  Why is this 
an important control experiment? 

3. Dilution series.  Antibodies are highly specific, but they can bind to non-specific sites in 
the tissue or cells that you wish to study.  To circumvent this problem: 
a.  use the lowest dilution of the primary antibody that results in staining.  This dilution 

is determined empirically for each batch of antibody.   
b. pre-incubate the cells or tissue in a solution of protein that will bind non-specifically 

to “sticky” sites in the cells.  This solution is called the blocking solution or “block”.  
We diluted the primary antibodies into bovine serum albumin (BSA, 1mg/mL), which 
functions as the block. 

Task 2. Fixation 
 While your coverslips are incubating in primary antibody, you will learn how to fix cells for 
immunofluorescence.  All fixatives are used only in the fume hood.  Wear gloves when 
handling the fixative and dispose of any used fixative in the hood.  When the cells are fixed 
and rinsed, they can be brought back to your station for staining.  
1. Obtain a coverslip of live cells in a small Petri dish of growth medium. 

2. Remove the medium: hold the dish at an angle and use a Pasteur pipette to remove the 
medium from the side of the dish.   

3. Using the same method of holding the dish at an angle, rinse the coverslip by adding 
warm phosphate buffered saline (PBS) to the dish, swirling gently, and removing with a 
clean Pasteur pipette.  Be gentle: if you pipette directly on the coverslip of live cells, they 
can be dislodged from the coverslip, so squirt the liquid to the side of the dish, not 
directly on the coverslip.  Repeat twice. 

4. IN THE FUME HOOD, and WEARING GLOVES, remove the last rinse of PBS and 
add ~1 mL of fixative (already prepared for you) to the dish containing the rinsed 
coverslip of cells. You can do this with a Pasteur pipette or the SL-1000; the exact 
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volume is not critical, as long as the coverslip is completely covered with fixative.  Swirl 
gently.  Fix for 5 minutes.  The fixative contains Triton-X 100, a detergent that 
permeabilizes the plasma membrane, so that the antibodies can access their binding sites 
in the cell interior. 

5. Remove the coverslip from the fixative using your fine forceps and dunk in 3 beakers of 
PBS-Tw-Az, in the hood.  Place the coverslip of fixed cells in a clean 35mm Petri dish 
with PBS-Tw-Az.  Dispose of the fixative in the proper container in the hood.  (Note: Tw 
stands for Tween, a nonionic detergent.  The Tween is added to the PBS to prevent non-
specific antibody binding.  Az stands for azide, which is present in the fixative to 
discourage growth of microorganisms.) 

6. The coverslip is now ready for staining. Given time constraints, we will have to save 
these coverslips to stain on another day.  Put the coverslip in a clean 35mm Petri dish, 
wrap some parafilm around the edge to prevent evaporation, and store in the refrigerator.   

Staining fixed cells with fluorescent dyes.  
In this section of the lab, you will obtain fixed cells and stain them for several different 
cellular structures.  You will then view the cells in your microscope and obtain images. 

Task 3. Visualization of the actin cytoskeleton with Phalloidin  
Phalloidin, a toxin isolated from the mushroom, Amanita phalloides (death angel), binds 
tightly to polymerized actin (F-actin).  You will use phalloidin that has been covalently 
coupled to a fluorescent dye.  You have already seen actin staining in the slides that were 
prepared for you.  Here we will stain two different types of mammalian cells: motile 
fibroblasts and epithelial cells that form sheets of cells that adhere to each other.  Each cell 
type has a distinct actin cytoskeleton. 
1. Each pair of students should obtain 2 coverslips of fixed cells: one of fibroblasts (NIH 

3T3 cells) and one of epithelial cells (pig kidney cells, LLC-Pk1) and a microfuge tube 
containing the diluted fluorescent phalloidin solution.  It has been prepared at the proper 
concentration for use.   

2. Wearing gloves, pipette 50 µL of the rhodamine phalloidin solution on to the parafilm in 
your humid chamber.  Carefully remove the coverslip from the Petri dish (the cells are on 
the top surface of the coverslip) with the forceps and, holding the coverslip at an angle, 
remove excess PBS using a Kimwipe.  Now, invert the coverslip onto the drop of 
phalloidin, so that the cells are immersed in the phalloidin solution.  Set the timer for 15 
minutes.  Repeat with the second coverslip.  Remember to keep track of which side of the 
coverslip has the cells on it. 

3. When the incubation is over, pick up the coverslip with forceps. Wash away excess 
fluorescent phalloidin by dunking the coverslip 10 times in each of 3 beakers of PBS-
tween-azide.  Blot away any excess PBS-tween-azide using a Kimwipe. 

4. Place the coverslip, cell side down, on a clean glass slide that has a small drop of 
mounting medium on the surface.  Still wearing your gloves, press down (gently, but 
firmly) and carefully blot away any excess mounting medium (using Kimwipes).  Seal 
the edges of the coverslip with nail polish.  The slide should be labeled with your name, 
date and the experiment.   

5. Carefully remove the parafilm and any remaining phalloidin from the humid chamber and 
dispose of them in the toxic waste bin. 
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6. While your coverslip is incubating, think of a control experiment that you could perform 
to demonstrate that the fluorescent phalloidin is labeling F-actin in the cells. 

Data collection and analysis: 
1. Obtain paired images of the cells in phase and the microtubules in fluorescence at various 

magnifications.  Include a marker bar in each image.  What is the organization of 
microtubules in cells?  Is the organization the same in all fibroblasts and epithelial cells? 
(Remember, you observed microtubules in epithelial cells previously.)  Document your 
findings.  Is the staining similar in all areas of the coverslip?  If not, what might be the 
reason? 

2. Experiment with settings of the camera and software so as to obtain the best images of 
the microtubules.   

3. Collect paired fluorescence and phase images of preparations that are stained for actin.  
What is the location of the actin?  Collect sufficient data so that you can be sure that you 
can describe the organization.  

Clean-up 
All solutions containing fixative go into the hazardous waste container labeled 
“paraformaldehyde and glutaraldehyde”. 

Used PBS and medium can go down the drain. 
Pasteur pipettes, broken glass, discarded coverslips go in the glass trash 

Anything with live cells on it can be disposed of in one of two ways: 

• Thrown into the biohazard trash to be autoclaved 

• Killed with 10% bleach, allowed to evaporate in the fume hood, and then thrown in 
the regular trash.  Nothing containing bleach should go in the autoclave! 
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Lab 3.4:  Imaging Living Cells Expressing GFP-
Tagged Proteins 

Goal for the module:   
The goal of this lab exercise is to perform fluorescence imaging of live cells expressing GFP-
tagged proteins.   

Introduction:  
Observation of live cells offers many advantages over examination of fixed (dead) 
specimens, but has unique challenges as well (see below).  The main advantage of using live 
cells is that dynamic processes can be observed, and the spatial and temporal regulation of 
the process can be examined directly.  In addition, if the cell is living, possible artifacts of 
fixation and staining are avoided.  However, stained cells, especially preparations prepared 
with multiple layers of fluorescent antibodies, have excellent signal-to-noise characteristics, 
making imaging easy, especially for proteins that are present in low abundance.  In contrast, 
the fluorescent signal from a live cell expressing a fluorescent protein is usually much 
weaker.  Finally, live cells are sensitive to light – the fluorophores are readily bleached and 
the cells can be damaged by the illumination.   

In spite of the challenges of imaging live cells in the light microscope, fluorescence imaging 
has become relatively routine in recent years.  A major step forward in live cell imaging was 
the discovery and cloning of the gene encoding green fluorescent protein (GFP) a naturally 
occurring fluorescent protein isolated from jelly fish Aequorea victoria (Chalfie et al., 1994).  
The 2008 Nobel Prize in Chemistry was awarded to three scientists, Osamu Shimomura 
(MBL, Woods Hole, MA), Martin Chalfie (Columbia Univ), and Roger Tsien (UCSD) “for 
the discovery and development of the green fluorescent protein, GFP”.  With this sequence, 
nearly any protein for which a gene sequence is available can be fluorescently tagged by 
creating a chimeric gene consisting of the GFP sequence in frame with the sequence of the 
gene of interest.  GFP has been engineered to improve its spectral characteristics and color 
variants of GFP have also been generated.  More recently other naturally occurring 
fluorescent proteins have been discovered, expanding the tool-box of fluorescent proteins 
that can be used to tag genes and distinguish them in the light microscope.  For additional 
information see the references on page 76. 

Transfection Protocol 
To use GFP tagged proteins, the gene encoding the protein of interest, in frame with the 
sequence of GFP, must be introduced into the cells, and so it can be expressed.  In the case of 
mammalian cells, the gene sequences are typically on a plasmid, a small circular piece of 
DNA, which is introduced into the cells using a procedure called transfection.  To do this the 
plasmid is incubated with a commercially available lipid-based reagent that binds to plasmid 
DNA and helps it to enter mammalian cells.   
Alternatively, the cells are incubated with the plasmid DNA and exposed to a brief electric 
pulse using an instrument called a nucleofector, which allows DNA (or RNA) to enter the 
cell nucleus directly.   

After transfection or nucleofection, the cells are plated at the appropriate density and cultured 
for 24-48 hours.  For this experiment, the cells were nucleofected for you.  Cells that have 
been transfected or nucleofected and examined 24-48 hours later are said to be “transiently 
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transfected”.  In a population of transiently transfected cells, not all cells express the gene of 
interest, and the level of expression can vary.  Following transient transfection, cells can be 
“selected” so that only cells expressing the GFP-gene remain in the culture, and a clonal cell 
line can be made in which all cells express the gene tagged with GFP.  This is called 
“constitutive” expression.  In this experiment, you will examine transiently transfected cells 
and a cell line permanently expressing GFP-tubulin, and identify the cellular location of an 
unknown GFP fusion protein. 

Working with live cells 
Use non-CO2 medium. Replace the bicarbonate-buffered growth medium used in the CO2 
incubator with non-CO2 medium (buffered with HEPES), which will maintain the correct pH 
in the room atmosphere.  To do this, remove and discard the CO2 medium, and gently add 
non-CO2 medium to the side.  Do not squirt it directly on the cells. 
Keep your cells warm with the stage heater on your microscope, or on the slide warmer on 
the lab bench (if your experiment does not require some other temperature). 
Observe cells in a glass-bottom dish.  These dishes look like small plastic Petri plates, but 
they have a coverslip bottom (see Figure 18).  We use these dishes because they are more 
stable than regular coverslips mounted on glass slides with Parafilm spacers.  This is 
important if you want to take time-lapse exposures of organelle movement and you need to 
minimize z-axis (focal) drift during the image-taking.  These 35 mm Petri dishes are slightly 
smaller than the microscope stage cutouts (the stainless steel circles just above the objective 
lenses) you have been using.  Each microscope has a smaller diameter cutout that you will 
need for these Petri dishes. 

 
Figure 18.  A MatTek™ Petri dish 

Materials: 
Live cells that constitutively express GFP-tubulin. 

Live cells that have been transiently transfected with another protein tagged with GFP 
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Procedure: 
Task 1. Imaging cells constitutively expressing GFP-tubulin. 
(Note: the cells were plated in dishes containing a coverslip bottom; had they been plated on 
coverslips, you could prepare them for microscopy*.) 

1. Begin by imaging the cells at low magnification in phase contrast.  Can you observe the 
nucleus?  Organelles?  Lamellipodia?  Make a short movie of the live cells.  Are the cells 
alive?  How can you be sure?   

2. Switch to fluorescence.  Use the shutter to acquire images of the cells.  If you leave the 
shutter open and look with your eyes, the sample will bleach rapidly.  Are all of the cells 
fluorescent?  Where is the GFP located? 

3. Test various settings of Image J and the neutral density filters to obtain a good image of 
the cells.  Begin with low magnification, and switch to higher magnification.   

4.  Set up Image J to acquire a short time lapse sequence of cells undergoing mitosis.   

Task 2. Imaging cells expressing another GFP-tagged protein. 
1. Obtain a dish of cells transfected with one of the unknown GFP-tagged proteins.  Note 

the number on the dish. 

2. Image the cells as in Task 1. 
3. Your goal is to identify the organelle or cellular structure that is labeled by GFP in the 

dish of cells.  Observe several fields of cells and collect images.  Examine the phase 
images of the same field of cells.  Does the GFP fluorescence correspond to a location or 
structure that you can identify in the phase image? What is the size or shape of the area of 
the cell that is fluorescent? Is the fluorescence in the entire cell?  Is it restricted to a 
particular region of the cell? Is the fluorescent pattern the same in all cells?  Does this 
help you to identify the organelle or structure?  Once you have identified the 
organelle/structure, think of any particular proteins that localize to this part of the cell.  

                                                
* Preparing cells for microscopy:   
1. Obtain a dish of cells that have been transfected/nucleofected with a vector containing the DNA sequence 

for green fluorescent protein (GFP).   

2. Take a clean class slide and label it.  Now, prepare a miniature chamber for the cells as follows.  Cut two 
small strips of parafilm, each ~2 cm long and about 1 cm wide.  Place these on the slide, separated by ~2 
cm (the width of the coverslip).  Press the parafilm with the forceps to stick it to the slide.  Place a SMALL 
(~100 µL) drop of warm, non-CO2 medium in between the two strips. 

3. Remove the coverslip from the dish using your fine forceps and blot the excess medium using a Kimwipe.  
Invert the coverslip, so that it rests on the two strips of parafilm.  The space between the coverslip and the 
slide should be filled with non-CO2  medium; if it is not, add a bit more, by pipetting medium in from the 
side. 

4. Carefully, remove excess medium from the top surface and edges of the coverslip.  Use the corner of a 
Kimwipe, or a Q-tip.   

5. Seal the coverslip to the slide so that the medium does not evaporate.  To do this, use VALAP, which is 
liquid at ~37 C, but hardens at room temperature, making a seal. 

6. When the VALAP hardens, carefully rinse the top surface of the coverslip with a little distilled water on a 
Q-tip. 
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Based on your observations, identify the cellular structure that contains the GFP-tagged 
protein and  if possible the identity of the protein. 

Data collection and analysis:   
Determine the following:  

What fraction of cells express the transgene ? 

What is the range of expression level of the GFP-tagged protein? Are some cells bright 
and others dim?  To answer this question, you will need to quantify the level of 
expression.  Take phase and fluorescence images of several fields of cells (~10).  For the 
fluorescent cells, measure the fluorescence intensity.  Now make a figure (or table) to 
show your results.   

A table like the one shown below can be used to record the data that you collect.  Be 
prepared to share these data with the class.  Include your data for each of the experiments 
(GFP transiently transfected, GFP-tubulin permanent line, GFP-unknown protein transiently 
transfected line).  From these data, make figures of your results. 

Experiment Field of View # cells # expressing GFP 
Level of expression 
(pixel values here) 

     

     

     

Questions:  
Compare what you observed in live cells with the images that you obtained of cells fixed and 
stained with antibodies to tubulin.  How were they similar? Different?  Summarize the 
advantages and disadvantages of each approach. 

References: 
Chalfie, M., Y. Tu, G. Euskirchen, W.W. Ward, and D.C. Prasher. 1994. Green 

fluorescent protein as a marker for gene expression. Science. 263:802-805. 
 Green Flourescent Protein.  (2008, June 18).  In Wikipedia, the free encyclopedia. 

Retrieved June 19, 2008, from 
http://en.wikipedia.org/wiki/Green_fluorescent_protein  

Tsien, R.Y., Rendered GFP Molecule. Retrieved June 19, 2008 from  
http://www.tsienlab.ucsd.edu/Default.htm 

Clean-up 
Used PBS and medium can go down the drain. 

Pasteur pipettes, broken glass, discarded coverslips go in the glass trash 
Anything with live cells on it can be disposed of in one of two ways: 

• Thrown into the biohazard trash to be autoclaved 

• Killed with 10% bleach, allowed to evaporate in the fume hood, then thrown in the 
regular trash.  Nothing containing bleach should go in the autoclave! 

! 

fluorescent cells
total cells( )
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Lab 4.1:  Motility in Control Cells 
Goal for this lab: 
To observe uninhibited cell motility in fibroblasts, epithelial cells, and melanoma cells. 

Introduction:   
Many types of cells are motile.  Fibroblasts, such as the 3T3 cells that we have used in 
previous labs, show a characteristic form of motion that consists of protrusion, adhesion and 
contraction.  The first step, protrusion, occurs when a cell extends cytoplasm in the direction 
of migration.  The cellular extension is termed a lamellipodium, and consists of a thin layer 
of cytoplasm that is especially rich in F-actin, and generally devoid of membrane bound 
organelles.  Protrusion is driven (at least in part) by the assembly of a meshwork of F-actin at 
the leading edge of the cell.  Cells can extend many protrusions, some of which adhere to the 
substrate and determine the direction of locomotion, while others retract.  Following 
protrusion and attachment, contraction of actin and myosin located in the central and rear of 
the cell  occurs, moving the cell forward (see Figure 19). 
Although fibroblasts migrate individually, other cells migrate not as individual cells, but as 
sheets of connected cells. Motion of sheets is characteristic of epithelial cells, such as 
LLCPk1 cells.  As with individual motion of fibroblasts, motion of sheets is thought to 
involve protrusion and contraction.  However in this case, the cells, which are held together 
by cell-cell adherens junctions, move together.  

 

Figure 19.  Cell locomotion.  (Figure 16-85 in  Alberts, 
et al, 2002, Biology of the Cell, 4th edition, Garland 
Science, reproduced with permission.) 

Both individual cell migration and motion of cell sheets can be easily studied by examining 
cells in tissue culture.  In phase contrast, the protrusive behavior of individual cell can be 
observed, and time-lapse movies of these dynamic events recorded.  The edges of the cells 
often display lamellipodia that extend along the surface of the dish or coverglass and others 
that extend upwards into the medium. These non-adherent protrusions are referred to as 
‘ruffles’ because they give the cell a characteristic ruffled appearance.   

Another experimental approach to examining cell motility is to make a ‘wound’ in a 
confluent monolayer of cells.  In this type of experiment, the tip of a pipette (or similar tool) 
is used to remove a strip of cells from the monolayer, generating an area free of cells.  With 
time, the cells migrate directionally, closing the wound.  As the cells migrate, they extend 



80 Lab 4.1:  Motility in Control Cells 

lamellipodia into the free space.  This method is especially good for examination of epithelial 
cell migration, but can also be used to study individual cells migrating. 

Like cells at the edge of a wound, many cells migrate directionally in response to cues in the 
environment.  For example, amoeboid cells can migrate toward a source of food, and 
Dicytostelium migrate in response to cAMP.   In embryos, cells receive diverse cues from 
other cells and extracellular factors in their environment that direct their motility.  Other cells 
move in a more random manner, such as the fibroblasts that we will examine in lab.   
Migration requires an intact actin and myosin cytoskeleton to generate protrusions and 
contractile forces.  In most cell types, microtubules also contribute to cell motility. In 
mammalian cells, disassembly of microtubules causes cells to round up and become less 
asymmetric.  Such cells send out protrusions in all directions, as if they are attempting to 
migrate in multiple directions simultaneously, and fail to translocate.  These experiments 
demonstrate that cell polarity or asymmetry is important for motility.  Microtubules also 
serve as the tracks for the motion of various membrane bound cargoes and directed 
membrane delivery may also contribute to cell locomotion.  

Procedure  
First, you will observe the motile behavior(s) of three different cell types (Experiments 1, 2, 
3).  Then you will learn to use an inhibitor of actin, and then observe cell motility following 
inhibition of actin.  Based on your observations of the control cells, you will design your own 
experiments to determine the contribution of actin to cell motility using either fibroblasts, 
epithelial cells or melanoma cells.   
You will have three lab periods to perform these experiments, so you can plan accordingly.  
All three types of cells will be available each day.   

Task 1. Lamellipodial extension 
Here you will examine the first step in motility, the extension of a protrusion or 
lamellipodium.  For this purpose, we will use 3T3 fibroblasts and LLCPk1 cells.  

Obtain a glass-bottom dish of cells.  If the cells are in CO2 medium, replace it with non-CO2 
medium, using the gentle techniques described on page 74.  Turn on the stage heater to 37°C. 

Use the 40 or 100× lens and align your scope for phase contrast.  Find a cell, and make time-
lapse movies of the periphery.  Try to find cells that are extending and retracting their 
lamellae.  These cells will have phase dense and phase light areas around the periphery.  
What do you observe?  Do the different types of cells behave in a similar manner?   

Task 2. Movement in melanoma cells  
B16 melanoma cells contain pigment granules, which are transported within the cell along 
cytoskeletal filaments.  These cells are also very dynamic and show interesting motile 
behaviors.  Because the melanoma cells are human cells you must handle them with caution.  
Wear gloves and place all materials that have come in contact with these cells in the 
biohazard trash to be autoclaved.  The pigment granules are phase dense, due to the pigment, 
so they are easy to observe.  Make observations of the edges of these cells and the interior 
region.  Try to find a region that is sufficiently flat for you to clearly observe individual 
granules. 
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Task 3. Dynamics of GFP-actin in motile cells.   
After you have examined cell protrusive activity in phase contrast, switch to fluorescence 
observation and examine the LLCPk1 cells expressing GFP-actin.  Record the dynamics of 
actin in the cell periphery; compare the behavior of actin with your observations of the cell 
periphery in phase contrast.     

At this point you will have examined three kinds of cells using phase contrast, and you will 
have observed the actin cytoskeleton in fluorescence.  Review your data.  Convert your 
image stacks into movie files.  In the second part of this lab, you will design experiments to 
test the role of the cytoskeleton in these various motile behaviors.   Discuss possible 
experiments with your lab partner and the instructor.  The reagents and some suggested 
experiments are given on page 83. 

Clean-up 
MatTek dishes can be thrown in the biohazard waste container to be autoclaved or sterilized 
with 10% bleach and left in the fume hood to evaporate.  Nothing containing bleach should 
go in the autoclave! 
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Lab 4.2:  Mechanism of Motility: the use of inhibitors 
Goal for this lab: 
To determine the effects of cytoskeletal disruption on cell motility. 

Introduction: 
To understand how cellular processes work, scientists often utilize specific inhibitors that 
prevent one or more steps in the biological process they are studying.  For example, many 
animals produce neurotoxins (think of snake venom) that are highly potent.  These molecules 
can be isolated from the venom (which typically contains a mixture of active molecules), and 
applied to neurons in culture to understand the molecular basis of neuronal communication.  
Many plants also produce active compounds that inhibit various cellular processes.  A good 
example is the mushroom toxin phalloidin, which you used in a previous lab to stain actin 
filaments.  Phallloiden binds very tightly to actin (which is why it is an excellent and specific 
marker for actin).  In live cells, phalloidin prevents actin’s interaction with myosin, a 
necessary step in muscle contraction, explaining its toxicity.   
Although the best inhibitors work by binding tightly and specifically to a single cellular 
component, at high concentrations, some inhibitors bind more than one target, resulting in 
pleiotropic effects.  In addition, not all cells can uptake the inhibitor with the same efficiency, 
thus changing the amount of inhibitor in the cell.  Therefore, prior to using an inhibitor, 
scientists treat cells with a range of concentrations of the inhibitor for a set time, and then 
measure the effect.  Alternatively, or in addition, an inhibitor at a single concentration can be 
applied to cells for variable lengths of time.  A control solution, containing the solvent in 
which the inhibitor is dissolved, is also applied to the cells, so that any nonspecific effect due 
to solvent can be examined, and hopefully ruled out. 
In this lab we will perform two experiments.  First, we will provide each group with a tube 
that contains either solvent alone, or a given concentration of an inhibitor of actin.  The class 
can determine the lowest effective concentration of the inhibitor that can be used to disrupt 
actin filaments. 
In a second experiment, students will apply inhibitors (at effective concentrations that were 
determined previously) and observe the effects on cell behavior.   

Task 1. Using an Inhibitor 
Cytochalasin D is a fungal toxin that binds to the growing ends of actin filaments, preventing 
their assembly and inducing disassembly.  The response of cells to an inhibitor depends on 
the concentration of the inhibitor used and the time that the cells are exposed to the drug.   
Typically, scientists must determine the lowest effective dose of an inhibitor prior to 
performing experiments. 
In this exercise the class will perform two experiments.  Some groups will obtain an aliquot 
of cytochalasin D and apply the inhibitor for various times.  Other groups will obtain an 
aliquot of cytochalasin D and test different concentrations for a set time. 

Groups 1-3:  Vary time, one concentration (250nM) 
Group 1: 5 min 
Group 2: 15 min 
Group 3: 30 min 
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Groups 4-6:  Vary concentration, one time (15 min) 
Group 4: 250 nM 
Group 5: 250 nM 
Group 6: 2500 nM 

Groups 7-8:  Controls (no inhibitor) 

Procedure 
Take a dish of cells and remove the growth medium to a liquid waste bucket. 

Add the contents of the tube with the correct concentration of inhibitor or solvent. 
Return the dish to the incubator for the indicated time. 

At the end of the incubation, remove and discard the inhibitor, and rinse twice with PBS.  
Leave the second rinse in the dish until you get to a fume hood. 

Take the dish to a fume hood, and remove the last PBS rinse.   
Add fixative to the cells, incubate 10 minutes. 

Remove fixative to waste bucket in the hood.  Rinse gently with PBS. 
Back at your bench, stain the cells with phalloidin, following the directions on page 71. 

When the cells are ready, examine them at the microscope, and collect images. 
The class, as a whole, needs to determine the extent of actin disassembly in the images. 

Things to consider: 
How will the data be collected? 

What parameters will be measured? 
How will you document the extent of actin assembly or disassembly? 

Task 2. Test the effect of actin inhibitors on cell motility 
The following drugs will be available, already made up at 2× the optimal effective 
concentration in tissue culture medium. 

Cytochalasin D.  Effective concentration range: nM to µM. 

Jasplakinolide is a naturally occurring cyclic peptide isolated from the marine sponge, 
Jaspis johnstoni, commonly used to stabilize actin filaments by interfering with their 
dynamic turnover.  

ML-7 is an inhibitor of protein kinases; it has specificity for myosin light chain kinase, which 
is required to phosphorylate and activate myosin for interaction with actin. 

Experiments:   
To add the inhibitor to cells, remove the growth medium, and then use an SL1000 to put 
exactly 1.0 mL of the control growth medium back in the dish.  Bring the dish to the 
microscope and find an interesting area that shows motile behavior, and begin filming their 
behavior. 

When you want to add the inhibitor, simply add 1.0 mL of medium containing 2× the desired 
(final) concentration of inhibitor to the dish.  The dish now has 2 mL of medium at a 
concentration of 1×.  See more on dilutions on page 149. 
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If you wish you can also add the inhibitor before beginning your observations, and then film 
the cells in the presence of inhibitor for a few minutes.  You can test the reversibility of the 
inhibitor by removing the inhibitor containing medium, rinsing the dish with PBS-/-, and 
then replacing with fresh medium.  Is the effect of the inhibitor reversible? 

If you wish to test other concentrations of an inhibitor let an instructor know and we can help 
you make a higher or lower concentration from the stock solution. 

Other options: 
If you would like, we can provide cells expressing GFP-tubulin so that you can observe the 
microtubules in control and cells treated with various inhibitors.  We can also provide an 
inhibitor of myosin (blebistatin).   

Note on cell health:  these cultured cells grow best at 37°C.  Your microscope is equipped 
with a temperature-controlled stage.  Any medium or inhibitors you add to the dish should 
also be warm.  You can use either the incubator or the water bath to keep your solutions 
warm. 

Task 3. Data analysis:   
At the end of the lab, you will have sequences of cells extending and retracting lamellipodia 
for control cells and cells treated with various inhibitors.  You will have data for three types 
of cells, and images of the actin cytoskeleton (GFP-actin).  You should decide how you 
might want to display your findings.  You can measure the rate that lamellae extend, using 
the tools in ImageJ.  You can measure the change in the area of the lamella from one frame to 
the next (for example for images taken a few minutes apart).  You can probably think of 
other parameters that you can quantify.  In fluorescence images, you can quantify the 
fluorescence and how this changes over time.   

Class Data analysis 
The data for Task 1 are distributed among all the lab groups.  How are you going to compare 
the images and determine which tube had which concentration?  Use class time to upload 
images to the course website and try to put them in order from low concentration to high.   
As you do this, think about how you could quantify the data in the images.  Try out some of 
your ideas.  How do the data look when you quantify the images versus using your visual 
impression to score the level of inhibition?  How many images are needed for each 
concentration to get a good idea of what is going on? 

Clean-up 
MatTek dishes can be thrown in the biological waste container to be autoclaved or sterilized 
with 10% bleach and left in the fume hood to evaporate.  Nothing containing bleach should 
go in the autoclave! 
Medium and buffers can go down the drain. 
Check with your instructors regarding disposal of leftover toxic reagents. 

Presentation: 
Share your results with the class, using the advice beginning on page 122 regarding 
presentations. 
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Lab 5.1:  Receptor-mediated Endocytosis 
Goal for this lab:  
To follow cell surface receptors as they are internalized. 

Pre-lab homework 
Read about receptor-mediated endocytosis and other forms of internalization in Alberts’ 
Molecular Biology of the Cell, available free online from the National Institutes of Health 
(http://www.ncbi.nlm.nih.gov/books/bv.fcgi?rid=mboc4.section.2383).   

Introduction 
Endocytosis is the process of cells taking up material from their environment starting with 
the formation of vesicles.  This process is controlled by an organelle called the endosome.  In 
general, the endosome is concerned with the inward flow of membranes and luminal 
contents. In contrast to the Golgi apparatus, the endosome has no distinctive morphology but 
is rather a collection of small, more or less spherical cisternae scattered throughout the cell.  
Endocytosis brings material into the cell non-specifically because whatever is in solution will 
be trapped in the lumen of the forming vesicle, and also specifically by means of dedicated 
receptors. In this lab we will study both receptor-mediated endocytosis and in the next one 
the non-specific process.  
An example of a ligand that is internalized by receptor-mediated endocytosis is transferrin.  
Transferrin is an iron-transport protein that binds two iron atoms in the plus-three oxidation 
state.  Iron-bound transferrin has high affinity for its cognate cell surface receptor, the 
transferrin receptor.  This receptor and its ligand are internalized via clathrin-mediated 
endocytosis.  Clathrin and associated proteins form a patch on the membrane around the 
occupied receptors and drive the formation of a vesicle.  Because the clathrin-rich patch is 
prominent in the electron microscope, the vesicles are called “coated” vesicles, even though 
the coat is shed soon after the vesicle forms.  
Briefly, clathrin-coated patches, typically called “pits”, continuously internalize membrane 
and membrane proteins.  Thus, specific receptors and any cargo that is bound to the receptors 
are brought into the cell.  The coated pits round up and pinch off from the plasma membrane 
to form coated vesicles, the interior (or lumen) of which contains material that was on the 
extracellular face of the membrane.  Therefore, the internalized cargo is inside these vesicles.  
As they are transported inwardly, the clathrin coat is stripped from the vesicles and a proton 
pump in the vesicle begins to acidify the lumen.   The stripped vesicles fuse with other 
vesicles to form endosomes, which further acidify.   As discussed below, the acidity is useful 
for sorting.  A class of endosomes called “sorting endosomes” segregates cargo, some of 
which goes to the digestive organelle (the lysosome) while some gets recycled via recycling 
endosomes back to the cell surface to repeat their endocytosis cycle. Material reaching the 
lysosomes is degraded to free monomers (lipids, nucleosides, and amino acids) for re-use by 
the cell. 

In the case of transferrin, the cell has to make sure that the iron also does not wind up back 
outside the cell.  This is accomplished by means of the acidification.  In the acidic lumen of 
the endosome (pH ~6), the receptor-bound iron-transferrin has a weak affinity for iron, which 
dissociates from the transferrin (which itself remains bound to the receptor). The receptors 
along with its transferrin are recycled back to the plasma membrane, but happily with iron-
free transferrin. When the complex reaches the cell surface, the iron-free transferrin 



88 Lab 5.1:  Receptor-mediated Endocytosis 

dissociates because it has low affinity for its receptor under extracellular conditions.  This 
freed transferrin then can bind two more iron atoms, bind to a transferrin receptor and repeat 
delivery of iron into the cell (Figure 20). 

 
Figure 20  The receptor-mediated endocytosis of transferrin (blue) follows the recycling 
pathway. When transferrin (blue) has bound to one or two iron atoms (yellow), the transferrin-
iron complex binds to its cell surface receptor (green).  The ligand-receptor complex is 
internalized via coated pits to coated vesicles which un-coat to form early endosomes.  As the 
endosomes acidify, the receptor-bound transferrin releases iron which is transported across the 
endosome membrane for use by the cell.  The iron-free transferrin and receptor complex is 
brought to the sorting endosome whence it is returned to the plasma membrane. Without iron 
in the extra cellular environment, the transferrin dissociates and finds more iron.  

To follow transferrin processing, you will use a fluorescently labeled, human transferrin.   
The fluorescent label on the transferrin is Alexa Fluor 488, which is a bright fluorophore.      
You can find the spectral properties of the AF488 from the Molecular Probes (Invitrogen) 
website.   

In this module you will explore transferrin trafficking.  In subsequent modules you will 
compare transferrin internalization to the internalization of dextran, which is internalized 
without receptors.  In the final module, you will also follow the dynamics of endosomal 
vesicle traffic as it moves along microtubules. 
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Materials 
3T3 mouse fibroblasts on cover slips 

Alexa Fluor 488-transferrin at 1 µM in Fe-HBS plus 1 mg/mL BSA (on ice) 
AF488-transferrin at 1 µM in high-Fe-HBS plus 1 mg/mL BSA (on ice) 
Ice cold rinse buffer (Fe-HBS) 

HBS 
Fine forceps 

Small beakers 
Humid chamber(s) 

Glass slides 
Fixative solution (HBS plus 3.7% paraformaldehyde), and rinse buffer.  

Mounting medium 
Ice bucket 

Procedures 
The transferrin reagent that you will be working with is produced from human blood serum.   
It has been tested and found negative for viruses.   Nevertheless, you should wear gloves 
while working with the labeling solution.  Rinse solutions should be disposed of in a bottle 
that we will autoclave.  Anything that may have contacted cells or solutions exposed to 
transferrin (Petri dishes, gloves, Parafilm, tips, filter paper, etc.) should be placed in a 
biohazard bag for autoclaving.  Used glass slides can be disposed of in the glass trash, since 
they have been sterilized by the formaldehyde fixation. We do all of this just to be on the safe 
side.  

Examine the flow chart in Figure 21 for a summary of the experiments we will do. 

 
Figure 21.  Flow chart of transferrin experiments 
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Make four humid chambers for labeling and subsequent incubation.  Place the chambers on 
ice in an ice bucket to chill the chamber surfaces.  Label each chamber with your initials or 
other identifying mark.  Each dish will be incubated for a distinct treatment.  Be sure to label 
them clearly!  Place one 50 µL drop of the transferrin labeling solution on each humid 
chamber Parafilm sheet.  Only after you have this set up should you obtain four coverslips of 
3T3 cells (each in a small Petri dish). 

You will use the Petri dishes that the cells are in for subsequent steps.  Label each dish as you 
did with the humid chambers.  One coverslip at a time, remove the growth medium and rinse 
3 times with ice-cold Fe-HBS.  Be really gentle!  Leave the last rinse in the Petri dish and 
put it into the ice bucket to keep the cells cold.  This will chill the cells to 4°C.  When you 
have all the coverslips rinsed and chilled, quickly transfer them to the humid chambers to 
begin the binding of transferrin to its receptors on the cell surface.  Blot the excess buffer 
from the edges of the cover slips before placing them cell side down on the transferrin 
droplet.  Keep the cells cold.  Do not delay in the transfer of the rinsed cells to the humid 
chamber. 

All four coverslips will be incubated on ice for twenty minutes.  Coverslip 1 will be fixed at 
that point.  Turn coverslip 1 over (i.e., cell side up), place in its original Petri, and add 1 mL 
of ice-cold HBS slowly and carefully to coverslip 1 to remove excess transferrin and then fix 
according to the instructions below.  The remaining three coverslips will be warmed up and 
incubated further at 37˚C.  To do this, carefully turn the coverslip over (cell side up) and 
return to original Petri dishes.  Add slowly and carefully 1 mL of warm Fe-HBS and return to 
incubator.  After 30 min, fix coverslip 2.  After 90 min, fix coverslips 3 and 4.  The 
difference between coverslips 3 and 4 is that coverslip 4 should be incubated in transferrin 
made up in high-iron HBS and also rinsed after the 20 min on ice in high-iron HBS for 
continued incubation therein.  

Fixation 
You will fix the cells in formaldehyde.  Do this in the fume hood wearing gloves.  In 
principle, you should do the fixation exactly on schedule as per the above protocol; however 
the hood might be busy.  You can stop cell reactions by simply placing Petri dishes with cells 
on ice.  When you have access to the hood, remove the buffer and replace it with 1 mL of the 
fixative.  Let stand for 15 minutes at room temperature. Then, rinse three times in the buffer 
provided.  Be sure to discard the used formaldehyde solution and the rinses in the container 
provided.  As the cells are now dead, you may mount them at room temperature on clean 
labeled slides: place a small drop of mounting medium on the slide, and then invert the cover 
slip onto the drop.  Blot excess HBS from the cover slip prior to mounting it in Vectashield 
mounting medium.  Seal with nail polish. 
Now proceed on to the imaging section below. 
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Imaging 
The goal of this module is to explore the time and iron dependence of the endocytosis of 
transferrin bound to its cell surface receptors.  We want to know several things about the 
endocytosis process.  Among them are: 

• Where in the cell do transferrin-positive endosomes reside?  
• Is there a difference in the location within the cell or in the abundance of early vs. late 

endosomes (e.g., 30 minutes vs. 90)? 
• Does high iron trigger a rapid down-regulation of the receptor, sending it to 

lysosomes? 
To get at these points you will observe the distribution of transferrin on the surfaces and in 
the cytoplasm of your cells.  You will take through-focal image series to observe the 
distribution throughout the cell.  You will measure the total amount of transferrin in patches 
on the cell surface and elsewhere. 

Task 1. Observe your cells.  
For each cover slip of cells, observe the transferrin signal by eye and by camera.   Alexa-
Fluor488 has an excitation peak around 488 nm and an emission peak around 510 nm.  Use 
the blue excitation/green emission fluorescence filter cube for imaging.  You should get a 
feel for the distribution of fluorescence in the cells and the variation among cells before 
taking and storing images.  Endosomes will be scattered in the cytoplasm of the cells.   
Lysosomes are much larger (i.e. brighter) than endosomes and are often found near the cell 
nucleus.  Always try to minimize photobleaching by shutting off fluorescence excitation 
between your observations and also by using the shutter when taking single pictures with the 
camera. 

Task 2. Through-focal series.   
You should take a series of images from the bottom part of the cell to the top of the cell.  The 
100×, 1.3 NA lens is best for this purpose.  The through-focal imaging can be done in a semi-
quantitative way by using the fine focus knob markings.  One full rotation of the fine focus 
control corresponds to 100 µm of movement in the z-direction.  Thus, each mark on the fine 
focus knob equals 1 µm.   

Find a group of cells that you think is representative of the cell population.  Locate the 
“bottom” of the cells by focusing on it.  While one partner observes the cells, the other 
partner should change the focus using the fine focus control.  Count the number of fine focus 
marks are needed to scan all the way to the top of the cells.  This is the thickness of the cells 
in µm.  (Not all cells will be the same thickness.  You should scan to the top of the thickest 
one in your field of view.)   
You need to keep the exposure of each of the images in the through-focal series the same as 
all the rest for subsequent image analysis.  You don’t want to overexpose very bright 
elements of any image, so find the brightest area in your image stack and set the fluorescence 
illumination and shutter exposure time to keep the brightest pixels below the maximum 
camera signal value (4095).  Probably keeping the camera signal below 3500 is a safe bet in 
case you missed some other very bright feature in one of your slices.  If photobleaching is 
fast then you can do this investigation on tester cells and then capture your through focal 
series on a different cell. 
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Now take a through-focal series of images at 1 µm z-steps from the bottom to the top of the 
cells.  You can do this by taking each image manually as you increment the fine focus knob 
or you can do this by setting up a time lapse image series (with enough images to cover the 
number of focal steps that you will need).  Start the first image at the bottom of the cells and 
then move the fine focus in 1 µm intervals between images.  Having 10 sec between images 
for the time-lapse approach should give you enough time to change focus after one image has 
been taken and before the next one is taken. Be sure to use the shutter under computer control 
for pulsed fluorescence illumination to minimize photobleaching when you take these 
images.   

Take a phase-contrast image at one of the focal planes to have a reference image for this 
fluorescence image series. 

Repeat this for all four sets of cover slips.  You might need to reset the image exposure time 
between coverslips.  Make note of these exposure times: they will let you quantitatively 
compare the different sets of images.  Note that you will be taking more pictures of each 
coverslip in the next step, and you might want to do that now before moving on to the next 
cover slip. 

Task 3. Cell surface and cytoplasmic distribution of transferrin.   
One thing we want to quantify is the relative number of transferrin particles in clusters on the 
cell surface, how many cell surface clusters there are, the number of endosomes and 
lysosomes (if any) and the brightness of these organelles.  As with the through-focal series, 
set the illumination and exposure time to keep the camera from saturating at any image slice 
that you might use.   Leave these settings fixed for all of the images.  Focus on the top of a 
cell or group of cells (this may be more difficult for the LLC-Pk1 cells than for the 3T3 cells 
due to the rounder nature of the LLC-Pk1 cells).  Take an image of the surface layer.  For 
coverslip 1 (incubated on ice only), the cell membrane is likely to be clearly labeled and 
defining a clear surface.  For the other coverslips, take an image near the surface but not 
necessarily right at it.  Early endosomes are near the periphery of the cell but not right at the 
membrane.  Now focus well into the cell interior and take an image.  Use your judgment to 
select a good focal plane (or planes if you want to take more than one).  Do this on a series of 
cells so you can compare many clusters and endosomes.  You will quantify the transferrin 
content of these clusters later.  You should take companion phase contrast pictures for each 
field of cells for reference. 
Repeat this for all four cover slips.  It will be best if you can leave the camera exposure 
settings constant for all coverslips, but if you have to adjust them then be sure to keep track 
of the exposure time (or other adjustment). 

Task 4. Analysis 
Through-focal series:   
Analysis can be done at home if you have downloaded a copy of imageJ.  Note that the 
following stack manipulations have been difficult for students to get to work.  Please check 
with your instructors if you encounter difficulty.  Also there are good resources on the 
ImageJ web page as well as related sites with helpful tips and tricks.  
Make a single projection image of each through-focal stack.  Convert the set of through-focal 
images for a cell into a single image stack (File > Import > Image sequence…).   Set the 
pixel-to-distance conversion in the images with the “Set scale” menu item.   
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Now compress the image stack into a single projection image (Image>Stacks>Z project…) 
using one of the “Projection types”.   

• “Average Intensity” stores average intensity of all images in the stack at each pixel 
location.   

• “Maximum Intensity” projection creates an output image each of whose pixels contains 
the maximum value over all images in the stack at the particular pixel location.   

• “Minimum Intensity” projection creates an output image each of whose pixels contains 
the minimum value over all images in the stack at the particular pixel location.   

• “Sum Slices” creates an image that is the sum of the slices in the stack.   

• “Standard Deviation” creates an image containing the standard deviation of the slices.   

• “Median” stores the median intensity of all images in the stack at each pixel location.   
Your best bet for the bright dots is probably the Maximum Intensity projection, though you 
should try other projections to see what they produce.  This sort of image processing 
essentially extends the focal distance of the microscope by artificially keeping the brightest 
elements of each image and throwing away the rest.  Most of the brightest elements will be 
those that are in best focus in each slice. 
Make a 3-D projection of your data stack. Do this with the Image > Stacks > Re-slice [/]… 
menu item. The input spacing is 1 µm.  Set the output spacing to be 0.5 to 1.0 µm (otherwise 
the 3-D projection will use too much memory).  Remember that your first slice was at the 
bottom of the cells, and set the start point accordingly.  You should end up with a z-x image 
stack that lets you look at the interior of the cells and their surfaces in cross section.   Again 
if you have trouble doing this, please ask for help.  

Transferrin spot fluorescence power:   
This will be tedious. For the second set of images that you took, (i.e., not the through-focal 
series) separate images into to cell surface and cell interior focal planes.  In some treatments, 
for example coverslip 1 (20 min on ice) we expect few if any spots of interior fluorescence.  
In that case, just measure surface spots.  For a given coverslip, try to measure more than ten 
surface spots and more than ten interior spots.  The more you can measure the more 
meaningful the analysis will be.    

To measure, outline a spot with one of the marquee tools and get the average intensity and 
the area (remember to adjust the imageJ measurement parameter choices at the beginning of 
each session).  For each image, also measure average intensity of at least one background 
region, namely a region with no obvious transferrin florescence (if the background intensity 
seems variable because of some haze or blur then take several background regions and use 
the average in the calculations below).  Depending on the number of spots, measure all or 
some of them or a representative selection.   Collect these data for your sets of surface and 
interior images.  You may pool all of the surface data (per coverslip) and all of the interior 
data (per coverslip).    
Once all the spots are measured, then take (Ispot – Iback)*Aspot, where Ispot is the average 
intensity for a spot and Iback is the average background intensity for the image, and Aspot is the 
area of the spot.  This gives you the total intensity, or the fluorescence power of that spot.  
This should be proportional to the total number of fluorophores.  How is this number 
different than the average intensity?  When would the average intensity be of interest?  
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You need to be systematic when collecting the spot data.  You want to sample “typical” spots 
and not to re-sample the same spot.  Have a reasonable feeling for whether the spots are near 
the surface of the cell or deep inside.  If you can stand to measure as many as ~30 or more 
spots per condition (e.g., surface and coverslip 1), then you can report the data as a histogram 
which is a great way to look at it.  Otherwise, you should report the average ± SD.  Compare 
the power of spots at the surface and in the interior. Is this different at 30 vs. 90 min?  Did 
the high iron change this relation?  How variable is the spot power?  Does this variability go 
up or go down when you compare surface to interior?  Or the interior at different times?  Do 
your best to answer some or all of these questions in your report.  Do the answers match what 
you read about endocytosis of transferrin?  

 The above analysis focuses on the intensity of each spot.  What else could you measure 
about the spots to give you additional information about endocytosis?  

Clean-up 
Anything with transferrin on it should go in the biohazard container to be autoclaved. 

Left-over buffer or medium can go down the drain. 
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Lab 5.2:  Bulk-phase endocytosis 
Goal for this lab: 
To follow the movement of bulk-phase endocytosis and compare that to the movement of 
transferrin.   

Pre-lab homework 
Read about receptor-mediated endocytosis and other forms of internalization in Alberts’ 
Molecular Biology of the Cell, available free online from the National Institutes of Health 
(http://www.ncbi.nlm.nih.gov/books/bv.fcgi?rid=mboc4.section.2383).   

Introduction: 
Endocytosis involves movement of internalized receptors and ligands through acidified 
endosomes.  While that goes on, material in the extra-cellular medium, for which there are no 
receptors, is trapped within the forming coated-vesicle and thus is carried to endosomes and 
then to lysosomes, where it is degraded.  We will sample this pathway by means of an 
artificial substrate, fluorescent dextran (5 kDa).  A dextran is an inert carbohydrate (polymer 
of glucose, related to starch) and we use it because it is too big to cross a membrane.  Once it 
becomes swallowed into an endosome, it will remain in the lumenal space until being 
degraded by a lysosome.  Some of this cargo also might pass into sorting endosomes and be 
delivered back to the extra-cellular solution.  To make it fluorescent, the dextran is 
conjugated to tetra-methyl rhodamine (TMR).  

Along the way from endosome to lysosome the pH steadily becomes more acidic, being 
about pH 6 in early endosomes and pH 5 in the lysosomes. This acidification serves several 
purposes, including regulation of the binding of ligands to receptors.  Additionally, 
lysosomal hydrolases have acidic pH optima.  This helps neutralize these enzymes should by 
chance one of them escape into the cytosol.  
To see this pH gradient we will use a second dextran, in this case labeled with a pH sensitive 
fluorophore (FITC).  Although this molecule is most sensitive to pH between 7 and 8, its 
intensity should drop along with pH becoming more acidic.  But there is a problem, different 
values of intensity could reflect less dye or changes in pH, or both.  To control for the dye 
amount, we will incubate cells in a mixture of FITC-dextran and TMR-dextran (the latter is 
pH insensitive).  The FITC is imaged with blue excitation and the TRM imaged with green 
excitation.  By calculating the ratio of FITC to TMR signal, we will in effect normalize the 
pH-sensitive signal to the amount of dye.  
This ratio method depends on the uptake and subsequent processing of the TMR- and FITC-
dextrans being indistinguishable.  In your lab reports discuss whether you think that is likely 
to be true.  

In this module you will do two things.  You will have two coverslips which you will process 
similarly to how you processed those for transferrin.  In addition, you will have two 
coverslips that you will image while cells are alive to explore the acidification process. 
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Materials 
3T3 mouse fibroblasts on cover slips and in MatTek dishes 

TMR-dextran solution 
TMR-dextran/FITC-dextran solution 

Growth medium for rinsing and return to incubator 
Non-CO2 growth medium for immediate imaging 

1 M methylamine solution 
PBS for rinsing 

Fine forceps 
Small beakers 

Humid chamber(s) 
Glass slides 

Fixative solution (PBS plus 3.7% paraformaldehyde), and rinse buffer.  
Mounting medium 

Ice bucket 

Procedures 
1. Fixation procedure. 
For this part, you will have two coverslips.  Incubate them in TMR-dextran.  Invert the 
coverslips on the staining solution, in the humid chamber, as you did for transferrin.  Use 50 
µL of dextran solution per coverslip.  However, for dextran labeling, do the incubation at 
37˚C.  (Why?)  After 15 min, return the coverslip cell side up to the Petri dish and carefully 
rinse with 37˚C warm PBS three times.  After the last rinse, return the coverslips to the 
incubator.  After 15 min, fix coverslip 1, and after 75 min, fix coverslip 2.   Remember you 
can put the coverslips on ice if you or the hood is busy at the exact time. Imaging for these 
fixed cells is described below.  

2. Live cell procedure.  
For these, you will have live cells in MatTek dishes, allowing you to observe them directly.  
Set them both up at the same time.  Remove the growth medium, then add 100 µL of staining 
solution containing both dextrans, carefully to avoid bubble formation.  Cover and return to 
incubator.   
After about 15 min, remove dextran solution and rinse with PBS three times.  Then to dish 1, 
add 1 mL of regular medium and return to incubator.  For dish 2, add 1 mL of non CO2 
medium and begin imaging right away.   

Imaging conditions are likely to be more difficult than with fixed cells.  Photobleaching in 
particular might be worse.  The TMR signal should be strong, however the FITC signal 
might be weak, or even invisible.   
After familiarizing yourself with how the two signals behave, capture some pairs of images, 
one for TMR and the other for FITC.  Collect the two images quickly and do not move the 
cells or focus between images.  Do this for a variety of cells and focal planes.  It is fine to use 
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longer exposure for the FITC than for the TMR, as long as the exposure you select is 
constant for all the FITC images you collect.  If it happens that you must change the exposure 
time (for either FITC or TMR images), be sure to record it, and then account for it when you 
are quantifying the results.  

Next, gently add ~20 µL methylamine to the dish and mix well.  (This will produce a 
working concentration of ~20 mM methylamine.)  Allow 5 or 10 min to equilibrate and 
repeat the procedure.  This should serve to increase the FITC signal. If it does not, then try 
adding more methylamine.  Repeat the process of collecting pairs of FITC and TMR images 
under these conditions.  Finally, once the second MatTek dish has been incubated for at least 
90 min (longer is ok) remove it and repeat the steps for the first MatTek dish.  That is, collect 
some TMR/FITC image pairs, add methylamine and collect additional image pairs.  

Imaging fixed cells: Through-focal series and overall distribution    
You will repeat the through-focal series and surface/interior comparisons that you did for lab 
6.1.  In that lab you fixed four coverslips but here you fixed only two.  Refer back to the 6.1 
lab instructions to recall how to collect the required images.  For the surface focal planes, 
take images near but not necessarily at the surface of the cell.  
Remember to keep the exposure of each of the images in the through-focal series the same as 
all the rest.  It is a good idea to experiment on some tester cells to get the exposure level 
about right before committing to the real one.  Remember also that because you will process 
these images as image stacks later on, the images you take should be numbered sequentially 
so that ImageJ can read them in the correct stack order.  Be sure to use the shutter for pulsed 
fluorescence illumination to minimize photobleaching of the fluorophores.  Finally, 
remember to take a phase-contrast image at one of the focal planes to have a reference image 
for this fluorescence image series. 

Analysis 
Fixed cells:   
The analysis here follows closely what you did for lab 6.1 and may be done at home.  To get 
a visual overview of the uptake in the cells, use the through focal series and make a single 
projection image (e.g., maximal intensity) and 3-D projection image.  To quantify the uptake, 
measure spot power for spots near the surface and in the interior.  

In your write up, compare the data you get for the dextran with that for transferrin.  Are they 
different?  In what way?  Do these data agree with or contradict what you read in the 
introduction to these two units?  

Living cells:   
Here, the ultimate goal is to determine whether you can detect a pH gradient.  You will do 
this qualitatively and quantitatively.   

Qualitative analysis 
Start out qualitatively by making a “merge” image.  You have done this already in other 
modules.  With red and green fluorescent probes as you have in this experiment, it is standard 
to put the red fluorophore (TMR dextran) in the red channel and the green fluorophore 
(FITC-dextran) in the green channel, leaving the blue channel turned off.  To do this, open 
the two images in ImageJ, then select “Image>Color>RGB merge…”.   Here, it might be 
necessary to increase the gain/contrast of the FITC image.   
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Inspect the merged image.  Are all of the spots yellow (that is, red + green)?  Or are there 
some only red ones?  And some only yellow ones?  What do you learn from this?  After the 
long time incubation (90 min or more), are there some spots that look a little more yellow 
than others? 

Quantitative analysis 
For quantitative analysis, you will obtain ratio data.  Although there are software tools to do 
this automatically, you will do it by hand to get an understanding of what is going on.  Open 
both members of an image pair (TMR and FITC). Use the marquee tool to encircle a spot (as 
for lab 6.1 measuring spot power).  Then copy the ROI to the FITC image (your instructor 
will provide you with the software shortcut to do this).  Measure the average intensity for 
each spot. Note that in imageJ, hitting the measure key once should record the intensities 
inside the ROI in both of the images (TMR and FITC).  Also obtain background intensities, 
at least one per image, and more if the background seems to vary.  Measure as many spots in 
as many image pairs as you can.   
After measuring, calculate the ratio as: (IFITCspot – IFITCback)/(ITMRspot – ITMRback), where IFITCspot 
is the intensity of a spot in the FITC image, IFITCback is the background intensity for that 
image, ITMRspot is the intensity of the same spot in the TMR image, and ITMRback is the 
background intensity for that image. 
Compare the ratios between edges and interior regions of the cell.  Is there any systematic 
difference?  What can you learn from this?  What about the methylamine treated cells?  Does 
the ratio change?  What does that mean? 

Clean-up 
Anything with cells on can go in the biohazard container to be autoclaved, or be bleached 
and left in the fume hood to dry.  Nothing containing bleach should go in the autoclave! 

Leftover buffer or medium can go down the drain. 



Unit 5:  Endocytosis 99 

Lab 5.3:  Transport of Endosomes Along 
Microtubules 

Goal for this lab:  
To follow the movement of transferrin-containing vesicles as they are transported along 
microtubules in living cells. 

Pre-lab homework 
Read about receptor-mediated endocytosis and other forms of internalization in Alberts’ 
Molecular Biology of the Cell, available free online from the National Institutes of Health 
(http://www.ncbi.nlm.nih.gov/books/bv.fcgi?rid=mboc4.section.2383).   

Introduction:   
You will continue with examination of receptor-mediated endocytosis in this lab module.  
Last time you examined the different fates of internalized dextran and transferrin, which are 
processed through the degradative and recycling pathways, respectively. 

Endosomes are transported along microtubules.   A motor protein, dynein, that is bound to 
the endosome membrane, interacts with microtubules to pull anything associated with it, like 
the endosomes, along the microtubules toward the microtubule minus ends (Figure 22). 

 
Figure 22.  Endosomes containing receptors and their ligands move along microtubule tracks 
(blue) due to the action of a microtubule-specific motor protein that hydrolyzes ATP and, in 
doing so, produces movement along the microtubule.  The association of the endosome and the 
microtubule breaks on occasion, causing the movement of the endosome to be jerky.  This type 
of motion is termed saltation. 

The movement of the endosomes along microtubules is not continuous or smooth.   Rather, 
the motion occurs stepwise, with a run for a number of seconds followed by a pause. The 
interpretation of this motion is that the minus-end directed motor dynein becomes detached 
from the microtubule (thus stopping the movement), and a second microtubule motor, 
kinesin, overcomes the dynein motor.  Kinesin moves along microtubules in the opposite 
direction compared to dynein.  Kinesin and dynein are illustrated in Figure 23. 
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Figure 23.  Bidirectional Vesicular Transport 

In this module you will use the LLC-Pk1 cell line that expresses the GFP-tubulin fusion 
protein.  You will label live cells and view the cells live.  The goal is to observe the motion 
of endosomes by using time-lapse imaging.  You will follow that observation with an image 
of the microtubule distribution (from the GFP-tubulin fluorescence) to determine if the 
motion of the endosomes is indeed along microtubule tracks.  You will treat cells with the 
microtubule depolymerizing drug nocodazole to see if that stops endosome movement. 

Materials 
LLC-Pk1 pig epithelial cells expressing GFP-tubulin on MatTek cover slip bottom dishes 
(see page 74.) 

Transferrin in HBS plus 1 mg/mL BSA (HBS-BSA). 
Transferrin in Fe-HBS-BSA 

TMR dextran in non-CO2 medium 
HBS-BSA plus 1 µM nocodazole (to depolymerize microtubules) 

Procedures 
This lab module is a bit more free form than previous labs.  Your goal is to observe in these 
living cells the motion of endosomes as well as to see whether endosomes are moving along 
microtubules.  You should examine at least one coverslip with labeled endosomes and at 
least one coverslip that has labeled endosomes and is treated with nocodazole to 
depolymerize the microtubules.  You have three coverslips for experiments.  You can chose 
to do what you want with the third coverslip.  We are providing both TMR-dextran and 
Alexafluor-transferrin to label endosomes.  The microtubules are labeled with GFP making it 
straightforward to image microtubules in one channel and TMR-dextran endosomes in the 
other.  In contrast, Alexa-fluor and GFP will light up with the same cube.  This might make 
resolving the endosomes and microtubules difficult.  However in favorable regions of the cell 
(few microtubules) it might make the co-localizations easier.  Try and see.  

Ligand binding 
Get a Petri dish and label the lid so you can keep track of your cells.  Remove the cell growth 
medium and rinse 3× with HBS/BSA.  Remove the last rinse as completely as possible.  You 
can even gently wipe the plastic part of the Petri dish with a Kimwipe to get the remaining 
solution.  Be very carful to avoid wiping the cover slip inside the petri dish.  Doing so will 
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remove all the cells.  Immediately after the last rinse is removed, add labeling solution.  
Don’t let the cells dry out! 

For labeling with dextran, with the growth medium removed, apply ~100 µL of the TMR-
dextran labeling solution to the well formed by the cover slip and the cutout in the Petri dish.  
Without tipping the Petri dish, replace its lid and incubate it at 37 °C for at least 10 min.  
Longer times will lead to more endosomes and possibly even lysosomes to view.  Then, 
carefully rinse the cells 3× with HBS/BSA, leaving the last rinse (about 1 mL in volume) in 
the Petri dish.  You can now observe the cells. 

For labeling with transferrin, proceed as above for the dextran, only in this case, it is not 
necessary to rinse the coverslip.  Note that for lab 6.1, you labeled cells with transferrin on 
ice, but it should be done at 37˚C for this lab.  

Nocodazole treatment 
You will treat cells with nocodazole to depolymerize microtubules. Label the endosomes as 
in the previous section (using the same conditions).  Remove the labeling solution or growth 
medium and add ~1 mL of HBS/BSA containing nocodazole.  Incubate at 37˚C for at least 
15 min. At that point you can proceed with imaging of these cells.  Leave the 
nocodazole/HBS solution on the cells for the whole experiment to keep the microtubules 
depolymerized. 

All groups: imaging 
The goal of this lab is to follow the dynamic motion of endosomes.  The movements are 
generally too slow to be seen by eye.  You will need to take time-lapse image series to 
observe endosome motion.  Trial and error will be needed to find a time interval between 
frames that is long enough to show movement but not too long to blur the details of the 
motion (saltations).  Another aspect of the experiment is to determine if the motion of the 
endosomes is along microtubules.  You should take an image of the GFP-tubulin distribution 
(blue excitation/green emission) before or after (or both!) the endosome time-lapse series to 
reveal the microtubule distribution.   

Uninhibited cells 
Find a region in a cell clump that has a good number of endosomes.  To reduce 
photobleaching and to make file sizes smaller, you probably should use 2× or 4× binning.  4× 
might not have the resolution you will need.  You should determine this for your selection of 
objective lens by taking preliminary images at 1× and higher binning to be sure you can see 
what you need to see with the higher binning. 
Take time-lapse images of the endosomes.  Some will move about 10 µm in 30 sec.  Many 
will move much less than that distance.  Thus, you will want to take images frequently 
enough to capture fast motion but to take images over enough time that you can see several 
endosomes move.  You might try to take an image series with one image every 10 sec for 5 
min (i.e. 31 images).  Play this back and check.  If that is unsatisfactory or you want a 
different time resolution, try to take images more frequently or for longer times.  Remember 
that photobleaching might well limit the total number of images you can take.  You should 
use pulsed illumination by using the computer-controlled shutter to minimize the exposure to 
excitation light. 

Don’t forget to get images of GFP-tubulin in the same focal plane as each endosome 
movement time-lapse series.  
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End up with a few movies of moving endosomes and companion images of microtubules.  
Ideally, you will see several endosomes moving at different speeds in different directions.  
Some should move, stop, move, stop, etc.  Some should change direction from time to time. 
A difficulty in this experiment is that the cell is a 3D object, but you are limited to a 2D focal 
plane.  Some of your endosomes will move out of focus and some will move in.  It is ok to 
refocus during a movie.  Be sure to capture the microtubules in the re-focused plane. 

Inhibited cells 
Repeat the imaging you did on uninhibited cells.  In the case of nocodazole-treated cells, you 
will find few or no microtubules that remain intact.  Image the microtubule channel anyway 
so its status can be ascertained.  Often there are residual microtubules. Again take some 
movies of endosomes.  Use similar time-lapse parameters as for the controls.  

Analysis 
Make movies of your endosome time-lapse series.  (This can be done at home). 

• File>Import>Image sequence… gets the image sequence into a single image stack in 
ImageJ. 

• File>Save As…>AVI converts the sequence into an .avi format movie. 

• File>Save As…>Quicktime movie converts the sequence into a .mov format movie. 
Make “merge” images of endosome motion overlaid on microtubule tracks.  You can do this 
by choosing two “good” example images of endosomes showing altered endosome 
distribution and putting them into the red and blue channels of a merge image.  You can put 
the GFP-tubulin image into the green channel.    

Observe the motion.  Does it fit with motion along microtubules?  Why or why not?  What 
happens with nocodazole?  Do the movements in this case also fit with the idea that 
endosomes move on microtubules?  Why or why not?  Finally, if you also observed 
transferrin labeled endosomes, did you detect any difference in the motility between them 
and dextran-labeled ones? 

Clean-up 
MatTek dishes can be thrown in the biological waste container to be autoclaved, or sterilized 
with 10% bleach and left in the fume hood to evaporate.  Nothing containing bleach should 
go in the autoclave! 
Anything that may have contacted cells or solutions exposed to transferrin (Petri dishes, 
gloves, Parafilm, tips, etc.) should be placed in the biohazard bag for autoclaving. 
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UNIT 6:  CELL SIGNALING 
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Lab 6.1:  Cellular Responses to External Stimuli 
Goal for the module 
To measure cellular responses to external signals using fluorescent indicators.   

Pre-lab homework 
Read about G-protein-linked receptor signaling, particularly activation of phospholipase C, in 
Alberts’ Molecular Biology of the Cell, available from the National Institutes of Health at: 

http://www.ncbi.nlm.nih.gov/books/bv.fcgi?highlight=signaling&rid=mboc4.section.2794 

Introduction 
This module examines communication of a cell with its extracellular environment.  There are 
many ways in which this occurs though one theme is nearly uniform: an extracellular 
molecule arrives at a cell, binds to a receptor (either on the cell surface or inside the cell), and 
activates the receptor to begin a series of steps that leads to a response.  The cellular response 
can range from immediate (for example, the increase in contraction frequency of a cardiac 
muscle cell when exposed to adrenaline) to delayed (for example, the expression of a set of 
genes in an epithelial cell hours after a growth factor arrives at the cell location). 

In the experiments for this module, we will focus on rapid cell responses.  In particular, we 
will look at changes in intracellular calcium ion concentration in response to applied 
signaling molecules.  Cells use calcium ion signaling in a number of ways.  Several 
molecules are regulated by the binding of one or more calcium ions to the molecules being 
regulated.  A well-known example is calmodulin, which has two calcium binding sites and 
which dramatically changes conformation upon calcium binding.  This conformational 
change allows calmodulin to regulate other molecules.  The sequence of events that occurs, 
from ligand binding to receptor to elevation of cytosolic calcium to activation of calmodulin 
to regulation of other molecules, is typical of cell signaling: various reaction pathways are 
activated to propagate the initial message (ligand binding) via other molecules (second 
messengers). 

Cytosolic calcium is held low at a concentration near 100 nM (0.1 µM).   Activation of a 
calcium signaling receptor will cause the concentration in the cell to rise transiently by a 
factor of 20 or so.  This rise occurs in two ways: influx of extracellular calcium through ion 
channels in the plasma membrane or release of stored calcium from intracellular organelles. 
Labs 7.1 and 7.2 will look at receptor-mediated release of calcium ion from intracellular 
stores and influx of extracellular calcium via calcium-carrying molecules that we will insert 
artificially into the plasma membrane. 
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The most common mechanism by which calcium ion release from intracellular stores occurs 
involves a 6-step sequence, depicted in Figure 24. 

1. Ligand (signal molecule in Figure 24) binds its receptor to activate it 
2. Activated receptor causes a G-protein to disassemble into α and βγ subunits 
3. The Gα subunit activates phospholipase C (PLC) 
4. PLC hydrolyzes phosphatidylinositol 4,5 bisphosphate (PIP2) to inositiol 1,4,5-

trisphosphate (IP3) and diacylglycerol (DAG) 
5. IP3 diffuses to the endoplasmic reticulum (ER) where it binds to IP3 receptors 
6. IP3 receptor channels open, releasing Ca2+ from the ER lumen to the cytosol. 

 
Figure 24.  The release of calcium ions from intracellular stores (the endoplasmic reticulum) is 
mediated by IP3 that is produced subsequent to the activation of a cell surface receptor.  In this 
scheme, the receptor activates a G-protein that activates the β  isoform of PLC.  In some other 
receptor systems, the receptor directly activates a different isoform of PLC but the rest of the 
pathway remains the same.  (Figure 15-36 in  Alberts, et al, 2002, Biology of the Cell, 4th edition, 
Garland Science, reproduced with permission.) 

The opening of the IP3 receptor in the ER membrane allows the high concentration of 
calcium in the ER lumen (where it is at high micromolar concentration) to flow down its 
concentration gradient to the cytoplasm, where its resting concentration is about 0.1 µM.  
The very low concentration of calcium in the cytosol is maintained by calcium pumps 
powered by ATP hydrolysis that move calcium from the cytosol to the ER or to the 
extracellular solution as well as ion exchangers that use other ion gradients to power calcium 
flux from a low concentration region (the cytoplasm) to high concentration regions.  These 
processes are shown in Figure 25.  
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Figure 25.  (Left)  Various Ca2+ pumps, powered by ATP hydrolysis, move Ca2+ from the 
cytoplasm to the extracellular solution or to the ER.  Ion exchangers also move Ca2+ against its 
concentration gradients by tapping into the energy contained in ion gradients of other ions like 
K+ and Na+.  (Right)  The transient elevation of [Ca2+]i via activation of plasma membrane 
Ca2+-permeant channels or ER membrane Ca2+-permeant channels can occur because the 
influx pathways overpower the pump and exchanger Ca2+ pumping.  As the channels are 
inactivated, [Ca2+]i returns to its resting level.  (Taken from Clapham, “Calcium Signaling”, 
Cell 131:1047-58, 2007, reprinted with permission) 

The ability of cells to import and export calcium allows cells to respond to external signals 
with transient rises in cytosolic calcium allowing for transient regulation of calcium-
dependent processes.  A transient rise in cytosolic calcium can have different time signatures.  
It can be a single rise and fall, or it can be oscillatory.  The latter involves negative feedback 
loops in which elevated cytosolic calcium shuts down calcium influx temporarily, allowing 
pumps and exchangers to drop cytosolic levels, thus turning off the negative feedback and 
allowing the process to repeat.  Different ligand/receptor combinations show different 
patterns of calcium signaling.  An example of a ligand that induces cytosolic calcium 
oscillations is vasopressin, which applied to hepatocytes causes oscillation in a 
concentration-dependent fashion (Figure 26). Notice that in this case, the oscillations occur in 
the presence of a constant level of stimulant. 
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Figure 26  Vasopressin, which regulates water retention by the kidney, binds to its receptor 
that is expressed in a number of different cell types.  Activation of the vasopressin receptor in 
liver cells causes calcium oscillations, the frequency of which are proportional to the 
concentration of vasopressin.  Note the time course.  The duration of a single calcium spike is of 
the order of 30-60 sec.  (Taken from Woods, Cuthbertson and Cobbold, Nature 319:600–2, 
1986, reproduced with permission.) 

We will use a derivative of fluorescein, fluo-4, in this lab.  Fluo-4 binds tightly to calcium, 
and when it does so its fluorescence quantum efficiency increases by about 100 fold.  Thus, 
increases in cytosolic calcium cause fluo-4’s fluorescence to increase, allowing us to detect 
calcium ion concentration rises within cells.  To accomplish this, the fluo-4 must be trapped 
inside the cells.  We do this by adding a modified fluo-4 that easily crosses the cell 
membrane.  Inside the cell, this modified fluo-4 is converted to active fluo-4, which is 
trapped there due to its negative charge.  You can read about fluo-4 at the Molecular Probes 
website (http://probes.invitrogen.com/media/pis/mp01240.pdf).   

In this module you will use fluo-4-loaded cells to measure cytosolic calcium transients 
caused by activation of different cell surface receptors that signal through G-proteins.  On the 
first day you will learn how to stimulate cells and obtain the response of cells to different 
stimuli.  On the second day of the module, you will explore the mechanisms by which 
calcium signals propagate in cells. 

Materials 
3T3 mouse fibroblasts on MatTek cover slip bottom dishes 

Fluo-4/AM at 2 µM in HBS plus 0.02% Pluronic F-127 (a surfactant) 

10 µM ATP in HBS 

2 µM bradykinin in HBS 

10 nM vasopressin in HBS 
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Procedures 
You will be stimulating cells with ligands that bind to G-protein-coupled receptors in 3T3 
cells.  ATP binds to purinoceptors, bradykinin binds to bradykinin receptors and vasopressin 
binds to vasopressin receptors.  You will follow the cytosolic calcium increase in the cells by 
measuring the increase in fluo-4 fluorescence. 

Loading cells with fluo-4 
Obtain a MatTek dish with cells.  Remove the medium and add ~250 µL of the fluo-4/AM 
loading solution.  (This is plain buffer plus 2 µM fluo-4/AM plus a little bit of surfactant to 
keep the fluo-4/AM dispersed.  As discussed before class, the cells convert the fluo-4/AM to 
fluo-4 which remains trapped in the cells.)  Incubate the cells in the loading solution for 20 
minutes at room temperature.  Keep them out of bright light to minimize photobleaching of 
the fluo-4.   
After the 20 min loading period, rinse the cells 3× with HBS.  For the last rinse, leave the 
cells in precisely 750 µL of HBS.  The reason for this is that you will be adding the same 
volume of stimulant solution at 2× strength, so that the dilution will bring the stimulant to 
proper concentration (see Figure 27).  When you have the cells rinsed, practice adding 
solution until you can confirm that no focus drift is occurring when you make the 
addition. 

Checking for focal drift 
The fluo-4 dye increases its fluorescence intensity as cytosolic calcium increases.  You will 
use this increase to measure the calcium signal in stimulated cells.  Because fluorescence 
intensity decreases as a region goes out of focus, it is important to confirm that the 
manipulations you do to stimulate cells do not throw off the microscope focus.  The first 
thing to do is to test the system with a sham addition (just plain HBS buffer).  The goal is to 
show that the fluorescence of the cells doesn’t change during a time lapse sequence when 
you add solution to the Petri dish.  Figure 27 illustrates the proper technique for adding 
solution to the dish. 
Using a 10× or 40× lens, find an area with cells (blue excitation for the fluo-4).  40× is better 
if you can find a field of view with at least 5 cells.  Set up the microscope to take a time lapse 
sequence, 61 images at 2 sec between images.  You should use 2×2 or 4×4 binning to reduce 
the amount of data that you will be collecting and storing.  Of course you need to use the 
computer-controlled shutter to reduce photobleaching during the time lapse sequence. 

Get a 750 µL aliquot of HBS in a small tube and a Pasteur pipette with bulb or 1000 µL 
pipettor prior to starting the time lapse.  One of the partners should be the designated “adder” 
while the other partner should be the designated “timekeeper” to keep the solution additions 
consistent for subsequent experiments.  The adder should get ready for addition by 
positioning the pipette tip and tube with solution near the Petri dish.  When ready, the 
timekeeper should start the time lapse.  The solution should be added between image 
collection frames.  The adder will have less than 2 seconds to do this.  Let a few images be 
collected prior to addition for a baseline fluorescence measurement.  Add the 750 µL of HBS 
after a few frames, say between frames 10 and 11 (Figure 27).  The timekeeper should write 
down the actual addition interval and also write down any relevant information (such as 
“solution was added 1 sec after end of frame 10” or “solution addition continued during 
collection of frame 11”).  Once the solution has been added, sit back and wait for the time 
lapse collection to finish. 
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Figure 27.  When adding solutions to the Petri dish on the microscope while taking data, be 
sure to avoid bumping the dish or causing the cells to move.  Add solutions slowly enough that 
you don’t cause Petri dish motion, but fast enough that you can get the full volume added 
between images.  Do not blast the solution in to the Petri dish.  Don’t put the solution in on top 
of the cover slip as that will quite likely cause some cells to detach from the cover slip. 

For your practice runs, check to be sure that the fluo-4 fluorescence didn’t change after the 
solution addition.  Open the time-lapse sequence into an image stack (File>Import>Image 
sequence…).  Use the Multi Measure plugin to measure fluorescence from a cell 
(Plugins>Multi Measure).  Draw a region of interest, add it to the Multi Measure panel, select 
it in Multi Measure and click “Measure”.  If the Mean value remains constant ± ~5% for the 
whole image sequence, your addition protocol is OK.  If you get a clear drop or rise in the 
fluorescence average after the solution addition, then you need to work on your addition 
protocol.  Remove the 750 µL of buffer that you added and repeat the process until you can 
get a flat fluorescence response.  If you are in doubt about what qualifies as “flat”, ask an 
instructor. 
Save this control addition image data set for the lab report.  Even if your hands are steady 
and you can add solution without disturbing your focal plane, it is still important to record a 
time-lapse sequence for control cells.  

Stimulation experiments 
You will do at least three experiments (you can do more if there are extra cells available) in 
which you stimulate fluo-4-loaded cells with one of the three ligand solutions.  All groups 
should use undiluted 10 µM ATP for the first stimulation.  After that, you can choose what 
stimuli and concentrations you want to use.  Each group should choose different stimuli for 
subsequent experiments.  We will compare results of these different experiments at the end 
of the second day of this module.  There will be a sheet with the three different ligands listed.   

• The first addition will be 750 µL of 10 µM ATP for all groups. 

• The second addition should be for another ligand, bradykinin or vasopressin, at a 
concentration not already used by any group. 

• The third addition should be for any of the 3 ligands, at a different concentration than 
your previous trial. 

Start with fluo-4-loaded cells.  Be sure that there is 750 µL of buffer in the Petri dish (so that 
the additions are all consistent one to the next).  Use a 10× or 40× lens.  You need to have 
enough fluorescence signal to take an image series without much photobleaching, so the 10× 
lens might not have a large enough NA.  You’ll just have to see what works for you.  Find a 
nice group of cells, preferably with 5 or more in the field of view.  (The cells are all 
individuals, and will respond differently to the same stimulus.  This is best seen when there 
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are lots of cells to observe.)  Set up the imaging so that you are using 2×2 or 4×4 binning.  
You want the image exposure time to be a lot less than the 2 sec interval between images for 
timelapse collection.  Pay very close attention to the image brightness.  Remember that the 
fluo-4 will get a lot brighter as [Ca2+]i increases.  The brightest pixels in the image may be as 
much as 100 times brighter.  Because the camera saturates at a signal of 4095, you should 
keep the maximum pre-stimulus fluorescence signal at 400 or below.  (The maximum camera 
signal value can be found at the lower right in the Micro-Manager window.)  If you have 
questions about this, ask an instructor. 

Once you have the field of view and exposure selected, set up to take images for at least 4 
minutes at 2 seconds between images.  There will be 30 images per minute, so that would be 
121 images for 4 minutes.  You can see why 2×2 or 4×4 binning is useful.  These time-lapse 
sequences will generate a lot of data. 

When everything is ready, follow the system that you worked out during the control 
additions.  Note to the adder: don’t touch the pipette to the Petri dish solution or dribble the 
stimulant prior to your addition time.  Obviously that would put stimulant in the Petri dish 
sooner than you intended.  If you accidentally start adding too soon, then complete the 
addition without delay.  You might be able to rescue the data.  It won’t be any good if you 
dribble, delay, dribble, etc. as the time of addition will be impossible to determine. 

Ligand concentrations to use 
Each of the full strength solutions, when added in a 1:1 ratio with buffer in the Petri dish will 
end up at half strength.  Thus, the maximum concentration of ATP stimulating cells will be 5 
µM, for bradykinin it will be 1 µM and for vasopressin it will be 5 nM.  Other concentrations 
of these stimulants that can be used in this module are shown in the table below.  Also shown 
are the amounts of full-strength stock solutions and buffer that are needed to make up 750 µL 
of stimulus solution. 

Note:  Bradykinin and vasopressin are effective only at higher concentrations.  Additionally, 
the time from addition of the stimulant to the response differs for these reagents, with some 
eliciting a rapid response.  Take care to image quickly to capture the initial events. 

ATP bradykinin vasopressin 
Stim 
conc 
(µM) 

Add 
conc 
(µM) 

µL 
stock 

µL 
buffer 

Stim 
conc 
(µM) 

Add 
conc 
(µM) 

µL 
stock 

µL 
buffer 

Stim 
conc 
(nM) 

Add 
conc 
(nM) 

µL 
stock 

µL 
buffer 

5 10 750 0 1.0 2 750 0 5 10 750 0 
3 6 450 300 0.5 1 375 375 3 6 450 300 
1 2 150 600 0.3 0.6 225 525 1 2 150 600 
0.5 1 75 675 0.1 0.2 75 675 0.5 1 75 675 
0.3 0.6 45 705 0.05 0.1 37.5 713 0.3 0.6 45 705 
 

Analysis 
You need to measure the change in fluo-4 fluorescence for all the cells in each time lapse 
sequence for each of the above experiments including the control, buffer-only addition.  The 
MultiMeasure ImageJ plugin works well for this type of analysis.  You will need to get the 
average fluo-4 fluorescence, which means that you need to subtract a cell-free average 
background from the raw cell fluorescence averages, just as you have done for other cell 
fluorescence measurements.  These you will put into a spreadsheet like Excel and plot as a 
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fluo-4 fluorescence vs. time plot.  From these you will extract the time from stimulus 
addition to the start of the response and the time from stimulus addition to the peak of the 
first calcium transient.  The timekeeper should have a record of the time when the solution 
was added to the cells.  For example, if the solution was added starting 1 sec after frame 10 
and took 1 sec to add, the time of addition would be the time at which frame 10 was taken 
plus 1.5 sec (1 sec delay time to start the addition plus 0.5 sec for the midpoint of the solution 
addition).  If frame 10 was taken at t = 18 sec, then the addition time would be at t = 19.5 sec.  
If the peak of the first calcium spike occurred at frame 17 where t = 36 sec, then the delay 
from addition to first peak is 36 – 19.5 = 16.5 sec.  
Some data that you will extract from the image analysis for the lab report will include  

• Average time to first peak for responding cells 

• Fraction of cells that respond to a stimulus 

• Relative increase in fluo-4 signal at the peak of the response (here background 
subtraction from raw fluorescence is essential) 

• Duration of initial [Ca2+]i spike 

• Frequency of oscillations, if there are any 

Clean-up 
Anything that may have contacted cells or solutions exposed to bradykinin or vasopressin 
(MatTek dishes, gloves, Parafilm, tips, etc.) should be placed in the biohazard bag for 
autoclaving or be sterilized with 10% bleach and left in the fume hood to evaporate.  
Nothing containing bleach should go in the autoclave! 

Buffer and medium can go down the drain. 
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Lab 6.2:  Release of Internal Calcium Stores 
Goal for the module 
To determine whether calcium signaling through ATP, bradykinin or vasopressin receptors is 
due to release of calcium from intracellular stores.   

Pre-lab homework 
Review the reading on G-protein-linked receptor signaling, as assigned in Lab 7.1, on 
page 105. 

Introduction 
In the previous module we examined the responses of 3T3 cells to ATP, bradykinin and 
vasopressin, observing changes in intracellular calcium concentration in response to these 
stimuli.  We did this by incorporating a calcium-sensitive fluorophore, fluo-4, into the cells 
and monitoring the fluo-4 fluorescence. 

In this module we will go into a bit more depth on the use of indicator dyes like fluo-4.  We 
will also compare the roles of release of calcium ion from intracellular stores and influx of 
calcium across the plasma membrane in the responses of cells to different stimuli. 
Consider again Figure 25 on page 107.  On the right hand side of the figure, we see that the 
calcium ion concentration in the cytoplasm, where the fluo-4 is located, can increase if 
calcium flows into the cytoplasm from the ER or from the extracellular solution.  We have 
very little control over the ER lumen solution, but we have complete control over the 
extracellular solution.  If we removed nearly all of the calcium from the extracellular solution 
and stimulated the cells, cytosolic calcium would not rise if the mechanism of calcium 
signaling were via plasma membrane channels but it would rise if the mechanism were via 
release from intracellular stores.  Thus, to determine the mechanism underlying the stimuli 
that we have used, we will do cell stimulations in calcium-free medium.  Because there is a 
little bit of calcium attached to cells and glassware, we will use a calcium chelator, EGTA, to 
bind up and hence remove nearly all of the free calcium in the extracellular solution to assure 
that we are operating at essential zero calcium. Because the receptors we will be activating 
are G-protein coupled ones that activate PLC and lead to IP3-mediated calcium release, the 
expectation is that extracellular calcium will not be required for signaling.     
To confirm that our results make sense, we will also examine the effect of application of a 
calcium ionophore, ionomycin, that carries calcium across the plasma membrane.  Ionomycin 
binds 1:1 with a calcium ion, shielding the charge of the ion from its environment.  This 
shielding allows the ionomycin-calcium complex to cross the plasma membrane, where the 
ionomycin can release the ion, thus increasing cytosolic calcium.  In the presence of 
extracellular calcium, ionomycin will cause cytosolic calcium to rise dramatically.  In the 
absence of extracellular calcium, ionomycin will have a smaller effect.  (Ionomycin will be 
able to enter cells and cross the ER membrane where it can transport some calcium into the 
cytoplasm.) 

You will continue with the experiments you did in Lab 7.1. The same ligands will be 
available as were for the previous module.  You will load cells with fluo-4 and stimulate 
them much as you did in the previous module. 
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Materials 
 3T3 mouse fibroblasts on MatTek cover slip bottom dishes 

 Fluo-4/AM at 2 µM in HBS plus 0.02% Pluronic F-127 (a surfactant) 

 10 µM ATP in HBS and Ca-free HBS 

 2 µM bradykinin in HBS and Ca-free HBS 
 10 nM vasopressin in HBS and Ca-free HBS 

 3 µM ionomycin in HBS and Ca-free HBS 

Procedures 
You will be stimulating cells with ligands that bind to G-protein-coupled receptors in 3T3 
cells.  ATP binds to purinoceptors, bradykinin binds to bradykinin receptors and vasopressin 
binds to vasopressin receptors.  You will follow the [Ca2+]i increase in the cells by measuring 
the increase in fluo-4 fluorescence. 

Loading cells with fluo-4 
Obtain a MatTek dish with cells.  Remove the medium and add ~250 µL of the fluo-4/AM 
loading solution.  (This is plain buffer plus 2 µM fluo-4/AM plus a little bit of surfactant to 
keep the fluo-4/AM dispersed.  As discussed before, the cells convert the fluo-4/AM to 
fluo-4, which remains trapped in the cells.)  Incubate the cells in the loading solution for 20 
minutes at room temperature.  Keep them out of bright light to minimize photobleaching of 
the fluo-4.   

After the 20 min loading period, rinse the cells 3× with HBS or Ca-free HBS, depending on 
the particular experiment you are doing.  For the last rinse, leave the cells in precisely 750 µL 
of buffer.  You will be adding 750 µL aliquots of stimulants to your Petri dish, and so need to 
keep volumes accurate so that you know final concentrations of materials.  

Checking for focal drift 
As in the previous module, you will be taking time-lapse images of the fluo-4-loaded cells 
and adding solutions to the Petri dishes.  If you feel the need to practice adding solutions to 
avoid focal shifts, do that now before you start with the experiments. 

Stimulation experiments 
You will do at least three experiments (you can do more if there are extra cells available) in 
which you stimulate fluo-4-loaded cells with one of the three ligand solutions.  You can 
choose what ligands and concentrations that you want to use.   You should do one pair of 
experiments using the same ligand and concentration, one in the presence of extracellular 
calcium and one in the absence.  You should do a third (or more) experiment on a different 
ligand in the absence of calcium.  In all experiments you will first stimulate with the ligand.  
After waiting an appropriate amount of time (a couple of minutes), you will do a second 
addition of the calcium ionophore ionomycin, which will facilitate the transport of calcium 
across membranes. 
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Experiment 1 
Start with fluo-4-loaded cells.  Be sure that there is 750 µL of HBS in the Petri dish (this is 
regular, calcium-containing HBS).  Use a 10× or 40× lens.  Find a nice group of cells, 
preferably with 5 or more in the field of view.  Set up the imaging so that you are using 2×2 
or 4×4 binning.  You want the image exposure time to be a lot less than the 2 sec interval 
between images for time-lapse collection.  Pay very close attention to the image brightness.  
Remember that the fluo-4 will get a lot brighter as [Ca2+]i increases.  The brightest pixels in 
the image may be as much as 100 times brighter.  Because the camera saturates at a signal of 
4095, you should keep the maximum pre-stimulus fluorescence signal at 400 or below.  (The 
maximum camera signal value can be found at the lower right in the Micro-Manager 
window.)  If you have questions about this, ask an instructor. 

Once you have the field of view and exposure selected, set up to take images for at least 4.5 
minutes at 2 sec per image.  There will be 30 images per minute, so that would be 136 
images for 4.5 minutes.  You can see why 2×2 or 4×4 binning is useful.  These time-lapse 
sequences will generate a lot of data. 

This experiment will be on a ligand you choose (ATP, bradykinin, vasopressin) at a 
concentration you choose (see the list of dilutions in the table below).  You will stimulate the 
cells first with your ligand between frames 10 and 11, or thereabouts, and then later about 45 
sec before the end of the time lapse sequence (around frame 115 of a 136 image sequence) 
with 1 µM ionomycin.  You need to get two small tubes with the correct solutions ready.  
The first is 750 µL of the ligand in HBS at its proper concentration and the second is 750 µL 
of 3 µM ionomycin in HBS.  [Note, add the ionomycin to the dish without removing any 
medium, therefore you are adding 750 µL to 1500 µL for a 3 fold dilution.] 

When everything is ready, follow the system that you worked out during the control 
additions.  Note to the adder: don’t touch the pipette to the Petri dish solution or dribble the 
stimulant prior to your addition time.  Obviously that would put stimulant in the Petri dish 
sooner than you intended.  If you accidentally start adding too soon, then complete the 
addition without delay.  You might be able to rescue the data.  It won’t be any good if you 
dribble, delay, dribble, etc. as the time of addition will be impossible to determine. 

Add the 750 µL of ligand solution at the appropriate time, wait for the signal to occur and die 
off, and then add the 750 µL of ionomycin late in the time sequence.  Because ionomycin 
will carry calcium ions across membranes and the concentration of calcium ion is high (2 
mM) in the extracellular solution, you should find that the fluo-4 signal spikes up very high 
immediately after addition of ionomycin.  Don’t add this too soon.  The response to 
ionomycin is rapid, and should peak out within 10 sec or so. 
Experiment 2 
Repeat, as closely as possible, the experiment you just did.  The only difference in this 
experiment is that all solutions are made in Ca-free HBS.  Any process that requires 
extracellular calcium will not proceed, so in this experiment you will be able to confirm (or 
not) whether your ligand and ionomycin require extracellular calcium to elevate cytosolic 
calcium.  
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Experiment 3 
Use a different ligand and repeat the second experiment (in calcium-free medium).  You 
might choose a ligand that you used in Lab 7.1 so that you have data for both calcium-
containing and calcium-free medium for two different ligands. 

Note on cell dishes 
For these experiments, you can repeat a few ligand additions on the same set of cells. 
Remove 750 µL, find a new field of cells, and add the next ligand.  However, after you get a 
movie from an ionomycin addition you will need to get a fresh dish of cells.  

Ligand concentrations to use 
Each of the full strength solutions, when added in a 1:1 ratio with buffer in the Petri dish will 
end up at half strength.  Thus, the maximum concentration of ATP stimulating cells will be 5 
µM, for bradykinin it will be 1 µM and for vasopressin it will be 10 nM.  Other 
concentrations of these stimulants that can be used in this module are shown in the table 
below.  Also shown are the amounts of full-strength stock solutions and buffer that are 
needed to make up 750 µL of stimulus solution. 

ATP bradykinin vasopressin 
Stim 
conc 
(µM) 

Add 
conc 
(µM) 

µL 
stock 

µL 
buffer 

Stim 
conc 
(µM) 

Add 
conc 
(µM) 

µL 
stock 

µL 
buffer 

Stim 
conc 
(nM) 

Add 
conc 
(nM) 

µL 
stock 

µL 
buffer 

5 10 750 0 1.0 2 750 0 5 10 750 0 
3 6 450 300 0.5 1 375 375 3 6 450 300 
1 2 150 600 0.3 0.6 225 525 1 2 150 600 
0.5 1 75 675 0.1 0.2 75 675 0.5 1 75 675 
0.3 0.6 45 705 0.05 0.1 37.5 713 0.3 0.6 45 705 
The ionomycin is at 3 µM concentration.  Adding 750 µL of this to 1.5 mL of medium in the 
Petri dish will produce a 1:3 dilution, so that the final ionomycin concentration applied to the 
cells will be 1 µM. 

Analysis 
You will measure the calcium responses under Ca-free and Ca-containing conditions just as 
in the previous module. 
Some data that you will extract from the image analysis for the lab report will include  

• Average time to first peak for responding cells 

• Fraction of cells that respond to a stimulus 

• Relative increase in fluo-4 signal at the peak of the response 

• Duration of initial cytosolic calcium spike 

• Frequency of oscillations, if there are any 

• Average time to peak for the ionomycin treatment 

• Relative increase in fluo-4 signal at the peak of the ionomycin response 

• Duration of the ionomycin-induced spike in cytosolic calcium.  



Unit 6:  Cell Signaling 117 

Clean-up 
Anything that may have contacted cells or solutions exposed to bradykinin or vasopressin 
(MatTek dishes, gloves, Parafilm, tips, etc.) should be placed in the biohazard bag for 
autoclaving or sterilized with 10% bleach and left in the fume hood to evaporate.  Nothing 
containing bleach should go in the autoclave! 
Buffer and medium can go down the drain. 
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UNIT 7:  INDEPENDENT PROJECTS 
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Lab 7.1:  Designing an Experiment 
Experimental question:  
You need to have a hypothesis, or question, that you will test, and hopefully answer, by 
performing your research.   Here are some examples: 

Cell motility:  
You observed cell motility, and made some interesting observations, but the conclusions 
were based on a small number of observations.  You can expand on this module.  For 
example, is F-actin required for the formation of ruffles at the leading edge of crawling cells?  
Does pigment granule motility in B16 cells require both microtubules and actin filaments?  
Do microtubules regulate the rate or directionality of cell locomotion?  During migration of 
cells into a wound in the monolayer, does cell density influence the speed of wound healing?  
Does cell division influence the rate of wound healing? 

Cell division:   
Taxol is used to treat cancer.  Does taxol arrest cells in mitosis? At what stage(s) are cells 
arrested?  Do arrested cells survive?   

Adhesion:   
Does adhesion to the substrate influence the rate of cell migration?  Does the number or size 
of cell adhesions change with the substrate? 

Time Frame:  
You have 6 class periods to work on your project.  Plan ahead!  Because you have 6 class 
periods, you should plan about 5 experiments, or 5 trials of your experiment.  The last period 
can be used for analysis. 

Cells:  
You will need to let one of the instructors know what cells you will need for each of these 
days.  The cells need to be plated 48 hours in advance of when you need them (so for 
Monday, you must let someone know on Friday what you need for Monday, and by 
Monday for Wednesday). 

Available cell types: 
 3T3 fibrobalsts 
  parental (non-fluorescent) 
  GFP-α-actinin expressing 
 LLC-Pk1 epithelial cells 
  Parental (non-fluorescent) 
  Expressing GFP-tubulin 
  Expressing GFP-actin 
 Drosophila S2 

 B16 melanoma cells 
 HeLa human carcinoma cells 
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Reagents:  
You need to let someone know in advance what reagents you need for each of the 4 class 
periods.   

Available reagent function 

DAPI Stains DNA 

Rhodamine phaloidin Binds to F-actin 

Mitotracker, Rhodamine 123 Stains mitochondria 

ER-tracker Stains ER 

Fluorescent transferrin (AF488-Tf) Ion transport protein: binds two Fe3+   
Antibodies to: 

tubulin 
Golgi marker 
α-actinin 
γ- tubulin 

binds to intracellular target 

Secondary antibodies binds to primary antibody, fluoresces 

Nocodazole Disrupts microtubules 
Coverslips treated with  

fibronectin,  
collagen,  
concanavalin A,  or  
poly-lysine,  

Affects cell adhesion 

Taxol Stabilizes microtubules 

Cytochalasin D, latrunculin Disrupts actin 

Bradykinin stimulates calcium mobilization 

Angiotensin vasoconstrictor 

Fluo-4 Intracellular calcium indicator 

ATP powers Ca+ pump (among other things) 

Ionomycin carries Ca+ across membranes 

Monensin Na+ ionophore 

Valinomycin K+ ionophore 
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Lab 7.2:  Our Final Meeting - Sharing your Results 
You will present your project to the class during the time scheduled for our final exam.  The 
presentation will be graded.  Each group member  needs to participate in the presentations.   
You will have 15 minutes to present your results.  We will have about 10 minutes for 
questions.  As with the Cell Cycle presentation, you should prepare a Powerpoint file that 
you can discuss.  The goal is to motivate the basis of your project, describe enough 
background to make it comprehensible to a general audience, explain your methods, show 
the results, and discuss what happened.   

It’s not necessary (or advisable) to show every last bit of data.  Usually it’s more informative 
to show an example and then summarize results from similar experiments.  Of course your 
own project has its own characteristics, so the use of images, graphs, words, tables, etc. will 
differ between presentations. 

See page 122 for some guidelines for making good slides. 
Some general guidelines for the slide show: 

1. Plan for at least 1 minute per slide.  It often goes slower than that. 
2. Avoid putting too much text on a slide.  The reader will be torn between reading and 

listening.  The slides should be the illustrations to your spoken explanation of what you 
did and what you found.  (If you have to read from a slide, you haven’t adequately 
prepared your talk!) 

3. Background information: summarize on one or two slides. 

4. Methods: briefly explain the methods that you used; can be done on a single slide.  
5. Results:  This is the most important section.  Organize your data into graphs, histograms, 

or whatever is most appropriate.  Label the axes of your graphs; provide a title for any 
tables that you generate.  You will likely need more than one slide.  Show images where 
appropriate, i.e. fluorescence of cell structures, phase images of groups of cells, overlays 
of multiple fluorophore stains, etc. 

6. Conclusions: briefly state what the data show; describe how the data support your 
hypotheses; if your experiment didn’t work, suggest an alternative approach. 
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Guide to making a good presentation 
The tl;dr version: 
Pictures!  No paragraphs!  No reading from the slide!  Labels!  Big font! 

The longer explanation: 
Why not to write out your talk on your slide: 
First of all, if you can’t give your talk without reading from your slides, you aren’t ready!  
What does this mean?  It means you need to know the material inside and out, and be able to 
tell the audience about it as if you were just having a conversation (while facing them instead 
of the screen).  Use notes to keep yourself on track, but don’t write your notes on your slides. 
Secondly, if your whole talk is written out on your slides, what is your role as the speaker?  
Either you read to the audience, which is boring, or you say different something different 
from what they are trying to read on the slide, which is distracting. 

The power of pictures: 
The main advantage to using slides over simply giving a speech is that you can show images.  
The best talks are spontaneous explanations of pictures you show your audience. 
Make the picture big!  Don’t waste valuable slide real estate with a written explanation of the 
image – it detracts from the power of the image and your ability to tell the story.   
Make the labels short and legible.  Most of the audience will be a lot farther away from the 
screen than you are.  If your label has to wrap around to the next line, reconsider its length. 
If you have a complicated experimental design, draw a diagram and walk your audience 
through it.  Harness the power of PowerPoint to bring one element up at a time, as you get to 
it in your explanation. 

Use only enough text to make your image understandable: 
Short, well-placed, easy-to-read labels make an image comprehensible. 

Short, title-like phrases are sufficient to help the audience follow your reasoning. 
Avoid taking up a huge portion of your slide with a not-so-specific word like “RESULTS”. 

The detailed figure titles necessary in print are completely inappropriate in a presentation – 
the audience can’t read it and listen to you at the same time. 

Make it big enough to read from the back of the room: 
Project your slide, walk to the back of the room, and check legibility.  If you can’t do a trial 
projection, maximize the image on your computer screen and step back from it about 6 feet. 
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Compare the following pairs of slides: 
The left slide in each pair has too small a picture (or none at all) and too much text.  The 
slides on the right, however, contain an image large enough to be seen from a distance, and 
the text (including headings) enhances audience understanding of the experiment.   

EXPERIMENTAL DESIGN 
• We obtained 40 plants, all at the early seedling stage, 

where the cotyledons were first visible above the soil. 
• We used 10 of these as controls.  They got only water. 
• 30 plants were experimental plants.  10 of these got 

nitrogen supplementation in their water (as NH4NO3 – 
ammonium nitrate – at a concentration of 10 mM). 

• Another 10 got phosphorus supplementation in their 
water (as potassium phosphate monobasic- KH2PO4 – at 
a concentration of 10 mM).   

• The last 10 got nitrogen and potassium supplementation. 
• We harvested all the plants (the above-ground structures) 

when they were 20 days old, ground them to a powder in 
liquid nitrogen, and then weighed that powder to get the 
dry weight in grams. 

• We recorded the weight of each plant, and calculated the 
averages and standard deviations, and ran a t-test. 

Fertilizer Experiment 

 
Harvest at 20 days, freeze dry, weigh 

  
RESULTS: 

As can be seen from this graph of the results of our experiment with 
fertilizer, the addition of phosphorus 
or nitrogen to the potting soil 
increased the growth of the plants at 
least two-fold.  The control plants 
were statistically smaller (p < 0.02) 
than the treated ones, as measured by 
dry weight.   

This agrees with our hypothesis.  We expected an effect at least this 
big, based on the results reported in several papers (Brown & 
Green, 2001, Farmer & Cook, 2009, Gardner & Chamber, 1999).   
Unfortunately, we were unable to test the simultaneous application 
of nitrogen and phosphorus due to a growth chamber mix-up.  We 
would have predicted, based on the same papers, that such an 
application would have produced even greater increases in plant dry 
weight. 

Fertilizer increases plant growth 

 

  
RT-PCR 

N does not affect gene expression 

 

 

Lane 1:  gDNA;  Lane 
2: Control -RT;  
Lane 3:  Control + RT;  
Lane 4: Experimental 
(Nitrogen) -RT;   Lane 
5: Experimental (IAA) 
+ RT;  Lane 6: 
Experimental 
(Phosphorus) +RT;  
Lane 7 Experimental 
(Phosphorus) -RT;  
Lane 8: Fermentas 
MassRuler, LMW 

As can be seen in this gel, our RT-PCR worked, because the lanes without RT have no 
bands, and the lane with nitrogen treatment and RT have cDNA bands.  We did not get an 
RT band for the phosphorus treated plants.  Also, there is approximately the same amount 
of cDNA in the two RT lanes, showing that our nitrogen treatment did not increase or 
decrease the amount of gene expression.  This is a surprise, because we designed this 
experiment based on several papers that suggested an effect of nitrogen on the expression 
of our gene (Brown & Green, 2001, Farmer & Cook, 2009, Gardner & Chamber, 1999). 

? 
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How to use a Micropipettor 
1. Rotate the volume adjustor to the desired setting.  Note the change in plunger length as 

the volume changes.  Be sure to properly locate the decimal point when reading the 
volume setting. (Your instructors will demonstrate.) 

2. You have three sizes of pipets in this lab:  LTS20s, which can measure between 1 µL and 
20 µL; LTS200s, which can measure between 21 µL and 200 µL; and LTS1000s, which 
can measure between 200 µL and 1000 µL (1 mL). 

There are three numbers on the display of each pipettor.  Look at the top of the pipet to 
see which one you are holding, then look at the display.  The numbers represent volumes 
as shown below.  The color change represents crossing the decimal place or changing 
units. 

SL 20   SL 200   SL 1000   
1 10  µL 1  100  µL 1 1000 µL = 1.0 mL 
0 1 µL 0 10  µL 0 100  µL 
0 0.1  µL = 100 nL 0 1  µL 0 1  µL 

3. Firmly seat a proper-sized tip on the end of the micropipettor.  The tips boxes are color-
coded to match the label on the plunger. 

4. When withdrawing or expelling fluid, always hold the tube firmly between your thumb 
and forefinger, keeping it nearly at eye level to observe the change in the fluid level in the 
pipet tip.  Do not pipet with the tube in the test tube rack or have another person hold the 
tube while you are pipetting. 

5. Hold the tube in your hand during each manipulation.  Open the top of the tube by 
flipping up the tab with your thumb.  During manipulations, grasp the tube body (rather 
than the lid), to provide greater control and to avoid contamination of the mouth of the 
tube. 

6. For best control, grasp the micropipettor in your palm and wrap your fingers around the 
barrel; work the plunger (piston) with the thumb.  Hold the micropipettor almost vertical 
when filling it. 

7. Notice the friction “stops” on the two-position plunger with your thumb.  Depressing to 
the first stop measures the desired volume.  Depressing to the second stop introduces an 
additional volume of air to blow out any solution remaining in the tip.   

8. To withdraw the sample from a reagent tube: 
a. Depress the plunger to first stop and hold it in this position.  Dip the tip into the 

solution to be pipetted, and draw fluid into the tip by gradually releasing the 
plunger.  Be sure that the tip remains in the solution while you are releasing the 
plunger. 

b. Slide the pipet tip out along the inside of the reagent tube to dislodge any excess 
droplets adhering to the outside of the tip.  To avoid future pipetting errors, learn to 
recognize the approximate levels to which particular volumes fill the pipet tip. 

c. If you notice air space at the end of the tip or air bubbles within the sample in the tip, 
carefully expel the sample back into its supply tube.  Collect the sample at the bottom 
of the tube by pulsing it in a microfuge. 
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9. To expel the sample into a reaction tube: 
a. Touch the tip of the pipet to the inside wall near the bottom of the reaction tube into 

which the sample will be emptied.  This creates a capillary effect that helps draw fluid 
out of the tip.  

b. Slowly depress the plunger to the first stop to expel the sample.  Depress to second 
stop to blow out the last bit of fluid.  Hold the plunger in the depressed position. 

c. Slide the pipet out of the reagent tube with the measurement plunger depressed, to 
avoid sucking any liquid back into the tip. 

10. Use the ejector button (located at the back and different from the plunger) to remove the 
tip into a waste container. 

Important pipettor don’ts: 
• Never rotate the volume adjustor beyond the upper or lower range of the pipet.   
• Never use the micropipettor without the tip in place; this could ruin the piston.  Pipettors 

use disposable plastic tips.  Every molecular biology lab circulates its own version of the 
story of the not-too-bright grad student who did not use a tip.  Do not be this student! 

• Never invert or lay the micropipettor down with a filled tip; fluid will run back into the 
piston. 

• Never let the plunger snap back after withdrawing or expelling fluid; smooth motions are 
the key to success. 

• Never immerse the barrel of the micropipettor in fluid.  Only the disposable tip touches 
the liquid.   

• Never reuse a tip.  Tips are pretty cheap (about $0.59 per rack).  The risk of cross 
contaminating your solutions is too great to get tricky with tips.  Just use a new one every 
time unless there is no possibility of cross contamination—like if you are pipetting the 
same solution into multiple empty tubes. 
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Passaging Cultured Cell Lines by Trypsinization 
Introduction 
In previous labs, the instructors prepared cells for your use.  Here we explain how to 
maintain mammalian cells in tissue culture and prepare them for use in experiments.   

Cells derived from various animals, plants, and insects can be propagated in tissue culture.  
Cells can grow in suspension (floating in solution) or attached to surfaces.  In this lab, we 
will grow mammalian cells that are adhesion dependent and will not grow without attaching 
to a surface.  The plastic dishes that we use are specially treated to support cell growth and 
attachment.   Cells in culture require nutrients to support their growth.  In most cases, tissue 
culture medium consists of nutrients (amino acids, sugars etc) and serum (the fraction of 
blood that is obtained after blood cells clot and are removed by centrifugation).  Serum 
contains factors necessary for cell growth, including hormones, vitamins and proteins.   
Although some medium formulations that do not require serum are available, most scientists 
supplement their culture medium with serum for optimum cell growth.  

In this lab, you will work with a cell line, LLC-Pk1, which can be continually propagated in 
culture.  Cell lines are derived from primary cultures, cells that are obtained when a tissue is 
dissociated, and the cells placed in culture for the first time.  Most cells in primary culture 
stop dividing after several passages, a phenomenon called ‘replicative senescence’.   
However, some cells become capable of indefinite growth in culture, provided that the proper 
conditions are maintained, a phenomenon called ‘immortalization’.  LLC-Pk1 cells are an 
immortalized cell line.  Immortalized cells maintain the need for serum and a substrate to 
grow, and are therefore distinct from transformed cells, which can grow in the absence of 
serum and can continue to grow when the surface is full (adhesion independent growth).   
Transformed cells are often genetically unstable.    

Many cell lines can be obtained from the American Type Culture Collection (ATCC).  Their 
web site has information about many aspects of cell growth and culture 
http://www.atcc.org/Home/tabid/57/Default.aspx. 
At the end of this lab period, you will have learned to passage a culture of mammalian cells 
and to prepare these cells for use in experiments.  Be sure to check your cultures in the next 
24 hours to examine their morphology and to check for any contamination. 

Asceptic Technique 
The world is a dirty place.  Bacterial and fungal spores are shedding from our skin, wafting 
on the breeze, and collecting on surfaces.   

In order to protect our cultures from these ubiquitous contaminants, we grow our cells in 
sterile medium; that is, the medium the cells grow in, as well as the buffer they are washed 
with, has been forced through a sterile filter with 0.2 µm pores into a sterile container.  All 
glass- or plastic-ware the cells come in contact with (e.g., pipettes, culture flasks, centrifuge 
tubes, cover slips, etc.) has been sterilized, either with gamma radiation or in an autoclave.   
In addition, every time we transfer cells or liquid that may contact cells, we do it aseptically, 
in a biological safety cabinet.  This is a contained work area which supplies a constant flow 
of filtered (and hence sterile) air from the back of the hood, over the work surface, then down 
at the front.  The direction of the air flow prevents outside contaminants (especially those 
falling off your skin and clothing) from wafting in on the breeze.  As long as you don’t touch 
it or wave your hands over it, a sterile container can be left open in the hood without 
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compromising its sterility.  During the course of this semester, you will learn how work in 
this cabinet. 

For experiments with fixed cells, or short-term experiments with live ones, it is not necessary 
to maintain sterility.  But any time cells are kept for more than a few hours, we must prevent 
contamination. 

Procedure 
All manipulations of cultured cells must be carried out asceptically.  Sterile technique is 
described on page 127. 

1. Examine the cells in the dish or flask for morphology, density, and contamination.  Use 
the inverted tissue culture microscope for this purpose.  It has 10× and 20× objective 
lenses and is equipped for phase contrast. 

2. Spray and wipe all surfaces of laminar flow hood and all bottles and containers with 70% 
ethanol.   

3. Remove the growth medium (using a 5mL pipette, or a Pasteur pipette) and discard in 
waste bucket; wash flask/dish once with warm 1× PBS. 

4. Remove PBS (to waste bucket) and add trypsin solution (0.25%) (~1 mL/small sized 
tissue culture flask is sufficient). 

5. Incubate ~3 minutes in incubator at 37°C 
6. Check for detachment of cells by observation using the tissue culture microscope; tapping 

the dish will help to dislodge the cells. Place cells back in incubator if not detaching and 
check again in 1-2 minutes.  Do not leave cells in trypsin for long periods or the cells will 
not survive. 

7. When the majority of the cells have detached, add 5 mL of growth medium to the flask 
and re-suspend cells by pipetting up and down for several times. Avoid bubbles. Transfer 
cells into 15 mL sterile conical centrifuge tube. 

8. Pellet cells by centrifugation (~5 min at 1000 rpm in a clinical centrifuge). 
9. Remove supernatant and add 10 mL fresh medium to the cells. 

10. Re-suspend thoroughly, but gently, by pipetting up and down 10 times. Be careful not to 
pull medium up into the cotton plug of the pipette, or to suck air into the pipette. 

11. Transfer appropriate aliquots into new dishes according to the split ratio desired 
(1:3 =  3.3 mL; 1:5 = 2 mL; 1:10 = 1 mL; 1:20 = 0.5 mL; etc.).   (note if you resuspend 
the cell pellet in step 9 with less than 10 mL of medium, simply adjust these dilutions).  

12. Add additional medium to the dishes to bring to appropriate amounts (3.5 cm diameter 
dish = 2 mL total volume; 6 cm diameter dish = 5 mL total volume; 10 cm diameter dish 
= 10 mL total volume).  Prevent bubbles and do not let the culture medium contact lids of 
dishes! 

13. Re-suspend cells homogenously by carefully “rocking” dishes or pipetting (a Pasteur 
pipette works well). Be careful not to spill any medium. If necessary, wipe dishes clean 
with 70% ethanol; check cells by microscopic observation and place in incubator. 

14. Check cells periodically over the next few days to check for growth, confluency, 
morphology, and contaminations. 
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Laboratory Report Format  
General 
Lab reports are to be handed in on paper at the assigned date during class. Electronic copies 
will not be accepted. We expect you to take pride and a professional attitude. Reports handed 
in with coffee stains, poor legibility, badly reproduced figures will lose points.  
For additional reading, there is a very nice web site “How to Write Lab Reports for Biology” 
at the Union College Biology Department web site: http://www.union.edu/ 
PUBLIC/BIODEPT/ResearchReports.html. 

However, should there be a conflict between what is given there and here, follow what is said 
here.  

Plagiarism 
DO NOT PLAGIARIZE!  Even the use of a phrase from a publication or the Internet 
without quotation marks and citing the reference is considered plagiarism. Be especially 
careful in cases when you write your passages immediately after reading information on the 
topic in a book or on the Internet.  Also, be careful when you and your lab partner are 
working together. While you both have the same data, the ideas and words presented in the 
lab report must be your own.  A student who plagiarizes on their lab report will get zero 
credit for that assignment and might be reported to the Provost at the discretion of the 
instructors. 
Although it is technically permissible to use brief quotations (a phrase or one sentence at 
most), these are very rarely used by practicing biologists.  It is never appropriate to quote 
extensive passages (more than two sentences) from a text or web site.  The only reason to use 
a direct quotation is that the bizarre or unbelievable wording in the source must be shared 
with your reader.  If you ever did have to use a quotation, you would use quotation marks and 
cite a reference at the end of the sentence.  However, it is very unlikely that you will need to 
make a direct quotation in a lab report.   

Citations 
It is imperative to acknowledge where ideas or knowledge not originally your own come 
from, even though you have stated your understanding of the idea in your own words. The 
source is given in parentheses at the end of the sentence containing that idea. The 
parenthetical reference to a source is a “call-out”.  If the source is a journal article or book, 
give the author's last name and the year; if the source has two authors, give both last names 
and year; if the source has more than two authors, give the last name of the first author 
followed by et al.  Note that “al.” stands for “alia” meaning others and so takes a period.  If 
the source is a book, include the page number (or page range) after the year.  Finally, if the 
source is a web page, put URL1 in parentheses at the end of the sentence and give the 
complete URL in the bibliography.  All sources (books or articles or web sites) you call out 
in your lab report must be included in a list of references in a separate section at the end of 
the paper.  See below for tips on formatting the reference list.  
Having said all of that, you will ask, “Are we required to consult outside sources for our lab 
reports?”  Required, no.  But particularly as the semester goes on, you will find reading 
outside sources useful and you will probably need to look at a few to write a well informed 
report.  Note that heroics are not necessary – reports turned in with more than four or five 
references are probably just showing off.  Finally, if you consult a source in a general way 
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for overall background and you do not refer to it specifically in your text then you do not list 
it in the reference list.  The reference list is not about showing off how much you have read, 
rather it is about providing citations for any source you cite specifically with a call out.  
For BioImaging, you do NOT need to cite the lab manual for this course. 

Clarity, grammar, syntax and spelling: the mechanics of writing 
The actual mechanics of your writing do matter.  This includes spelling, grammar, logic, the 
flow of the writing and general understandability of the paper.  Therefore, you should make 
sure you proofread your reports, and edit them as necessary.  The very best way to be certain 
that your writing is clear is to read it out loud, preferably to a friend.  

There is help available from the University Writing Program, found at 
http://www.umass.edu/writingprogram/index.html.  You paid for it (with your tuition and 
fees); you should take advantage of it. Your grades will thank you. 

 
Reporting numbers 
Write the zero in front of a decimal, e.g., 0.05. 

Don’t report more significant figures than are found in the least precise of your 
measurements.  Just because your calculator or Excel calculated a number to 9 decimal 
places doesn’t justify reporting all those significant digits.  For example, when you report the 
mitotic index as 10.47619048%, you are claiming that you can distinguish between cultures 
or slides with indices of 10.47619047 and 10.47619049; because you counted 11 dividing 
cells in a slide of 105 cells, there is no way you can support that precision.  Instead, give the 
index as 10.5. 
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Scientific terminology  
• One medium, two media 

• One bacterium, many bacteria 

• Culture of bacteria or bacterial culture 

• One datum, many data. 

• The names of elements, sugars, genes, and enzymes are NOT capitalized, even if the 
corresponding acronym is made of capital letters.   

• The scientific names of organisms always take this form:  Genus species.  The genus 
name is capitalized, and the species name is lower case.  Both are italicized.  After you 
have first written out the entire name, if you refer to the same species again in the 
report, then you may abbreviate the genus name with just its first initial.  That is: 
Escherichia coli becomes E. coli after first use.   

• Use the most specific term you can, even if it is repetitious and your English teacher 
told you not to repeat the same word too often.  For example, “hydrochloric acid” is 
more specific than “acid”, which is more specific than “chemical”.  Write “lactose” 
when you mean lactose in particular, and “sugar” when the reader couldn’t possibly 
think you mean any other sugar in that sentence, or when you do mean any sugar. 

Specifics 
First section:  Introduction 
The point of this section is to give background information on the general topic of the 
laboratory experiment.  We want you to exhibit some independent understanding of what you 
did in lab, and why you did it.  Generally, there is one major idea that a lab will investigate.  
Remember that when you write a lab report, you will have already performed the 
experiment(s), so use the past tense.  

This section (as in all other sections) is written in full paragraphs – never as a list.   

Second section:  Results  
In this section, you will present the experiments you did and the results you got.  Although 
your professors have read (!) the lab manual you should write your report for someone who 
had not read it.  For each experiment, briefly state the question it should address (in one or 
two sentences), describe the set up used to address it, present the results you obtained, and 
state again briefly (one or two sentences) the conclusion.  
Particularly as the semester wears on, you will get a lot of “results”.  It is not required to 
present everything you did or to present the results in excruciating detail.  Present the main 
results and demonstrate your mastery of the objectives stated in the lab manual.  We expect 
students to make judgments particularly as the semester progresses about what are the 
important results.    

What about “materials and methods”?   Here we will cut you some slack.  You don't need a 
formal materials and methods section.  In general, distinguish things you do from things that 
are done for you.  For a given lab there will be solutions already made and provided for your 
use. Because you didn't make these you do not have to give their complete composition and 
simply refer to them by name (e.g., “fixation buffer”).  Or in cases where there are key 
issues, with appropriate specificity: “calcium-free rinse”.  In contrast, things that you did: 
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manipulating the microscope, drawing circles around the cells, measuring intensity, etc., 
should be described in sufficient detail that we can follow what you did.  In a scientific 
paper, there has to be enough detail that someone can repeat the experiment.    
It might happen, particularly for your final project, that you do make solutions or make up 
some complex treatment schemes of your own.  In a case like this, then add a materials and 
methods section that describes these complexities.  The Methods section is typically found 
before the Results section, so the reader can learn up-front what you did.  
Most experiments will be in the form of treating cells in some way, adjusting the microscope 
in some way, capturing images, and then analyzing the images to obtain quantitative data.  
For experiments like this, break the presentation of the results up in a logical way.  For 
example, describe the cell treatments and microscopes set up, present the images; then, 
describe the analysis procedure, and present the numerical results.  

Most often, the results section is written using a series of figures (pictures and graphs) as a 
skeleton.  This means that the text needs to describe not only what you did but also what is in 
the figures.  Let's look at an example, taken from molecular biology. 

 To determine an appropriate dilution of DNA for subsequent experiments, the 
genomic DNA was diluted in DNA-buffer to different extents. Each dilution 
was run on a 1% agarose gel, which was then stained with the DNA stain, 
ethidium bromide, and imaged on the departmental trans-illuminator (Figure 
1).  For the 1/50 and 1/100 dilutions, DNA could not be detected (Figure 1, 
lane 3 and 4); however, for the lesser dilutions (1/25 and 1/10), DNA was 
observed readily (Figure 1, lane 5 and 6). Based on the staining profile, we 
selected a dilution of 1/25 for further work.  

This begins with a statement of the reason for the experiment, since no experiment is done in 
a vacuum.  While this section emphasizes results, there has to be a context for the results to 
have meaning.  It continues with a description of what was done, in enough detail for the 
reader to know the main features of what you did, but not so much detail as to be 
burdensome.  Next it presents both the negative results (unstained lanes) as well as positive 
ones (well stained lanes).  Finally, it states the main conclusion.  
It is useful to consider what is left out.  It does not explain why 1/25 was preferred over 1/10.  
Could it have done so?  Sure.  Should it have?  It depends.  Is this a crucial or preliminary 
choice? You decide.  It omits mention of what is in lanes 1 and 2.  Why?  Let’s say lane 1 is 
the molecular weight markers and lane 2 is the no-DNA control.  These lanes would be 
described in the figure legend.  They are necessary to validate the experiment but not to 
understand it.  What do you put in the figure legend and what do you put in the text?  
Unfortunately there is no absolute answer to that.  The results section is supposed to tell the 
story convincingly.  To be convinced, the reader has to understand the figures and see what 
you are seeing.  Suppose there were some staining in the no-DNA lane?  In that case it had 
better be admitted to and if possible explained.  One of the teaching goals for the course is 
that you will learn what makes a convincing example in microscopy.  

Remember, make sure that you show and state the results you actually found, even if they 
are not what you expected or predicted. 

You must refer, in the text, to each figure and table, by its number.  Explain in your own 
words the salient features of every figure or table.  The choice of what you talk about in the 
text reflects your understanding of what is important about your results.   
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Figures and tables are a crucial and integral part of the Results section, as mentioned above.  
A figure is a graph, photograph, or diagram (i.e., a picture). A table is a list of numbers or 
words. A sample figure and table are compared in Figure 28.   
This is what the authors who created the graph illustrated in Figure 28 had to say about it:   

The enzyme exhibited a pH optimum at 5.5 to 6.0 with a rapid decline of the 
activity at the higher and lower pH ranges (Fig. 2).  

After reading this description, we can look at the graph and see just how much higher the 
enzyme activity was around pH 6 than anywhere else along the pH scale.  Then we can return 
to the figure caption text to read details about the enzyme and the buffers, and what the 
different symbols used in the figure mean.  This allowed the main text (i.e., what was quoted 
above) to concentrate on the authors’ main point.  They didn’t think the fact that there was no 
detectible activity at pH 9 was important, so they didn’t point it out; we can think of 
scenarios where that would be the main point.  Context matters!    

 

TABLE 1.  Summary of purification of amylase S 

Treatment 
Total 

activity 
(U) 

Protein 
(mg) 

Sp act 
(U/mg) 

Yield 
(%) 

Purification 
(fold) 

(NH4)2SO4 608 434 1.4 100 1 
DEAE 582 3.4 171 96 122 
Superdex 160 0.14 1,143 26 816 

 

     Fig. 2.  Effect of pH on the amylase activity.  The following buffers were 
used at 50 mM:  sodium acetate buffer between pH 3.8 and 5.7 (circles), 
sodium-potassium phosphate buffer between pH 5.6 and 7.3 (squares), and 
glycine-NaOH buffer between pH 7.7 and 9.0 (triangles).  All the pH values 
were adjusted at 70°C. 

 

Figure 28.  The difference between a figure and a table in a scientific publication (from Chung, 
Y.C., et al, 1995.  Applied and Environmental Microbiology 61(4), p. 1502-1506).  The figure’s 
caption is below or occasionally to the side; the table’s heading is above.  Figures and tables both 
have a “title”, which is simply the start of the caption.  Like a title, it should be able to stand alone.  
The figure caption must explain all symbols and lines and other things in the figure (for images, 
give the scale bar calibration in the caption).  If there are asterisks or error bars, the significance 
level is given in the caption.  If you need to give extra details for the table, that usually follows the 
title, above the numbers in the table.  

Occasionally, you may have a result that is not shown in a figure or a table, but this is rare.  
One example would be a simple calculation, e.g.,  

We calculated the concentration of our DNA sample as conversion factor × 
OD260 × dilution factor (0.5 × 0.98 × 2) to arrive at a concentration of 0.98 
µg/µL.  

It’s a result, and needs to be included, but is not something that (by itself) warrants a whole 
figure or table.  Please note that, if several such calculations were made, you would want to 
put them into a table!   

To reiterate, the Results section consists of a complete prose description, written in full 
sentences and paragraphs, which describes the reason for each experiment, what you did and 
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observed, and the main conclusion.  In addition to the text, the Results section will include 
figures and tables that show the actual data.  Each figure and table will have a legend, and 
figures will be appropriately labeled. 

Third section:  Discussion 
In the discussion, you will quite literally discuss your results.  Speaking very generally, there 
are two broad topics: problems and meaning.  As for problems, what went wrong; what could 
have been done differently; what kind of variability was there; what was uncontrolled; how 
reliable do you think the results are?  As for meaning, are there cause-effect relations?  Was a 
hypothesis posed in the introduction supported or refuted?  Can you suggest further 
experiments to go beyond these conclusions?  As a general rule, discuss problems first and 
then move to conclusions and meanings.  But often the two are too closely linked to separate.  
It is a good idea to use headings in your discussion as an organizing tool.  We are looking for 
a well-reasoned assessment of the results but we are not looking for long-winded descriptions 
of every possible error or meaning.  One to a few paragraphs will usually suffice.  

Final section:  Literature Cited  
Here you list any books, papers, internet sites, etc. in which you found information about the 
topic of the experiment that you cited (called out) in the text of your report.  These references 
are to be listed in alphabetical order by the first author’s last name.  Make sure all the authors 
are listed.  Samples are given below.  If you used just part of a book, indicate the chapter or 
pages used.  For web sites, give the exact electronic address and any other information you 
have about it.  (It is best if you have an author (if one is listed) and the name of the 
organization that sponsors the site, as well as the date you accessed the site.)  Again, you 
want to give any information necessary for another researcher to find the facts you did.  
Remember—do not include references that you did not cite.   

Examples:  
Book:  Author(s). Year. Title. Location: Publisher. Number of pages, or pages cited.  Note 
that for book titles, each major word is capitalized and the title is set in italic.  

For example, 
Hille A, Bertil C. 1992. Ionic Channels of Excitable Membranes. Second Edition. 
Sunderland, MA: Sinauer Associates, Inc. 607p.  

Article:  Author(s) [list them all, even when there are lots]. Year. Title of Article. Journal, 
volume number, pages.  Note that for journal articles, titles are in Roman and only the first 
word is capitalized. Preserve accents in the names of authors. 

For example, 
Huxley AF, Stämpfli R, 1949. Evidence for salutatory conduction in peripheral 
myelinated nerve fibres. J. Physiol. 108: 315-339.  

Web page:  Name of web page.  Creator or publisher.  Subject.  Web address, date accessed.  

For example, 
URL1: The Animated Brain.  Brainviews, Ltd.  Saltatory conduction. 
http://www.brainviews.com/abFiles/AniSalt.htm, accessed 8/14/07. 
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How to avoid repeating yourself: 
Many students, when beginning to write lab reports, feel that they contain a lot of repetition.  
They feel that they have said the same things in the M&M section, the Results section, and 
then the Discussion.  If done correctly, and with attention to the ‘rules’ given above, the 
amount of repetition in a well-written lab report is minimal.  Most often, a single phrase or 
sentence can be used to re-orient your reader to a particular idea that was discussed earlier.  
Consider the following examples: 
Methods: Primers oHTJ_F (ATTTAGGGATAGACTT) and oHTJ_R 

(ATTGTAGGATTGATCCCC) were chosen to match positions 3456 and 
3822, respectively. 

Results: Primers oHTJ_F and oHTJ_R were expected to amplify a 366 bp fragment 
spanning the third intron of the UNK_A gene, as illustrated in Figure 1. 

Discussion: The 366 bp fragment was not amplified from cDNA using primers oHTJ_F and 
oHTJ_R.  Instead, a 132 bp amplicon was produced.  This indicates that the 
gene model that we predicted was correct, and that these primers flank an 
intron. 

In these examples, the author has oriented you by mentioning the primer names, or by 
reminding you of the amplicon’s expected size, but has not repeated information extensively. 
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The Q-test for the Outlying Data Point 
Sometimes you collect data by repeated measurements that seem to cluster around a certain 
value, except for one odd data point.  You want to be honest; you really did get that 
measurement, and you don’t want to cheat.  However, it does seem to be from another 
universe.  For example, suppose these are the readings from your experiment: 

25.1 21.2 27.5 22.7 23.8 26.3 40.6 22.9 
That 40.6 not only looks out of place, but it has an effect on the mean and standard deviation 
of your data set: 

 mean standard deviation 

including maximum value 26.1 6.3 
excluding maximum value 24.0 2.1 

It may also have an effect on statistical significance when you compare this distribution to 
another one by a t-test. 

Is it a mistake?  Is it noise?  Did your recording device hiccup?  What is the likelihood of 
getting an outlier this far from the next value when you are picking from a population with 
these characteristics? 
Chemists (and other scientists) often test for outliers with the Q-test.  This test calculates the 
ratio between the putative outlier’s distance from its nearest neighbor and the range of 
values: 

Notice that as the distance between the potential outlier and its nearest neighbor increases, so 
does Q.  

! 

Q =
potential outlier " nearest neighbor
maximum value"minimum value

 

For our hypothetical data listed above,  

! 

Q =
potential outlier " nearest neighbor
maximum value"minimum value

=
40.6" 27.5
40.6" 21.2

= 0.675 

The significance test consists of comparing your calculated Q to the theoretical Q that is 
expected to occur 5% of the time if you were sampling from a population with this mean and 
standard deviation.  The null hypothesis is that all your data points come from the same pool.  
If your Q is as big as or bigger than the critical Q, then you can reject that null hypothesis 
with 95% confidence, and safely exclude the one odd data point. 
Table 1, on page 137, lists critical values of Q at the 5% significance level.  Notice that the 
smaller the number of data points, the larger Q must be for you to reject a data point.  For a 
set of 8 data points, according to the table, Q would be greater than 0.526 just by luck of the 
draw 5% of the time or less.  Since our experimental Q (0.675) is larger than 0.526, we may 
safely omit the 40.6 value from our data set, because such a large value is unlikely to occur 
by chance alone.  We can conclude that that data point measures something other than what 
all the others are measuring.  To maintain honesty, we can report something like this:  “One 
very large (or small) value was rejected from the data set by the Q-test with 95% 
confidence.”  

You may only reject one data point from a data set by this method.  
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Excel Tricks to help you calculate Q 
Sort 
Select your data, then choose Sort from the Data menu.  This makes visual inspection for 
outliers easier.  Note:  if there are identifiers adjacent to the data values, be sure to include 
them in the sort, or you will lose the connection between the labels and the values! 

MAX 
From the fx menu, under statistical.  This returns the maximum value from a list of values.  
The result goes in the cell where you typed the equation.  You can specify the data array 
either by typing the range of cells where your data are found, or by clicking and dragging 
over them. 

=MAX(data array) 

MIN 
This function works just like MAX, but tells you the minimum value in a series. 

=MIN(data array) 

COUNT 
This tells you how many numerical values there are in an array.  (If you use COUNTA, it 
will return the number of non-empty cells, rather than the number of data points.) 

=COUNT(data array). 

LARGE 
This function tells you the kth largest value in a series.  Set k = 2 to find the second largest 
value.  Set k = n-1 to find the next-to-last value in a set of n data points. 

=LARGE(data array, k) 

SMALL 
This function tells you the kth smallest value in a series.  Set k = 2 to find the second smallest 
value. 

=SMALL(data array, k) 

ABS 
This function returns the absolute value of a number.  The number may be the result of a 
calculation, or may refer to a particular cell in which a calculation is done. 

=ABS(number) 
=ABS(number1+number2) 
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Table 1.  Critical values of Q at the 95% confidence ( α  = 0.05) level, 
for data sets up to n = 30 

number of  
data points* Q0.05 

3 0.970 
4 0.829 
5 0.710 
6 0.625 
7 0.568 
8 0.526 
9 0.493 

10 0.466 
11 0.444 
12 0.425 
13 0.410 
14 0.396 
15 0.384 
16 0.374 
17 0.365 
18 0.356 
19 0.349 
20 0.342 
21 0.337 
22 0.331 
23 0.326 
24 0.321 
25 0.317 
26 0.312 
27 0.308 
28 0.305 
29 0.301 
30 0.298 

 

                                                
* Table from David B. Rorabacher, 1991.  Statistical treatment for rejection of deviant values: critical values 

of Dixon's "Q" parameter and related subrange ratios at the 95% confidence level.  Anal. Chem.,  63 (2): 
139–146 

 http://pubs.acs.org/doi/abs/10.1021/ac00002a010, accessed 9/10/09. 
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Comparing Means:  The t-Test 
The Mean (Average).  
This is probably the most common measure of central tendency.  It is calculated by dividing 
the sum of all the data values by the number of such values: 

mean =  

Excel will calculate the mean for you with the following formula: 
=average(data array). 

data array:  You type in (or click and drag over) the address of the data you want averaged. 

Function wizard:  You can also use the function wizard (fx) to calculate the average:  pick a 
cell to contain the average, click on fx, choose AVERAGE (you may have to hunt for it in the 
statistical menu), highlight the values to average, and click OK.  The cell will contain the 
formula given above. 

The Standard Deviation   
The standard deviation is one of the most commonly used and easiest to understand measures 
of spread.  It also has some nice properties that will be described below. 

The standard deviation is something like the average of all the individual deviations from the 
mean.  This is a tedious calculation to do, so we usually ask a computer to do it for us 
(although generations of students before you managed with nothing more than calculators, 
and slide rules before that). 

The calculation is done as follows:  each datum is subtracted from the mean of all data (these 
are the individual deviations).  About half of these deviations will be negative, and half 
positive, and if you add them together, they cancel each other out.  To correct this, the 
deviations are squared so they will all be positive.  These squares are added together, and 
their sum is divided by the number of data (actually, one less than the number of data – 
sorry) to get the “average”.  Finally, the square root of this average is taken to correct for the 
squaring done earlier. 

 

  Where  
   sd is the standard deviation,  
   n is the number of data,  
   xi is each individual measurement,  
   x̄ is the mean of all measurements, and  
   Σ means the sum of 

Excel will calculate the standard deviation for you with the following formula: 
 =stdev(data array).   

One nice feature of the standard deviation alluded to above is that it is measured in the same 
units as the mean, so it is meaningful to add it to or subtract it from the mean. 
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A scond nice feature is that when the data are distributed symmetrically around the mean 
(that is, when they fall into the famous bell curve of song and legend), between one standard 
deviation above the mean and one below are found 68% of the data, and between two 
deviations above and two deviations below the mean are found 95% of the data.  This 
property is illustrated in Figure 29.   
The bigger the standard deviation, the wider the spread of data around the mean, as 
illustrated in Figure 30. 

  
Figure 29.  A “bell curve”, showing the 
symmetrical distribution around the 
mean.  Horizontal lines indicate 1 and 2 
standard deviations from the mean. 

Figure 30.  Two “bell curves”, with the 
same mean (13), but different standard 
deviations.  Horizontal lines indicate 1 
standard deviation from the mean. 

 

Comparing The Means.   
Usually, even when the means of two groups differ, there is some overlap between the two 
distributions.  How different the two groups “really” are depends, therefore, not only on the 
difference between their means, but also on the extent of the overlap between their 
distributions.  

Illustrating the relationship.   
The standard deviation can help to make a more complete comparison between two sets of 
data.  (Here’s where another nice feature of the standard deviation comes into play: it is in 
the same units as the mean, so they can be added together.)   Figure 31 shows why it is 
important to report not only the difference in the means between your two groups, but also 
some measure of the variation in each one.  The means of groups 1 and 2 differ from each 
other by the same amount as do 3 and 4, yet the error bars, illustrating the size of the standard 
deviation,  indicate a much greater degree of overlap between groups 3 and 4. 
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Figure 31.  The effect of standard 
deviation on a comparison between 
means.  Approximately two thirds of the 
values in each group lie within the one 
standard deviation error bars. There is 
much greater overlap between the 
measurements in groups 3 and 4 than 
between those in 1 and 2. 
 

The easiest way to create a histogram comparing the means, with standard deviation as the 
error bars, requires making a little table in Excel that looks like this: 

 mean St dev 
control   
experimental   

Choose appropriate descriptive labels for your two groups, as these will appear in your graph.  
Type the formula for the mean and standard deviation in the appropriate cells, i.e., 
=average(data array) and =stdev(data array), respectively.   

Highlight the cells containing the labels and the averages, shown above with a double 
outline, and use the chart wizard to make a bar graph.  Then highlight the bars and format the 
data series.  Make custom Y-error bars, using the two cells in which you have calculated 
standard deviation.  Note:  the “standard deviation” choice inside the Y-error bar dialog 
box is not what you think it is!  Don’t use it!  You must calculate the standard deviation in 
a cell.  (The dialog box has no idea which data went into making the means you are graphing, 
and cannot possibly calculate their standard deviation.  Instead, it calculates the standard 
deviation of the values you are plotting – in this case the control mean and the experimental 
mean, and plots an error bar that length starting from the average of those values.  I don’t 
know when this would be useful.) 
Quantifying the relationship:  calculating “t”.   
The statistic “t” is a measure of the difference between two means, divided by the geometric 
mean of the standard errors of the population means (a sort of average of the standard 
deviations of the two populations).  (The manner of calculating t depends on various 
characteristics of the experiment and the data, so this is why you must specify a “test type” 
before you ask Excel to calculate t for you.)   

 

The value of t gets larger as the difference between the means gets larger; but this is 
counterbalanced by this measure of spread in the denominator.  The greater the standard 
deviations, or the smaller the sample sizes (n), the bigger a difference in means is required to 
make t large.  You can think of this as a ratio of signal (the difference between the means) to 
noise (the variation within the population). 

group 1 group 2 group 3 group 4

M
e

a
n

 +
 S

ta
n

d
a

rd
 D

e
v
ia

ti
o

n

! 

t =
x 1 " x 2

SD1
2

n1
+

SD2
2

n2



142 Comparing Means:  The t-Test 

Figure 32 illustrates the effect of standard deviation on the t statistic.  The same difference 
between means can be significant or not, depending on the amount of variation in the 
populations being compared.   

  
Figure 32.    The effect of standard deviation on the t statistic.  The means of both pairs of distributions 
differ by the same amount, yet the t statistic is 2.236 for the pair with the smaller standard deviations, 
and only 0.745 for those with the larger standard deviations.  Notice the greater overlap between the 
curves on the right.  (T values calculated for population size of 10 in each group.) 

Interpreting the relationship.   
Tests of significance always set up a straw man, the null hypothesis, which is that there is no 
difference between the groups, or no relationship between the variables.  Then we find out 
how likely we are to get a result like our actual result if the null hypothesis were true.  From 
this, we decide to accept or reject the null hypothesis. 

If the category in question (e.g., control or treatment) had no effect on the variable being 
measured (e.g., number of cells in a suspension), you might as well be assigning categories at 
random.  Imagine putting stickers on tubes of cells at random: some get labeled “group 1”, 
others get labeled “group 2”.  Occasionally, such a process would result in all the tubes with 
dense populations being labeled “group 1”, and all those with very few cells, “group 2”.  
Such a result would give a rather large t. 

How often would a t as large as the one you got in your actual experiment be expected to 
occur if the stickers were put on at random?  The probability of getting a t as large as or 
larger than yours is called ‘p’, and fortunately, we can look up the p for a given t and number 
of measurements in any statistics book, on the internet, and inside of Excel. 

If a t like yours is rather likely to occur by the chance procedure, you cannot rule chance out, 
and you must accept that there is no difference between the means of the two groups. 

However, if such a t as yours would be exceedingly uncommon in a chance process, you may 
reject the idea that there is no difference between the means, and conclude that there is a 
statistically significant difference between the two groups.  The statistic tells you how often a 
result like yours might occur by chance alone; it cannot tell you the probability that chance 
actually caused the difference you observed.   
Conventionally, if a t as big as or bigger than yours can be expected to occur less often than 
5% of the time (p < 0.05) when there is nothing other than chance acting, we reject the null 
hypothesis, and conclude that there is a difference between the groups.   

By this criterion, the two distributions illustrated on the left in Figure 32 are statistically 
significantly different from each other, while those on the right are not. 
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P = 0.049 
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Calculating T With Excel (the quick and dirty method)   
If you have both sets of data to compare, use the built-in t-test in Excel (which you can find 
the statistics category of the function menu: 

=ttest(data array 1, data array 2, number of tails, test type) 
data array 1: the first set of data (enter the addresses, or click and drag over them) 

data array 2: the second set 
number of tails: 2 if you can’t predict how one group will differ from the other, and think the 
means might vary in either direction, 1 otherwise.   (Use 2 most of the time.) 
 test type: 1, 2, or 3 

1 for paired data i.e., two measurements on the same thing.  In this test type, Excel takes 
the differences between the paired measurements, rather than between each one and the 
mean of the population.  This works if you are comparing, for example, the absorbance at 
two different times of the very same culture (as opposed to the absorbance at the same 
time in two different cultures). 

2 for unpaired data, but where both sets have the same standard deviation (don’t use this 
one – it is unlikely to have two sets of data with identical standard deviations). 

3  for unpaired data, with unequal standard deviations (two separate sets of measurements, 
such as number of cells in treated cultures vs. number of cells in control cultures).  This is 
the most likely situation. 

Excel will return the value of p that goes with this, but not tell you the actual t.  In other 
words, Excel gives you just the punch line:  what is the probability of grabbing two handfuls 
of data at random from a single population and winding up with two subsets as different from 
each other as your two data sets are from each other. 

If you don’t have both sets of data (if you are comparing your measurements to a standard 
reported in the literature only as mean plus or minus standard deviation), you have to do 
more work.  Ask your instructor for guidance. 

Calculating T With StatPlus.   
If StatPlus is in the dock, open it by clicking on it. 

If it isn’t in the dock, open it from the applications folder.  Doing so will put an icon for it  
in the dock, and put its main menu bar (StatPlus Spreadsheet Statistics Data Charts Help) at 
the top of the screen. 
Choose Basic Statistics and Tables from the Statistics menu, and Comparing Means (t-test) 
from that menu.  That should pull up a dialog box that looks like the one below. 
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To enter your data, click in the Values box, then click on the little spreadsheet icon , 
which should take you to your spreadsheet if it is open, or to a new Excel file.  From that new 
blank file, you can open your data file.  Select the data for the first variable, return to 
StatPlus, and repeat for the second variable. 
Check the settings:   

If you included labels in the selection make sure StatPlus knows there are labels in the first 
row.   

Leave the summarized data blank.   
Set the hypothesized mean difference to zero, (because the null hypothesis is that the two 
collections of data were chosen at random from the same population) and  
Set the alpha (the maximum probability at which you will reject the null hypothesis) to 5% 
(= 0.05) by convention.   
For T-Test Type, choose the two-sample test assuming unequal variances (heteroscedastic).   
You are not comparing paired data, and your two sets of values almost certainly do not have 
the same variance (standard deviation squared). 

When you click OK, it chugs for awhile, then opens a new file called StatPlusMacResults.xlt, 
with something like this on a tab called Comparing Means: 

To enter data, click in 
the values box first 

Then click the spreadsheet icon.  The 
data you select will automatically be 
filled in once you return to StatPlus 
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Comparing Means [ t-test assuming unequal variances (heteroscedastic) ] 
Descriptive Statistics 

VAR Sample size Mean Variance 
 9 6.77778 1.94444 
  8 9.375 1.125 
    
Summary 
Degrees Of Freedom 15 Hypothesized Mean Difference 0.E+0 
Test Statistics 4.34884 Pooled Variance 1.56204 
    
Two-tailed distribution 
p-level 0.00057 t Critical Value (5%) 2.13145 
    
One-tailed distribution 
p-level 0.00029 t Critical Value (5%) 1.75305 
        
G-criterion 
Test Statistics #N/A p-level #N/A 
Critical Value (5%) #N/A     
    
    
Pagurova criterion 
Test Statistics 4.34884 p-level 0.99938 
Ratio of variances parameter 0.60573 Critical Value (5%) 0.0255 
 
In this output table, 

VAR: Probably short for variable.  This should have the labels from your two columns of 
data.  If not, type them in before you forget which comparison this is. 

Sample Size:  Sample size tells you the number of values in each group.  Use it to do a 
reality check:  do the sample sizes reported by StatPlus match the number of values in each 
of your categories?  If not, you should repeat your data selection. 
Mean:  Is this the same as what you had Excel calculate for you on your spreadsheet?  
(Another reality check.) 
Variance is standard deviation squared.  It is another measure of the spread of data around 
the mean.  
Degrees of freedom is the total number of data points minus 2 (it’s the number of data points 
that are free to vary before the remaining ones are set). 
The Hypothesized Mean Difference should be 0 (given as 0.E+0 in Excel-style scientific 
notation). 
Test Statistics is your t value. 

The Pooled Variance is an estimate of variance that assumes the true variance of the two 
samples is the same.  You can ignore it. 

The p-level (the probability of getting results this different from each other if the two sets of 
values were really drawn from the same pool) is given twice, once for a one-tailed 
distribution, and once for a two-tailed distribution.   
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In general, you should use the p value for the two-tail test, since this tests for both positive 
and negative differences between the means.  The one-tail test gives you greater power to 
detect a difference in only one direction, but increases the possibility of getting a false 
indication of significant difference.  

The t Critical value (5%) is the t associated with that probability.  If your t is greater than 
the critical value, your p-value is less than 0.05.  Remember, the bigger the difference 
between the two groups, the higher the t and the lower the probability of getting a t that big 
by random factors alone.  

It is OK for our purposes to ignore the G and Pagurova criteria.  
This output table is static.  If you change anything about your data, you must re-do the 
analysis. 
Excel reports the values with up to nine decimal places.  This in no way obligates you to do 
the same!  Round the values to the number of significant digits of your least precise 
measurement.  You can do this by formatting the cells in Excel, or correcting the number 
when you paste a result into Word.  See pages 42 and 130 for more discussion of significant 
digits. 

Multiple comparisons – a caution 
What if you have more than two sets of data to compare (e.g., two experimental treatments 
and one control)?  It is tempting to do multiple t-tests to find out which means are different 
from each other.  However, this should only be undertaken with great caution, because the 
more comparisons you make, the more likely you are to find high t-values by chance alone.  
Remember, the p-value is a calculation of the likelihood of getting a t as high as yours even if 
the values in both groups were actually drawn from the same population (i.e., by chance), so 
if you did 100 comparisons, you can predict that chance alone would produce about 5 
“significant” results.  See Adjusting the critical α, on p. 148. 

Analysis of Variance 
One improvement on multiple comparisons is to begin with an analysis of variance 
(ANOVA) on all the data first, to find out whether the variation between groups differs from 
the variation within each group.  ANOVA tests the null hypothesis that there are no 
differences between the groups, that in fact, all the data are pulled from what is effectively a 
single population. 
ANOVA uses the F-statistic, which is the ratio between the mean square (a measure of 
variation) between groups and the mean square within groups.  The null hypothesis is that the 
variation between groups is no bigger than the variation within groups, or that F < 1.  As with 
the t-test, a large F statistic occurs rarely when the groups are the same, so the associated p-
value is a measure of how likely it is to get an F as large as yours by chance alone. 

Use the one-way ANOVA in StatPlus, assuming you have only one variable (e.g., 
“treatment”), which consists of different conditions (e.g., “control”, “treatment 1”, “treatment 
2”, etc.).  Set your data up in columns, with labels in the first row.  
Select one-way ANOVA from the StatPlus Statistics menu, click in the “variables” box, click 
on the spreadsheet icon,find your datafile, and select your data including the labels.  Let it 
run.  It will produce a spreadsheet with a table like this: 
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Analysis of Variance (One-Way) 
       
Summary             

Groups Sample size Sum Mean Variance     
control 7 20. 2.85714 1.80952   
treatment 1 7 4. 0.57143 0.28571   
treatment 2 7 9. 1.28571 0.57143     
       
ANOVA             
Source of Variation SS df MS F p-level F crit 
Between Groups 19.14286 2 9.57143 10.76786 0.00084 4.90007 
Within Groups 16. 18 0.88889    
       
Total 35.14286 20         

 
In this output table: 

Groups should accurately label your sets of data.  If not, repeat your data selection. 
Sample size should accurately reflect the number of data points in each group.   If not, 
repeat, with correct selection of data from your spreadsheet. 
Sum should be what you get if you add up all the values in one group.  The Mean should be 
the average of the data in the group, and Variance is standard deviation squared. 
SS stands for the sum of (deviation) squares.  It should remind you of the standard deviation.  
Squaring the difference between the individual values and the mean or between the group 
means and the overall mean gets rid of the negative values and magnifies the impact of a 
large deviation.  SSbetween is the sum of the squares of the differences between each group 
mean and the total mean, times the number of scores in the group, and SSwithin is the sum of 
the squares of the differences between every raw score and its sample mean. 

 

where 
 = the mean of group i 
 = the mean of all raw scores combined 
 = the number of scores in group i 

 
 

where 
 = raw score i 
 = the mean of i’s group 

 
Df, or degrees of freedom, is the number of values that are free to vary and still give you the 
same statistic.  Within groups, this should be 1 less than the number of groups.  Between 
groups, this should be the total number of samples minus the number of groups. 
MS stands for mean square, or variance, and it is the ratio between SS and df.  This yields 
something like an average, and corrects for the number of scores. 
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F is the ratio between MSbetween and MSwithin ( ).  The null hypothesis is that the 

variation between groups is no bigger than the variation within groups, or that F < 1.  A 
larger F indicates greater variance between groups than within each group. 
The p-level is the probability of getting an F as big as yours by chance alone, even if all the 
data come from the same population.   
The F crit is the F associated with the p-value (probably 0.05) you specified when you set up 
the test.  It is the smallest F that would let you conclude your groups differ statistically from 
each other. 

If you get a statistically significant result (i.e., a p less than 0.05) with ANOVA, you can test 
the treatment groups in pairs by the t-test.  Doing so, however, increases the chance of 
finding spurious “significance.”  You can guard against that in various ways.  The two 
simplest are to adjust the α (that is, the maximum p-value you will use to reject the null 
hypothesis of no difference between the groups), or caution your reader that you have 
performed multiple comparisons. 

Adjusting the critical α   
The probability of getting a large t rises with the number of t-tests you perform.  Therefore 
you should tighten your decision criterion a little.  The easiest way is to correct the critical α 
by dividing your usual α (0.05 for most purposes) by the number of pairwise comparisons 
you made.  This protects you very well against claiming statistical significance where none 
exists, but not so well against claiming no difference when there is one. 
For small numbers of comparisons, this is nearly identical to the next simplest correction, 
calculated as 1-(1-α)1/n.  As the number of comparisons grows, this correction stops the α 
from slipping into infinitesimal territory.  This helps prevent you from being unable to detect 
any differences at all. 

 You can be very confident of any difference that passes either of these corrected α tests.  
There are other ways to guard against spurious significance that are beyond the scope of this 
chapter, but which a statistician would be delighted to teach you. 

Reporting Your Statistical Results.  
 Use the criteria above, that is, a significance level of p  ≤ 0.05, to decide whether the values 
in two sets of data can be called statistically different from one another.   
Remember that the p value only tells you how likely it is to get a t as big as yours if the two 
samples really were picked from the same population, so resist the urge to say you’ve proved 
chance did or did not cause the difference you observe.  Here are a few conventional 
expressions of such a result: 

The mean [whatever was measured] of Group 1 (5 + 2, n = 10) is statistically lower than that 
of Group 2 (7 + 2, n = 10) by the t-test (t = 2.236, p = 0.049). 

Group 2 had significantly higher [whatever was measured] by the t-test (t = 2.236, p = 0.049). 

There was no statistically significant difference between Groups 3 and 4 by the t-test 
(t = 0.745, p = 0.475).  

  

! 

MSbetween
MSwithin
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The Chi Square Test for Counted Data 
One test for statistical significance applicable to many experiments that count data in 
categories (e.g., number of cells in particular phases of mitosis) is the Chi (pronounced like 
sky without the s) squared (χ2) test.    It tests for whether the values are distributed in the 
categories as predicted (expected) by chance. 

!! =
(!! − !!)!

!!

!

!!!

 

χ2 is based on the difference between a series of observed values (o1, o2, …om) and values 
(e1, e2, …em).  Bigger deviations from the expected yield a bigger χ2. 

The differences between observed and expected are squared for two reasons.  The first is that 
this makes all the terms positive so the negative ones don’t cancel out the others.  The second 
reason is that this accentuates large differences and minimizes small ones. 
The squared difference is divided by the expected value to obtain something like the percent 
deviation, thereby weighting the individual (!!!!!)

!

!!
 terms so that the relative deviation rather 

than the absolute deviation is used in calculating the statistic. 

The individual (!!!!!)
!

!!
 terms are summed to give an overall indicator of the difference 

between observed and expected across all the categories. 

χ2 lets you determine the probability that the deviation from your prediction was due to 
chance alone.   

Example: 
For the entering class in 2012, UMass accepted 11,918 out of 18,006 female applicants, and 
9552 out of 16320 male applicants*.  Is this distribution according to chance, or is there some 
non-random factor at work?  Imagine the admissions process taking place by the admissions 
officials putting all the applications into a giant bag, and pulling out 21,470 (11918 + 9552) 
without looking.  How likely would they be to pull out 11,918 applications from females and 
9552 from males? 
It helps to look at a 2-way table: 

gender accepted rejected total applications 

female 11,918 6088 18,006 

male 9,552 6768 16,320 

totals 21,470 12,856 34,326 

 

What would we expect from the grab-bag admissions technique?  The applicant pool was 
52.5% female (18,006/34,326), so the population of admitted students should also be 52% 

                                                
* UMass Amherst At a Glance 2012-2013, http://www.umass.edu/oapa/publications/glance/FS_gla_01.pdf, 

accessed 8/26/13 
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female.  Similarly, 62.5% of all applicants were accepted, so we expect 62.5% of the female 
applicants to be accepted.  Here’s the two-way table again, with the expected values 
calculated: 

gender accepted rejected total  
applications 

female 18006
34326×21470 = 11,262.3 

18006
34326×12856 = 6743.7 18,006 

male 16320
34326×21470 = 10,207.7 

16320
34326×12856 = 6112.3 16,320 

totals 21,470 12,856 34,326 

 

!! =
(11918 − 11262.3)!

11262.3
+
(9552 − 10277.7)!

10277.7
+
(6088 − 6743.7)!

6743.7
+
(6768 − 6112.3)!

6112.3
= 1.5×10!!" 

This particular calculation gives us a minute χ2, because the observed values are actually 
quite close to the expected ones.   

The calculated χ2 by itself has very little meaning.  The significance (literally) comes from 
calculating the probability of getting a χ2 at least this big by random assignment of 
individuals to categories.  Imagine the admissions committee doing the grab-bag technique 
over and over and over.  Most of the time, a random assignment procedure will produce 
results similar to the prediction. 

Every once in a while, however, the person pulling applications from the bag to accept will 
grab mostly applications from women, or mostly from men.  This would produce a much 
larger χ2 than we calculate from the actual data. 
In our actual UMass admissions example, almost any result other than the reported one 
would give a χ2 bigger than ours, so the probability of getting results at least this different 
from the expected is quite high.  (In fact, Excel reports it as 1.) 

The one remaining element needed in order to calculate p from χ2 is the degrees of freedom, 
which is the number of categories you have to count to be able to fill in the rest by 
subtraction.  This assumes you know all the subtotals.  The degrees of freedom = m-1, or one 
less than the number of categories. 

You can get Excel to do the heaviest of the lifting for you, that is calculating χ2 from arrays 
of observed and expected values, and calculating p from the χ2.  However, you do have to get 
Excel to calculate the expected values for each category.  Here’s how I did the calculations 
for the application example: 
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I typed in the raw data 
from the UMass 
website, then used 
formulas to calculate 
the subtotals and the 
grand total: 

 
  

Then I made another 
table for the expected 
values, and typed in the 
appropriate formulas to 
have Excel do the 
calculations for me. 

 
I used the formula builder to calculate χ2 with the function CHISQ.TEST.  You can see why 
it matters how you array your observed and expected values.  Their relative positions must 
match. 
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Finally, I calculated p with the function CHISQ.DIST.RT.  (It only examines the right side of 
the χ2 distribution, because that’s where the larger χ2 values are, and we are only interested 
in the probability of getting a χ2 value as high as or higher than our calculated value – but 
that’s probably more than you wanted to know.) 

 
Remember, when you have finished these calculations, you do not have proof that chance did 
or did not cause your results; you simply know how likely it is to get results like yours if 
chance were the only factor.  If results as skewed as yours would be unlikely to occur by 
chance alone (less than 5% of the time), then you can reject the hypothesis that your results 
are randomly assigned to categories.  In the case of the UMass admissions data, we can 
conclude that there is no apparent gender bias in acceptance rates. (See page 148 for a further 
discussion of the meaning and reporting of statistical results.) 
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Making Dilutions 
It is often very important to know the precise concentration of some chemical you are using 
in your experiment.  Various units of concentration are used in biology and chemistry: 

Molarity (M) = moles/Liter 
mg/mL = g/L 

% w/vol = g/100 mL (because 1 mL of water weighs 1 g) 
% vol/vol = mL/100 mL 

Sometimes you can start from scratch, that is, weigh out the substance and dissolve it in the 
appropriate amount of solvent (usually water for biological applications). 

What if I need 10 mL of 5M NaCl (MW = 58)?  You can calculate how much NaCl to 
dissolve in 10 mL water this way (notice how all the units but g cancel out): 

 

What if I need 1 mL of 5mM NaCl?  

 

Unfortunately, 0.00029 g is an almost imaginary amount of sodium chloride.  Even if you 
made 10 times what you needed, you’d have to weigh out 0.0029 g, and most of our prep 
room balances only report three decimal places.  You could make a liter of 10mM NaCl with 
0.29 g, because sodium chloride is cheap to buy and legal to pour down the drain, but many 
reagents are much harder to come by and dispose of, so we need other ways of making 
solutions. 
If you already had your 10 mL of 5 M NaCl, you could make your 1 mL of 5 mM NaCl by 
dilution, that is, by taking a small volume of your 5 M NaCl and diluting it in water.  To 
calculate how, we use the lab preparer’s best friend: 

 

 c1 = the concentration of the initial solution used to make the more dilute solution 
 v1 = the initial small volume of the first solution used to make the dilute solution 

 c2 = the concentration of the second, more dilute solution 
 v2 = the final volume of the second solution after the dilution is carried out 

So we need to figure out what volume (v1) of the 5 M (c1 ) solution to use to make 1 mL (v2) 
of a 10 mM NaCl (c2) solution. 
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"
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Another way to look at this is to calculate the dilution factor, that is, the ratio between the 
initial and final concentrations.  Diluting a 5M solution to a 5mM solution is a 1000-fold 
dilution: 

 

 Therefore, you need 1 part stock solution to make 1000 parts of your final solution. 

 

Fortunately, I have a micropipettor that can deliver 0.001mL (=1µL).  So I can make the 
dilute solution by mixing 0.001mL of my concentrated solution with 0.999 mL of water.   

What if I don’t really trust* my pipettor down in the single µL range? 
Worse, what if my concentrated sodium chloride stock solution is 1M, rather than 5M?  
The initial volume would be 0.0002 mL (=0.2µL), and I really don’t have a pipettor I trust to 
deliver that small a volume. 

I can solve the problem of a v1 too small to deliver by using a series of dilutions, each 
transferring a volume I can accurately deliver, to achieve my intended volume and 
concentration.  For this procedure, I use a modification of c1v1=c2v2: 

 

c1 = the concentration of the initial solution used to make the next dilution in the 
series 

vt = the transfer volume 

d = the dilution factor (e.g., 2 for a 2-fold dilution series, where the concentration 
of each solution in the series is half that of the previous one) 

 = the concentration of the second solution in the series 

vf  = the desired final volume of each solution 
vf + vt = the initial volume of a diluted solution, until the transfer volume is removed to 

make the next dilution in the series 
This procedure is illustrated in Figure 33. 

                                                
*  When I say I don’t trust the pipettor, I mean that I worry about tiny errors in delivery representing a large 

percentage of the volume I’m transferring. 
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Figure 33.  A serial dilution.  A small volume (vt) of solution is transferred to a vessel 
containing a volume (vf) of solvent.  After these are mixed, vt of the second solution is 
transferred to the third vessel, also containing vf of solvent.  The concentration of each 
solution is 1/d the concentration of the previous one in the series. 

So if I didn’t think I could trust a 1 µL transfer volume, I might try a 10-fold serial dilution 
(d = 10) (both because calculations with 10 are easy, and because I want the last dilution in 
my series to be one one-thousandth of the initial concentration).   Suppose that the 1 mL 
volume in the example above was more than enough for my experiment.  An easy 10-fold 
dilution series could be done with a 0.1mL transfer volume, as follows: 

Starting with the general equation:  

Substituting the initial concentration, the 
dilution factor, and the transfer volume: 

 

Solving for vf :  

So by starting with 1 mL (vf + vt) of my 1M (c1) solution, and transferring 0.1 mL (vt) of it to 

0.9 mL (vf) of solvent gives me 1 mL (vf + vt) of 0.1M  solution.   

Repeating this process will give me a series of solutions, each one-tenth the concentration of 
the one before it.   
What if I don’t know what concentration range of a particular substance is suitable for 
use in my experiment or in my measuring device?  You need to test a wide range of 
concentrations.  Serial dilution is the best way to achieve such a range.  With a 2-fold 
dilution series of 10, you can take a solution down to less than a 1000th of its original value: 
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With a 10-step10-fold dilution series, you can get down to 10-10 (less than a billionth!) of the 
original concentration. 

What if the manufacturer gives me exactly 1 mg of the chemical?  You can take 
advantage of the manufacturer’s precision by dissolving the chemical, still in its original 
package to prevent loss of material, in a small, known volume of suitable solvent (which the 
package insert should identify for you), thereby making a stock solution of known 
concentration (e.g., 1 mg/mL).  From that, you can make whatever dilute concentrations you 
need. 
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Metric Prefixes 
(adapted from Greg Pearce, chemformula bbcmb@sigmaxi.org, 

http://www.unc.edu/~rowlett/units/prefixes.html) 

In your introductory chemistry and biology labs, you probably used only a few of the most 
common metric prefixes, such as milli-, centi-, and kilo-.  Various textbooks and lab manuals 
contain longer lists of prefixes, but not many contain a complete list.  There is no point in 
memorizing all of them, but it is nice to be able to look them up when you encounter them as 
you read the scientific literature.  The smaller prefixes, such as nano-, pico- and femto-, are 
becoming increasingly common as analytical chemistry and biotechnology develop more 
sensitive methods.  The larger prefixes, such as mega-, giga-, and tera-, are becoming more 
common in computing as engineers find ways to pack more and more memory into tiny 
devices.  Table 2 presents prefixes ranging from 1024 to 10-24.  To help you visualize the 
effect of these prefixes, the column labeled “a sense of scale” gives some examples of the 
magnitudes represented. 

Table 2. Metric Prefixes 

Prefix 

Abbreviation 
(note upper 

and lower case) Meaning Synonym A sense of scale  (approximate) 

yotta- (Y-) 1024 1 septillion Mass of water in Pacific Ocean  
Energy emitted by sun per second  

Volume of earth  
Mass of earth  

~1 Yg 
~400 YJ 
~1 YL 
~6000 Yg 

zetta- (Z-) 1021 1 sextillion Radius of Milky Way galaxy  
Volume of Pacific Ocean  

Annual world energy production  

~1 Zm 
~1 ZL 
~0.4 ZJ 

exa- (E-) 1018 1 quintillion Age of universe (12 billion yr) ~0.4 Es 
peta- (P-) 1015 1 quadrillion 1 light-year  ~9.5 Pm 
tera- (T-) 1012 1 trillion Sun-to-Jupiter distance  ~0.8 Tm 
giga- (G-) 109 1 billion Human life expectancy  

1 light-second  
~3 Gs 
~0.3 Gs 

mega- (M-) 106 1 million Two weeks ~1.2 Ms 
kilo- (k-) 103 1 thousand   
hecto- (h-) 102 1 hundred   
deka- (da-) 10 1 ten   
deci- (d-) 10-1 1 tenth   
centi- (c-) 10-2 1 hundredth   
milli- (m-) 10-3 1 thousandth   
micro- (µ-) 10-6 1 millionth Diameter of human ovum 

Volume of mosquito blood meal 
Volume of wood frog egg    

~1 µm 
~2 µL 
~3 µL 

nano- (n-) 10-9 1 billionth Radius of chlorine atom  ~0.1 nm 
pico- (p-) 10-12 1 trillionth Mass of bacterial cell  ~1 pg 
femto- (f-) 10-15 1 quadrillionth Radius of proton  

Volume of E. coli cell 
Volume of red blood cell 

~1 fm 
~1 fL 
~100 fL 

atto- (a-) 10-18 1 quintillionth Time for light to cross an atom  
Bond energy of C=C  

~1 as 
~1 aJ 

zepto- (z-) 10-21 1 sextillionth 600 atoms or molecules  ~1 zmol 
yocto- (y-) 10-24 1 septillionth Mass of proton or neutron  ~1.7 yg 

 


